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1
Installing or Restoring the Operating System

Depending on the workstation model, Microsoft Windows 2000 Professional (with latest Service 
Pack), Microsoft XP Professional, or Red Hat® Linux® is preinstalled. The operating system is 
configured automatically the first time the computer is turned on.

Ä
CAUTION: Do not add optional hardware devices to your computer until the operating system is 
successfully installed. Doing so may cause errors and may prevent the operating system from installing 
properly.

Ä
CAUTION: Once the automatic installation has begun, DO NOT TURN OFF THE COMPUTER UNTIL 
THE PROCESS IS COMPLETE. Turning off the computer during the installation process might damage the 
software that runs the computer.

1.1 Installing the Operating System and Software
The following sections discuss the operating system and HP software installation procedures.

1.1.1 Installing Microsoft Windows 2000 Professional
The first time you turn on the computer, you will be prompted to select a language for the 
operating system. After selecting the language, read and follow the instructions on the screen to 
complete the installation of the operating system. This takes approximately 10 minutes, 
depending on the system hardware configuration. During this process, do not turn off your 
computer unless you are directed to do so.

Installing or Upgrading Device Drivers 
To install hardware devices such as a printer, a display adapter, or network adapter after the 
operating system installation is completed, the operating system needs access to the appropriate 
software drivers for the devices. 

To locate the most current device drivers go to www.hp.com. 

The I386 directory and its subdirectories provide the HP-specific integration of the operating 
system for the computer model and include device drivers supported by Windows 2000.

When prompted for the I386 directory on the operating system CD, replace the path specification 
with C:\I386 or use the browse button of the dialog box to browse the computer for the I386 
folder. 

✎ The service pack for Windows 2000 Professional has been integrated into the program.
Service Reference Guide 1–1
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Creating an Emergency Repair Diskette - Windows 2000
1. Click Start > Programs > Accessories > Backup.

2. Select the menu option Tools, then select Create an Emergency Disk.

3. Follow the instructions that appear on the screen.

Using the Emergency Repair Diskette - Windows 2000
1. Insert the diskette into the diskette drive and restart the computer (you may boot the 

computer to the Windows 2000 CD on some computers).

2. Press Enter to start the repair process, then choose to repair the system.

3. Select the Emergency Repair Process. 

4. Follow the instructions that appear on the screen.

1.1.2 Installing Microsoft Windows XP Professional
The first time you turn on the computer, you will be prompted to select a language for the 
operating system. After selecting the language, read and follow the instructions on the screen to 
complete the installation of the operating system. This takes approximately 10 minutes, 
depending on the system hardware configuration. During this process, do not turn off your 
computer unless you are directed to do so.

Installing or Upgrading Device Drivers 
To install hardware devices such as a printer, a display adapter, or network adapter after the 
operating system installation is completed, the operating system needs access to the appropriate 
software drivers for the devices. Device drivers are usually provided on a CD supplied with the 
peripheral device.

Some existing peripheral devices may not have been shipped with drivers developed for 
Windows XP. To locate the most current device drivers go to www.hp.com. 

Creating a Restore Diskette 
To create a restore diskette for Windows XP, go to Start > Programs > Accessories > System 
Tools > System Restore, and follow the instructions on screen.
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1.1.3 Installing Red Hat Linux
The first time the workstation is booted, the Linux Setup Tool utility displays. This program 
allows you to enter your password, network, graphics, time, and keyboard settings for your 
workstation.

Ä
CAUTION: Once the automatic installation has begun, DO NOT TURN OFF THE WORKSTATION 
UNTIL THE PROCESS IS COMPLETE. Turning off the workstation during the installation process may 
damage the software that runs the workstation or prevent its proper installation.

✎ When you enable the YPBind feature in the Network tab of the Linux Setup Tool, you may get a 
blank screen for about 15-30 seconds after you have selected and saved all of your settings and 
have exited the utility. This is normal. The boot process continues its execution after the screen 
returns.

✎ In the Time/Time Zone tab of the Linux Setup Tool utility, the Time Zone Region must be 
selected first and then the City, before clicking the Save/Exit button.

upgrading device drivers
Should you ever have to upgrade a Linux device driver, visit the HP Web site at: 
http://www.hp.com/go/workstationsupport.

You can also visit Red Hat at www.redhat.com to check availability of additional device drivers.

1.1.4 hp Software
The Microsoft Windows 2000 Professional or Windows XP Professional operating system is 
preinstalled on the computer and will be configured automatically the first time the computer is 
turned on. The following HP software will also be installed at that time on selected models:       

■ Setup Utilities and diagnostic features

■ Support Software including device drivers

■ HP Configuration Record

■ Online Safety & Comfort Guide

■ HP Intelligent Manageability

■ HP Insight Manager

■ Diagnostics for Windows

■ DMI Support

■ Power Management with energy saver features

■ Security Management tools

■ Software Support Management tools

Certain drivers and utilities are available only in selected languages. You can obtain the latest 
version of these files, in English and selected other languages, in one of two ways:

■ Support CD kit

■ HP web site at www.hp.com
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1.2 Restoring the operating system
The following sections discuss the procedures for restoring the operating system and applications 
software.

1.2.1 Microsoft Windows 2000 Professional and Windows XP 
Professional
Restore the original operating system and factory-installed software by using the Restore Plus! 
CD and the OS CD that came with the workstation. Carefully read and follow the instructions 
provided with the Restore Plus! CD.

1.2.2 Red Hat Linux
Should a recovery of the OS or software be required, insert the hp workstations Red Hat Linux 
with hp additions (Binary Disk 1/3) CD and follow the prompts on the screen to successfully 
complete the recovery process.

1.3 Converting to NTFS
Hard drives are formatted according to a file system format that sets a maximum partition size. 
With the increase in drive size and changes in operating systems the FAT32 file system format 
has become outdated. The NTFS file system format is preferred for the latest drive sizes and 
operating systems.

1.3.1 Windows 2000 Professional
The hard drive may be automatically converted to NTFS when Windows 2000 is configured. On 
some systems the following procedure may be required.

To convert an existing partition from a FAT 32 partition to an NTFS partition, double-click the 
NTFS Convert icon on the desktop. Carefully read and follow the directions that appear on the 
screen.

Ä
CAUTION: Converting from a FAT32 partition to NTFS may result in loss of data. Back up all data files 
before changing the file system format.

1.3.2 Windows XP Professional
During the initial unbundling of the operating system, the system will start out with a FAT32 
partition but will automatically convert to NTFS. The Windows XP operating system is not 
designed to run in a FAT32 partition on these systems.
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1.4 Hyper-Threading Technology
Hyper-Threading Technology is a high performance technology, developed by Intel®, that allows 
a single processor to execute multiple threads of instructions simultaneously. Hyper-Threading 
Technology enables the processor to utilize its execution resources more efficiently, delivering 
performance increases and improving user productivity. Not all systems benefit from the 
Hyper-Threading Technology.

To see if Hyper-Threading Technology can benefit you, test your system by turning the feature 
on using the Computer Setup (F10) system utility. To do this, run F10 Setup during boot up and 
select Advanced > Device Options > Hyper-Threading, and enable the Hyper-Threading 
Technology.

Note the following:

■ If your workstation does not support Hyper-Threading Technology, the Hyper-Threading 
menu item will not be available on the Computer Setup menu.

■ The Hyper-Threading Technology is recommended for use with Microsoft® Windows® XP 
systems. This technology is detected by the system and is turned on in the operating system 
after it is enabled in the system BIOS.

■ Hyper-Threading is not recommended for use with Windows 2000-based workstations.

■ The Hyper-Threading Technology is compatible with Linux-based systems. An SMP kernel 
must be installed on your system before this technology can be enabled.

■ For more information about the Hyper-Threading Technology, you can visit the Intel Web 
site at www.intel.com.
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Setup Utilities and Diagnostic Features

Setup Utilities (F10) and diagnostic features provide information needed about the computer 
system when contacting HP Customer Support. These tools can also be used to:

■ Change factory default settings and to set or change the system configuration, which may be 
necessary when you add or remove hardware.

■ Determine if all of the devices installed on the computer are recognized by the system and 
functioning properly.

■ Determine information about the operating environment of the computer.

■ Solve system configuration errors detected but not automatically fixed during the Power-On 
Self-Test (POST).

■ Establish and manage passwords and other security features.

■ Establish and manage energy-saving timeouts.

✎ All features identified in this chapter may not be available on all HP products.

Power-On Self-Test (POST)
POST is a series of diagnostic tests that runs automatically when the system is turned on, POST 
checks the following items to ensure that the computer system is functioning properly:

■ Keyboard

■ Memory modules

■ Diskette drives

■ All IDE and SCSI mass storage devices 

■ Processors

■ Controllers

✎ If the Power-On Password is set, a key icon appears on the screen while POST is running. You 
will need to enter the password before continuing. Refer to Chapter 3 for information on setting, 
deleting, or bypassing the password.

If POST finds an error in the system, an audible and/or visual message occurs. Refer to Appendix 
C for POST error messages and their solutions.
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2.1 Computer Setup Utilities
Use Computer Setup Utilities (F10) to: 

■ Modify or restore factory default settings.

■ Set the system date and time.

■ Set, view, change, or verify the system configuration including settings for processor, 
graphics, memory, audio, storage, communications, and input devices.

■ Modify the boot order of bootable devices such as hard drives, diskette drives, CD-ROM 
drives, DVD-ROM drives, or PD-CD drives.

■ Configure Quiet Drive options (for drives that support this feature).

■ Enable Quick Boot which is faster than Full Boot but does not run all of the diagnostic tests 
run during a Full Boot. You can set your system to:

❏ Always Quick Boot (default);

❏ Periodically Full Boot (from every 1 to 30 days); or

❏ Always Full Boot.

■ Enable or disable Network Server Mode, which allows the computer to boot the operating 
system when the power-on password is enabled. The keyboard and mouse remain locked 
until the power-on password is entered.

■ Select POST Messages Enabled or Disabled to change the display status of Power-On 
Self-Test (POST) messages. POST Messages Disabled suppresses most POST messages, 
such as memory count, product name, and other non-error text messages. If a POST error 
occurs, the error is displayed regardless of the mode selected. To manually switch to POST 
Messages Enabled during POST, press any key (except F10 or F12).

■ Establish Ownership Tag, the text of which is displayed each time the system is turned on or 
restarted.

■ Enter the Asset Tag or property identification number assigned to this computer.

■ Enable power-on password prompting during system restarts (warm boots) as well as during 
power-on.

■ Establish a setup password that controls access to Computer Setup and the settings described 
in this section.

■ Secure the integrated I/O functionality, including the serial, USB, or parallel ports; audio; or 
embedded NIC, so that they cannot be used until they are unsecured.

■ Enable or disable Master Boot Record (MBR) Security.

■ Enable or disable removable media boot ability.

■ Enable or disable removable media write ability.

■ Solve system configuration errors detected but not automatically fixed during the Power-On 
Self-Test (POST).

■ Replicate your system setup by saving system configuration information on diskette and 
restoring it on one or more computers.

■ Execute self-tests on a specified IDE hard drive.

■ Configure various energy-saving features including energy saver mode, system and hard 
drive timeouts, power button mode, and power LED behavior.
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2.1.1 Using Computer Setup Utilities
To access the Computer Setup Utilities (F10) menu, complete the following steps: 

1. Turn on or restart the computer. To restart the computer in Windows click Start > Shut 
Down > Restart the Computer. 

2. When the F10 Setup message appears in the lower-right corner of the screen, press the F10 
key. Press Enter to bypass the title screen, if necessary (for English only).

✎ If you do not press the F10 key while the message is displayed, you must turn the computer off, 
then on again, to access the utility.  
 
Pressing the F12 key initiates Network Service Boot for Remote System Installation.

A choice of five headings appears in the Computer Setup Utilities menu: File, Storage, Security, 
Power, and Advanced. Section 2.1.2 in this chapter provides more information about the features 
that are available. 

3. Using the arrow keys or the Tab key, select the option you want and press Enter. To return to 
the Computer Setup Utilities menu, press Esc.

4. To apply and save changes, select File > Save Changes and Exit. 

❏ If you selected an option that automatically restarted the computer, changes were applied 
at that time.

❏ If you have made changes that you do not want applied, select Ignore Changes and Exit.

❏ If you have already applied changes you now want to eliminate, select Set Defaults and 
Exit. This option will restore the original system defaults.

✎ Be sure to configure new options and drivers in the operating system after they have been 
configured by the Setup Utility.
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2.1.2 Computer Setup Menu
.

Heading Option Description  

File System 
Information

Lists product name/type/speed/stepping, cache size, system 
ROM family and version, installed memory size, system board 
revision, chassis serial number, integrated MAC for enabled or 
embedded NIC (if applicable), and asset tracking number.

About Provides copyright information

Set Time and 
Date

Allows you to set system time and date.

Save to Diskette Saves system configuration, including CMOS, to a formatted 
blank 1.44-MB diskette.

Restore from 
Diskette

Restores system configuration from a diskette.

Set Defaults and 
Exit

Restores factory default settings and clears all passwords.

Ignore Changes 
and Exit

Exits Computer Setup without applying or saving any changes.

Save Changes 
and Exit

Saves changes to system configuration and exits Computer 
Setup.

Storage Device 
Configuration

Lists all installed storage devices. The following options appear 
when a device is selected:

Diskette Type (For legacy diskette drives only) 
Identifies the highest capacity media type accepted by the 
diskette drive. Options are 3.5" 1.44 MB, 3.5" 720 KB, 5.25" 
1.2 MB, 5.25" 360 KB, and Not Installed.

Drive Emulation (IDE devices only) 
Allows you to select a drive emulation type for a storage device. 
(For example, a Zip drive can be made bootable by selecting 
disk emulation.)

Drive Type Emulation Options

Hard disk No emulation options available.

Diskette None (treated as diskette drive)

Disk (treated as hard drive)

CD-ROM None (treated as CD-ROM drive)

Diskette (treated as diskette drive)

Disk (treated as hard drive)

Other (e.g., Zip 
drive)

None (treated as Other)

CD-ROM (treated as CD-ROM drive)

Diskette (treated as diskette drive)
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Disk (treated as hard drive)

Storage 
(continued)

Device 
Configuration 
(continued)

Transfer Mode (IDE devices only) 
Specifies the active data transfer mode. Options (subject to 
device capabilities) are PIO 0, Max PIO, Enhanced DMA, Ultra 
DMA 0, and Max UDMA.

Translation Mode (IDE disks only) 
Lets you select the translation mode to be used for the device. 
This enables the BIOS to access disks partitioned and formatted 
on other systems and may be necessary for users of older 
versions of Unix (e.g., SCO Unix 3.2). Options are Bit-Shift, LBA 
Assisted, User, and None.

Ä Ordinarily, the translation mode selected automatically by the 
BIOS should not be changed. If the selected translation mode 
is not compatible with the translation mode that was active 
when the disk was partitioned and formatted, the data on the 
disk will be inaccessible.

Translation Parameters (IDE Disks only) 
Allows you to specify the parameters (logical cylinders, heads, 
and sectors per track) used by the BIOS to translate disk I/O 
requests (from the operating system or an application) into terms 
the hard drive can accept. Logical cylinders may not exceed 
1024. The number of heads may not exceed 256. The number 
of sectors per track may not exceed 63. These fields are only 
visible and changeable when the drive translation mode is set 
to User.

Multisector Transfers (IDE ATA devices only) 
Specifies how many sectors are transferred per multi-sector PIO 
operation. Options (subject to device capabilities) are Disabled, 
8, and 16. 

Quiet Drive (available on select drives only)
• Performance 

Allows the drive to operate at maximum performance.
• Quiet 

Reduces noise from the drive during operation. When set to 
Quiet, the drive will not operate at maximum performance.

✎ If the drive does not support Quiet mode, the Quiet Drive 
option will not be displayed.

Options Removable Media Boot 
Enables/disables ability to boot the system from removable 
media.

✎ After saving changes to Removable Media Boot, the 
computer will restart. Manually, turn the computer off, then 
on. 

Primary IDE Controller 
Allows you to enable or disable the primary IDE controller.

Secondary IDE Controller
Allows you to enable or disable the secondary IDE controller.

Heading Option Description  (Continued)
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Storage 
(continued)

Options 
(continued)

Diskette MBR Validation 
Allows you to enable or disable strict validation of the diskette 
Master Boot Record (MBR). 

✎ If you use a bootable diskette image that you know to be 
valid, and it does not boot with Diskette MBR Validation 
enabled, you may need to disable this option in order to use 
the diskette.

DPS Self-Test Allows you to execute self-tests on IDE hard drives capable of 
performing the Drive Protection System (DPS) self-tests.

✎ This selection will only appear when at least one drive 
capable of performing the IDE DPS self-tests is attached to the 
system.

Controller Order Allows you to specify the order of the attached hard drive 
controllers. The first hard drive controller in the order will have 
priority in the boot sequence and will be recognized as drive C 
(if any devices are attached.
The selection will not appear if all hard drives are attached to 
the embedded IDE controllers.

SCSI Narrow 
Termination

Allows you to configure SCSI termination on the external SCSI 
connector for narrow SCSI drives. The feature should only be 
enabled if using a narrow SCSI drive to terminate the external 
SCSI channel.

Boot Order Allows you to specify boot order of installed peripheral devices 
(such as LS-120 drive, diskette drive, hard drive, SCSI drive, 
CD-ROM drive, or DVD-ROM drive).

Security Setup Password Enables setup (administrator) password. 
See Section 3.4, “Asset Tracking and Security,” for more 
information.

Power-On 
Password

Enables power-on password. 
See Section 3.4, “Asset Tracking and Security,” for more 
information.

Password 
Options

Enables/disables network server mode.
Specifies prompting for power-on password. 
See Section 3.4, “Asset Tracking and Security,” for more 
information.
This selection will appear only if a power-on password is set 
and the network server mode is disabled. 

Smart Cover Enables/disables Smart Cover Sensor and Cover Lock. (Feature 
supported on select models only.)
Lists most recent cover removal. (Feature supported on select 
models only.)
See Section 3.4, “Asset Tracking and Security,” for more 
information.

Heading Option Description  (Continued)
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Security 
(continued)

DriveLock* Allows you to assign or modify a master or user password for 
certain hard drives. When enabled, the user is prompted to 
provide one of the DriveLock passwords during POST. If neither 
is successfully entered, the hard drive will remain inaccessible 
until one of the passwords is successfully provided during a 
subsequent cold-boot sequence.
This selection will only appear when at least one drive that 
supports the DriveLock feature is attached to the system.

Master Boot 
Record Security*

Allows you to enable or disable Master Boot Record (MBR) 
Security. When enabled, the BIOS rejects all requests to write to 
the MBR on the current bootable disk. Each time the computer is 
powered on or rebooted, the BIOS compares the MBR of the 
bootable disk to the previously saved MBR. If changes are 
detected, you are given the option of saving the MBR on the 
current bootable disk, restoring the previously saved MBR, or 
disabling MBR security, You must know the password if one is 
set.

✎ Disable MBR Security before intentionally changing the 
formatting or partitioning of the current bootable disk. 
Several disk utilities (such as FDISK and FORMAT) attempt to 
update the MBR. If MBR Security is enabled and disk 
accesses are being serviced by the BIOS, write requests to 
the MBR are rejected, causing the utilities to report errors. If 
MBR Security is enabled and disk accesses are being 
serviced by the operating system, any MBR change will be 
detected by the BIOS during the next reboot, and an MBR 
Security warning message will be displayed.

Save Master 
Boot Record*

Saves a backup copy of the Master Boot Record of the current 
bootable disk.

✎ Only appears if MBR Security is enabled.

Restore Master 
Boot  
Record*

Restores the backup Master Boot Record to the current bootable 
disk.

✎ Only appears if all of the following conditions are true: 
MBR Security is enabled.
A backup copy of the MBR has been previously saved.
The current bootable disk is the same disk from which the         
backup copy of the MBR was saved.

Device Security Enables/disables serial ports A & B; parallel and USB ports; 
system audio; network controller (some models); and SCSI 
controllers.

Network Service 
Boot

Enables/disables Network Service Boot. (Feature supported on 
select models only.)

*Option not supported on all products.

Heading Option Description  (Continued)
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Security 
(continued)

System IDs Allows you to set Asset Tag and Ownership Tag.
Allows setting of Chassis Serial Number if current number is 
invalid.
Also allows you to set keyboard locale setting (e.g., English or 
German) for System ID entry.
Allows setting of Ownership Tag and Universal Unique 
Identifier (UUID).
See Section 3.4, “Asset Tracking and Security,” for more 
information.

Power Energy Saver Allows you to set energy saver mode to Advanced, Disabled, or 
Minimal.

✎ In the minimal energy saver mode setting, the hard drive and 
system do not go into energy saver mode, but the setting 
allows you to press the power button to suspend the 
system.This option does not apply under ACPI-enabled 
operating systems.

Timeouts Allows you to enable/disable or manually select timeout values.

✎ This selection will appear only when energy saver mode is 
set to advanced.This option does not apply under 
ACPI-enabled operating systems. 

Energy Saver 
Options

Allows you to set power button configuration (on/off or 
sleep/wakeup.)
Allows user to enable/disable power LED blink in suspend 
mode.

✎ This selection will appear only if the energy saver mode is 
enabled. This option does not apply under ACPI-enabled 
operating systems.

Advanced** Power-On 
Options

Allows you to set POST mode (QuickBoot or FullBoot every n 
days where n = 1 to 30), enables/disables POST messages, 
and delay POST.
Enables/disables Safe Post, F9 prompt, F10 prompt, F12 
prompt, option ROM prompt, UUID, I/O APIC Mode, USB 
Buffer @ Top of Memory, and Hot-Pluggable MB Floppy.
Allows you to select the wakeup boot source (local hard drive or 
remote server).
Allows you to select computer state after a power loss  
(On or Off).

✎ The suspend/sleep feature of Remote Management cannot 
be used if If the computer was turned off using a power strip.

Onboard 
Devices

Allows you to set resources for onboard system devices (serial 
port, parallel port, diskette controller, etc.).

**These options should be used by advanced users only.

Heading Option Description  (Continued)
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PCI Devices Lists currently installed PCI devices and their IRQ settings. 
Allows you to reconfigure IRQ settings for these devices or to 
disable them entirely. These settings have no effect under an 
APIC-based operating system.

Advanced 
(continued)**

Bus Options Enables/disables PCI bus mastering, PCI VGA palette 
snooping, PCI SERR# generation, and ECC on select models.

Device options Allows you to set printer mode (EEP+ECP), Output only, 
bidirectional, and NumLock state at power-on.
Enable/disable Power Management Events (PME) wakeup 
events, processor cache, processor number, ACPI thermal 
mode, and ACPI S3 support. (When ACPI S3 is enabled you 
may also enable/disable ACPI S3 video repost, PS/2 mouse 
wakeup, and hard disk reset.)
Allows you to select AGP aperture size (4, 8, 16, 32, 64, 128, 
or 256 MB).
Enables monitor tracking.

PCI VGA 
Configuration

Allows users to specify which VGA controller will be the “boot” 
or primary VGA controller.
Appears only if there are multiple PCI video adapters in the 
system.

*Option not supported on all products. 
**These options should be used by advanced users only.

Heading Option Description  (Continued)
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2.2 Computer Diagnostics    

✎ The following section applies only to computers equipped with a diskette drive and running an 
OS that supports the production of a Diagnostics diskette.

HP strongly recommends that you create a diagnostics diskette as soon as you begin to use the 
computer. This is a bootable diskette that allows you to test and inspect the hardware outside of 
the operating system by running the Computer Checkup (TEST) or View System Information 
(INSPECT) diagnostic programs. The diskette will play an important role in the restoration 
process if you ever experience a major system failure. 

Another diagnostic feature is Diagnostics for Windows, described in Section 2.2.4.

2.2.1 Create a Diagnostics Diskette

DOS-Based 
To create a bootable, DOS-based Diagnostic Diskette (some models may require two 1.44-MB 
diskettes), run the SoftPaq executable file found in C:\DIAGDISK\ to extract the necessary files. 
Insert a blank 1.44MB formatted diskette into the diskette drive, then run 
C:\DIAGDISK\PDIAG\MAKEDISK.BAT

✎ To obtain the SoftPaq executable filename, run DIR C:\DIAGDISK\SP*.EXE

Windows-Based 
NOTE: Not all versions of Windows support this feature.

Using the Windows operating system:

Click Start > Compaq Information Center > Create Diagnostics Disk. Insert a diskette into the 
diskette drive and follow the instructions on the screen.

2.2.2 Computer Checkup (TEST)
Use Computer Checkup (TEST) in the following instances to:

■ Determine if all the devices installed on the computer are recognized by the system and 
functioning properly. Running TEST is optional but recommended after installing or 
connecting a new device.

✎ Third-party devices not supported by HP may not be detected.

■ Save, print, or display the information generated by TEST. You should run TEST and have 
the printed report available before placing a call to the Compaq Customer Support Center.

■ Reproduce the same environment on another computer for testing. 

✎ Before you run TEST, you must create a diagnostics diskette. See Section 2.2.1, “Create a 
Diagnostics Diskette,” for instructions.
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Running TEST
1. Turn off the computer.

2. Disconnect all peripheral devices other than the keyboard and monitor. Do not disconnect the 
printer if you want to test it or use it to log error messages.

3. Install loop-back and terminating plugs to test external ports if desired.

4. Cold boot the computer from the diagnostics diskette you have created. Press Enter to bypass 
the title screen, if necessary.

5. Select Computer Checkup (TEST).

6. Select the option to view the device list. A list of installed hardware devices appears.

7. Verify that TEST correctly detected the devices installed. This utility will detect all devices 
manufactured or supported by HP; devices from other manufacturers may not be detected.

❏ If the list is correct, select OK and go to step 8.

❏ If the list is incorrect, be sure that any new devices are installed properly. 

8. Select one of the following from the test option menu: 

❏ Quick Check Diagnostics—This option runs a quick, general test on each device with a 
minimal number of prompts. If errors occur, they are displayed when the testing is 
complete. This option will only test the first 16 MB of memory.

❏ Automatic Diagnostics—This option runs unattended, maximum testing of each device 
with minimal prompts. You can choose how many times to run the tests, to stop on 
errors, or to print or file a log of errors.

❏ Prompted Diagnostics—This option allows maximum control over the device testing 
process. You can choose attended or unattended testing, decide to stop on errors, or 
choose to print or file a log of errors.

✎ If attended testing is selected, the test itself may result in data loss.

Follow the instructions on the screen as the diagnostic tests are run on the devices. When the 
testing is complete, the TEST option menu is displayed again.

9. To exit TEST, press the Esc key to reach the Exit option. Then press Enter.

✎ Refer to Appendix E for a listing of the Diagnostic Error Codes.
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2.2.3 View System Information (INSPECT)
Use View System Information (INSPECT) to:

■ View information about the system once it has been configured.

■ Save, print, or display the information generated by INSPECT. You should run INSPECT 
and have the printed report available before placing a call to the HP Customer Support 
Center.

■ Assist your HP/Compaq authorized dealer, reseller, or service provider in analyzing the 
system by allowing the service provider to reproduce the same environment on another 
computer for testing.

The information provided by INSPECT includes:

■ Contents of the operating system startup files

■ Current memory configuration

■ ROM versions

■ Type of processor and co-processor

■ Diskette, CD-ROM, DVD-ROM, tape, or hard drives installed

■ Active printer and communications interfaces

■ Modem type installed

■ Graphics settings

■ Windows WIN.INI file details

✎ Categories or items of information displayed by INSPECT are similar to but may vary slightly 
from those available in Diagnostics for Windows.  
 
Before you run INSPECT, you must create a diagnostics diskette. See Section 2.2.1, “Create a 
Diagnostics Diskette,” for instructions.

Running INSPECT
1. Cold boot the computer from the diagnostics diskette you have created. Press Enter to bypass 

the title screen, if necessary.

2. Select View System Information (INSPECT).

3. Select one of the available options using the Esc key:

❏ Print the INSPECT status.

❏ Save the INSPECT status to a file.

❏ Add comments to a parameter status.

❏ Exit the utility.

4. To exit INSPECT, press the Esc key to reach the Exit option. Then press Enter.
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2.2.4 Diagnostics for Windows 

Diagnostics for Windows is a component of Intelligent Manageability that allows you to view:

■ System overview

■ AssetControl information

■ Input devices

■ Communications ports

■ Storage devices

■ Graphics information

■ Memory configuration

■ Security management settings

■ System health

■ Operating system

■ Windows version

Depending on the version, Diagnostics for Windows may include diagnostic tests to determine if 
all the devices installed on the computer are recognized by the system and are functioning 
properly. 

Using Diagnostics for Windows
1. Select the Diagnostics for Windows icon, located in the Control Panel.

2. The screen displays an overview of the computer hardware and software.

3. For specific hardware and software information, select a category from the Categories menu 
or from the toolbar.

✎ As you move your cursor over the toolbar icons, the corresponding category names appear near 
the cursor.

4. To display more detailed information in a selected category, click More in the Information 
Level box.

✎ Categories or items of information displayed by Diagnostics for Windows are similar to but may 
vary slightly from the information presented in View System Information (INSPECT).

5. Review and print this information.

✎ To print the information, click File, then select Print. Select one of the following options: 
Detailed Report (All Categories), Summary Report (All Categories), or Current Category. Click 
OK to print the report you selected.

6. To exit Diagnostics for Windows, click File, then click Exit.
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Running Diagnostic Tests
If your version of Diagnostics for Windows includes diagnostic testing utilities, four tabs will 
appear next to Overview: Test, Status, Log, and Error.

1. Select the Test tab. 

2. Select one of the following options:

❏ Quick Test—Runs a quick, general test on each device with a minimal number of 
prompts.

❏ Complete Test—Runs maximum testing of each device with minimal prompts.

❏ Custom Test—Runs only the tests you select. To select specific devices or tests, find the 
device in the list, then click the box beside each test to select or deselect it. When 
selected, a red check mark appears in the box.

3. Select Interactive Mode or Unattended Mode. 

4. In Interactive Mode, the diagnostic software will prompt you for input during tests that 
require it. Some tests require interaction and will display errors or halt testing if selected in 
conjunction with Unattended Mode. 

5. Click the Begin Testing button.

6. Test Status is displayed, showing the progress and result of each test. 

7. If errors are found, click the Error tab to display more detailed information and 
recommended actions. By following the recommended actions, you may be able to solve 
some problems yourself.

8. Click Print or Save the error information in case you need to contact your HP authorized 
dealer, reseller, or service provider for assistance.

9. To exit Diagnostics for Windows, click File, then click Exit.

2.3 Protecting the Software
To protect software from loss or damage, you should keep a backup copy of all system software, 
applications, and related files stored on the hard drive. The Restore CD or the Restore Plus! CD 
that accompanies many desktop and workstation models enables the user to selectively restore 
the original system software. You can order a replacement copy of the Restore CD from HP at 
nominal cost for all of the software preinstalled on the computer. Refer to the operating system or 
backup utility documentation for instructions on making backup copies of data files. 
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2.3.1 Ordering Backup Software
You can order all software that shipped with the product from HP as a single set, or you can order 
the various software packages separately.

✎ Before calling HP to place your order, be sure to have the serial number of the computer 
available. This number is necessary for all diskette purchases.

2.3.2 Restore CD
The Windows-based systems ship with either the Restore CD or the Restore Plus! CD that offer 
easy deployment and recovery of system software. Along with the Microsoft operating system 
CD, the Restore and Restore Plus! CDs enable the user to selectively restore the original system 
software. This can be extremely helpful in the event of hard drive failure or corruption. Required 
drivers that are not included on the Restore CD or the Restore Plus! CD may be downloaded 
from the HP web site at www.hp.com.
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3
Desktop Management

HP Intelligent Manageability provides standards-based solutions for managing and controlling 
workstations in a networked environment. This guide summarizes the capabilities and features of 
the four key components of desktop management:

■ Initial configuration and deployment

■ Software updating and management

■ Asset tracking and security

■ Fault notification and recovery

✎ Support for specific features described in this guide may vary by model or software version.

3.1 Initial Configuration and Deployment
HP workstations come with a preinstalled system software image. After a very brief software 
“unbundling” process, the computer is ready to be used.

You may prefer to replace the preinstalled software image with a customized set of system and 
application software. There are several methods for deploying a customized software image. 
They include:

■ Installing additional software applications after unbundling the preinstalled software image.

■ Using software deployment tools, such as Microsoft MS Batch or NT Distribution Share 
(NTDS), or Altiris eXpress to replace the preinstalled software with a customized software 
image.

■ Using a disk cloning process to copy the contents from one hard drive to another.

The best deployment method depends on your information technology environment and 
processes. The PC Deployment section of the Solutions and Services Web site 
(www.compaq.com/solutions/pcsolutions) provides information to help you select the best 
deployment method. You’ll also find guides and utilities to integrate Microsoft or PXE-based 
deployment tools.

The Restore or the Restore Plus! CD, ROM-based setup, and ACPI-ready hardware provide 
further assistance with recovery of system software, configuration management and 
troubleshooting, and power management.
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3.2 Remote System Installation
Remote System Installation lets you start and set up your system using the software and 
configuration information located on a network server. This feature is usually used as a system 
setup and configuration tool, and can be used for the following tasks:

■ Deploying a software image on one or more new PCs.

■ Formatting a hard drive.

■ Installing application software or drivers.

■ Updating the operating system, application software, or drivers.

To initiate Remote System Installation, press F12 when the F12=Network Service Boot message 
appears in the lower-right corner of the HP/Compaq logo screen. Follow the instructions on the 
screen to continue the process.

3.3 Software Updating and Management
HP provides several tools for managing and updating software on desktops and 
workstations—Altiris eXpress, Altiris PC Transplant Pro, PC Transplant for Compaq, Insight 
Manager™ LC, System Software Manager, and Remote Management Setup Utilities. Using 
Insight Manager LC, you can also monitor a workgroup of PCs from a central console and 
remotely update the system software, security settings, flash ROM, or hardware device drivers, 
for each of the managed PCs individually. 

3.3.1 Altiris eXpress
Altiris eXpress allows the system administrator to create and quickly deploy a customized, 
corporate-standard software image across one or more networked client PCs with an interface as 
simple to use as Windows Explorer. Altiris eXpress supports Intel’s Wired for Management and 
Preboot Execution Environment (PXE). Using Altiris eXpress and the Remote System 
Installation features of the computer, there is no need for the system administrator to visit each 
new PC individually to deploy the software image.

Altiris eXpress is able to install a disk image containing the operating system, application 
software, and the Altiris eXpress client, without requiring the use of a separate boot diskette. 
With Altiris eXpress, the network administrator can:

■ Create a new image or edit an existing image, or clone a PC on the network which may have 
the ideal image.

■ Create any number of customized disk images for a variety of workgroups.

■ Edit image files, modifying them without having to start from scratch. This is possible 
because Altiris eXpress stores files in its native format: NTFS, FAT16, or FAT32.

■ Establish a “New PC Event,” a script that will run automatically when a new PC is added to 
the network. The script can, for instance, format the PC hard drive, flash the ROM BIOS, and 
install a full, standard software image.

■ Schedule an event to run on a group of computers.

Altiris eXpress also includes easy-to-use software distribution capabilities. You can use Altiris 
eXpress to update operating systems and application software from a central console. When used 
in conjunction with System Software Manager, Altiris eXpress can also update ROM BIOS and 
device driver software.
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For more information, refer to the HP web site at www.hp.com.

3.3.2 PC Transplant Pro and PC Transplant for Compaq
PC Transplant is designed to assist you in personalizing your new HP workstation. It can be 
downloaded free from the HP web site. It lets you preserve the “personality” or the customized 
settings, such as Start menu entries, drive and printer mappings, software application options, 
and so on of an existing PC. It will then transfer those unique settings to a computer.

For more information, refer to the hp web site at www.hp.com.

3.3.3 HP Insight Manager LC
HP Insight Manager LC is a web-based tool for managing workgroups of PCs. It provides a 
unified “browser-based roaming console,” not only for HP/Compaq clients but any standard DMI 
2.0–based PC on the network. It can automatically discover, view system information, and 
receive alerts from any DMI 2.0 PC on a specified domain or workgroup.

For more information, refer to the HP web site at www.hp.com

3.3.4 System Software Manager
System Software Manager (SSM) is a utility that lets you update system-level software on 
multiple systems simultaneously. When executed on a PC client system, SSM detects both 
hardware and software versions, then updates the appropriate software from a central repository, 
also known as a file store. Support software that works with SSM is flagged with the PC 
Lifecycle Management icon on the HP web site. To download the utility or to obtain more 
information on SSM, visit the HP web site at www.hp.com.

3.3.5 Remote Management Setup Utilities
The Remote Management Setup Utilities, when integrated with Management Solutions Partners 
products supplement the capabilities of Solutions Partners products for distributing new 
applications, device drivers, and other system software. The HP web site includes updated ROM 
images and device drivers which can be distributed to client PCs using these software tools.

For more information, refer to the online Remote Management Administrators Guide. The 
Remote Management Administrators Guide is included with the Remote Management Setup 
Utilities, which are available on the HP web site at www.hp.com. The following sections provide 
information on using these utilities to accomplish various remote management functions 
including ROM flash, changing security settings, and wakeup/shutdown.
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3.3.6 Remote ROM Flash
Your computer comes with a reprogrammable flash ROM (read only memory). By establishing a 
setup password in Computer Setup, you can protect the ROM from being unintentionally updated 
or overwritten. This is important to ensure the operating integrity of the computer. Should you 
need or want to upgrade your ROM, you may:

■ Order an upgraded ROMPaq diskette from HP.

■ Download the latest ROMPaq images from the HP web site (www.hp.com).

Ä
CAUTION: For maximum ROM protection, be sure to establish a setup password. The setup password 
prevents unauthorized ROM upgrades. HP Insight Manager LC allows the system administrator to set the 
setup password on one or more PCs simultaneously. For more information, visit the HP web site at 
www.hp.com.

Using Remote ROM Flash
Remote ROM Flash allows the system administrator to safely upgrade the ROM on remote HP 
computers directly from the centralized network management console. Enabling the system 
administrator to perform this task remotely on multiple computers results in a consistent 
deployment of and greater control over ROM images over the network. 

All ROMPaq ROM images from HP are digitally signed to ensure authenticity and minimize 
potential corruption. Your system ROM may include a Boot Block that is protected during the 
flash process and allows the computer to be restarted, in the unlikely event of an unsuccessful 
ROM flash.

✎ Your computer must be powered on, or turned on through Remote Wakeup, to take advantage of 
Remote ROM Flash. Use of Remote ROM Flash also requires an established setup password.

For more information on enabling Remote ROM Flash, refer to the online Remote Management 
Administrators Guide. The Remote Management Administrators Guide is included with the 
Remote Management Setup Utilities, and is available on the HP web site at www.hp.com.

FailSafe Boot Block ROM
The FailSafe Boot Block ROM allows for system recovery in the unlikely event of a ROM flash 
failure, for example, if a power failure were to occur during a ROM upgrade. The Boot Block is a 
flash-protected section of the ROM that checks for a valid system ROM flash when power to the 
system is turned on.

■ If the system ROM is valid, the system starts normally.

■ If the system ROM fails the validation check, the FailSafe Boot Block ROM provides 
enough support to start the system from a ROMPaq diskette, which will program the system 
ROM with a valid image.

When the Boot Block detects an invalid system ROM, the system sounds a series of beeps (one 
long and three short) and flashes the three keyboard lights (on and off two times). A Boot Block 
recovery mode message is displayed on the screen. 
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To recover the system after it enters Boot Block recovery mode, complete the following steps:

1. Remove any diskettes from the diskette drive and turn off the power.

2. Insert a ROMPaq diskette into the diskette drive.

3. Turn on power to the system.

4. If no ROMPaq diskette is found, you will be prompted to insert one and restart the computer.

5. If a setup password has been established, the Caps Lock light will turn on and you will be 
prompted to enter the password.

6. Enter the setup password.

7. If the system successfully starts from the diskette and successfully reprograms the ROM, 
then the three keyboard lights will turn on. A “rising tone” series of beeps also signals 
successful completion.

The following table lists the various keyboard light combinations used by the Boot Block ROM, 
as well as the meaning and action associated with each combination.

Keyboard Light Combinations Used by Boot Block ROM
Failsafe 

Boot Block 
Mode

Keyboard 
LED Color

Keyboard 
LED Activity State/Message

Num Lock Green On ROMPaq diskette not present, is bad, or 
drive not ready.*

Caps Lock Green On Enter password.*

Num, Caps, 
Scroll Lock

Green Turn on and off 
2 times 
(accompanied 
by 1 long and 
3 short beeps)

ROM flash failed.*

Num, Caps, 
Scroll Lock

Green On Boot Block ROM Flash successful. Turn 
power off, then on to reboot.

✎ Diagnostic lights do not flash on USB keyboards.

*Insert valid ROMPaq diskette in drive A. Turn power switch off, then on to reflash ROM. 
If ROM flash is successful, all three keyboard LEDs will light up, and you will hear a rising 
tone series of beeps. Remove diskette and turn power off, then on to restart the computer. 
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3.3.7 Remote Security Management
Remote Security Management allows the system administrator to safely set or modify security 
features on remote workstations directly from the centralized network management console. 
Enabling the system administrator to perform these tasks remotely, on multiple computers, 
results in consistent deployment of and greater control over client computer security parameters 
over the network. 

✎ Your computer must be powered on, or turned on through Remote Wakeup, to take advantage of 
Remote Security Management. Use of Remote Security Management also requires an established 
setup password.

For more information about the Remote Management Setup software and enabling Remote 
Security Management, refer to the online Remote Management Administrators Guide. The 
Remote Management Administrators Guide is included with the Remote Management Setup 
Utilities, and is available on the HP web site at www.hp.com.

3.3.8 Remote Wakeup and Remote Shutdown 
If your computer has an optional network card installed, it may support the Remote Wakeup and 
Remote Shutdown functions. These functions allow a system administrator to power on and 
power off a client computer from a remote location supported by PC LAN management tools.

✎ Third-party software tools are required to remotely distribute software.

Remote Wakeup allows the network interface controller to continue functioning when power to 
the computer has been turned off, but the power cord is still connected to an electrical outlet. 

✎ The computer continues to consume a small amount of electricity even after you turn it off. Only 
when you disconnect the power cord from the electrical outlet does the computer stop consuming 
electricity.

To enable Remote Wakeup and Remote Shutdown, complete the following steps:

1. Double-click the Network Icon, located in the Control Panel.

2. Double-click the appropriate network controller.

3. Click the Advanced Properties tab.

4. Select Remote Wakeup.

5. Change the value to ON.

6. Click OK to save and apply changes, then click OK to exit the Network dialog.

For more information on using Remote Wakeup and Remote Shutdown, refer to the online 
Remote Management Administrators Guide. The Remote Management Administrators Guide is 
included with the Remote Management Setup Utilities, and is available on the HP web site at 
www.hp.com.

3.3.9 NIC Alert
The NIC Alert function enables desktop PCs to send an immediate alert to the network 
administrator when there is a hardware or operating system failure, or evidence of tampering. An 
alert will be sent even if the system is powered off or the operating system has not yet started.
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3.3.10 Replicating Your Setup
This procedure gives an administrator the ability to easily copy one setup configuration to other 
computers of the same model. This allows for faster, more consistent configuration of multiple 
computers. To replicate your setup:

1. Access the Computer Setup Utilities menu. 

2. Click File > Save to Diskette. Follow the instructions on the screen.

✎ This requires an internal diskette drive, a MultiBay LS-120 drive, or a portable, external diskette 
drive.

3. To replicate the configuration, click File > Restore from Diskette, and follow the instructions 
on the screen.

Altiris eXpress and PC Transplant make it easy to replicate the configuration and custom settings 
of one PC and copy it to one or more PCs. For more information, visit the hp Web site at 
www.hp.com.

3.3.11 Dual-State Power Button
With Advanced Configuration and Power Interface (ACPI) enabled for Windows, the power 
button can function either as an on/off switch or as a suspend button. The suspend feature does 
not completely turn off power, but instead causes the computer to enter a low-power standby. 
This allows you to quickly power down without closing applications and to quickly return to the 
same operational state without any data loss.

To change the power button's configuration, complete the following steps:

1. Access the Computer Setup menu.

2. Select Power > Energy Saver. Select Minimal or Advanced to turn on the Energy Saver 
Options menu.

3. Select Power > Energy Saver Options. Set the power button configuration to either On/Off or 
Suspend/Wakeup, as desired.

4. Refer to the Computer Setup (F10) Utility Guide for more detailed information about the 
features of Computer Setup.

5. Select File > Save Changes and Exit.

After configuring the power button to function as a suspend button, press the power button to put 
the system in a very low power state (suspend). Press the button again to quickly bring the system 
out of suspend to full power status. To completely turn off all power to the system, press and hold 
the power button for four seconds.

✎ If you have selected the “Blink LED during Energy Save” option in Computer Setup, the 
power-on light will blink green once every two seconds while the computer is in suspend. Refer 
to the Computer Setup (F10) Utility Guide for more information on using Computer Setup.
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3.3.12 Power Management
Power Management is a feature that saves energy by shutting down certain components of the 
computer when they are not in use, saving energy without having to shut down the computer. 
Timeouts (the period of inactivity allowed before shutting down these components) can be 
enabled, customized, or disabled using Computer Setup.

1. Access the Computer Setup menu.

2. Select Power > Energy Saver. Select Advanced to turn on the Timeouts menu.

3. Select Power > Timeouts. Enable, customize, or disable timeouts. 

4. Refer to the Computer Setup (F10) Utility Guide for more detailed information about the 
features of Computer Setup.

5. Select File > Save Changes and Exit.

✎ To avoid conflicts, never enable monitor timeouts in Windows 98 while system timeouts are 
enabled in Computer Setup.

Use Display Properties to establish, modify, or disable Power Management settings for the 
monitor. To access Display Properties, right-click on the Windows Desktop, then choose 
Properties.

3.3.13 World Wide Web Site
When making the transition to new or revised operating systems, it is important to implement the 
support software designed for that operating system. If you plan to run a version of Microsoft 
Windows or Microsoft Windows NT Workstation that is different from the version included with 
your computer, you must install corresponding device drivers and utilities to ensure that all 
features are supported and functioning properly.

HP has made the task of locating, accessing, evaluating, and installing the latest support software 
easier. You can download the software from the HP web site at www.hp.com.

The Web site contains the latest device drivers, utilities, and flashable ROM images needed to 
run the latest Microsoft Windows operating system on your HP workstation.

3.3.14 Desktop Management Interface (DMI)
The Desktop Management Task Force (DMTF) is an industry body with the goal of standardizing 
systems manageability. DMTF established the Desktop Management Interface (DMI) framework 
to standardize access to PC configuration data. HP delivers hardware and software 
instrumentation that supports the DMI standard.

For more information on configuring the DMI software, refer to the online Intelligent 
Manageability Guide. 
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3.3.15 Wired for Management
Intel's Wired for Management initiative is focused on reducing the support and administration 
cost of Intel architecture–based systems without compromising flexibility and performance. The 
Wired for Management guidelines provide a baseline set of building blocks that are utilized in 
Intelligent Manageability to provide standardized management of desktop inventories, remote 
system configuration, off-hours maintenance, and next generation power management. 
Additional capabilities have been incorporated into Intelligent Manageability to provide an 
extensive solution for managing networked computing environments. 

Wired for Management technologies include:

■ Desktop Management Interface (DMI) 2.0

■ Remote System Installation

■ Remote Wakeup and Remote Shutdown

■ ACPI-Ready Hardware

■ SMBIOS

■ Pre-boot Execution (PXE) support

■ Boot Integrity Services (BIS)

3.4 Asset Tracking and Security
The asset control features incorporated into the computer provide key asset tracking data that can 
be managed using HP Insight Manager products and Management Solutions Partners products. 
Seamless, automatic integration between AssetControl features and these products enables you 
to choose the management tool that is best suited to your environment and to leverage your 
investment in existing tools. 

HP workstations are manufactured with the hardware and firmware required to fully support the 
DMI 2.0 standard.

HP also offers several solutions for controlling access to valuable components and information. 
Security features such as the Smart Cover Sensor and the Smart Cover Lock, available on select 
models, help to prevent unauthorized access to the internal components of the personal computer. 
By disabling parallel, serial, or USB ports, or by disabling removable media boot capability, you 
can protect valuable data assets. Memory Change and Smart Cover Sensor alerts can be 
automatically forwarded to HP Insight Manager products to deliver proactive notification of 
tampering with a computer’s internal components.

There are three ways to manage security settings on your HP computers:

■ Locally, using the Setup Utilities. See the Computer Setup (F10) Utility Guide included with 
the computer for additional information and instructions on using the Computer Setup 
Utilities.

■ Remotely, using the Remote Security Management software. This software enables the 
secure, consistent deployment and control of security settings from a central point on the 
network using a third-party PC LAN management application such as Microsoft SMS.

■ Remotely, using HP Insight Manager LC, a tool for managing PC workgroups.
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The following table and sections refer to managing security features of your computer locally 
through the Setup Utilities. Refer to the Remote Management Setup Utilities for more 
information on using the Remote Security Management software. These utilities are available on 
the HP web site at www.hp.com.

Security Features Overview  
Feature Purpose How It Is Established

Removable Media Boot 
Control

Prevents booting from the 
removable media drives.

From the Setup Utilities menu. 

Serial, Parallel, USB, or 
Infrared Interface Control

Prevents transfer of data 
through the integrated serial, 
parallel, USB (universal serial 
bus), or infrared interface.

From the Setup Utilities menu.

Power-On Password Prevents use of the computer 
until the password is entered. 
This can apply to both initial 
system startup and restarts.

From the Setup Utilities menu.

Setup Password Prevents reconfiguration of 
the computer (use of the 
Computer Setup Utilities) until 
the password is entered.

From the Setup Utilities menu.

Network Server Mode Provides unique security 
features for computers being 
used as servers.

From the Setup Utilities menu.

DriveLock Prevents unauthorized access 
to the data on specific hard 
drives. This feature is 
available on select models 
only.

From the Setup Utilities menu.

Smart Cover Sensor Indicates that computer cover 
or side panel has been 
removed. Can be set to 
require the setup password to 
restart the computer, after the 
cover or side panel has been 
removed.

From the Setup Utilities menu. 

Master Boot Record Security May prevent unintentional or 
malicious changes to the 
Master Boot Record of the 
current bootable disk, and 
provides a means of 
recovering the “last known 
good” MBR.

From the Setup Utilities menu.

Memory Change Alerts Detects when memory 
modules have been added, 
moved, or removed; notifies 
user and system 
administrator.

For information on enabling 
Memory Change Alerts, refer 
to the online Intelligent 
Manageability Guide.
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3.4.1 Password Security
The power-on password prevents unauthorized use of the computer by requiring entry of a 
password to access applications or data each time the computer is turned on or restarted. The 
setup password specifically prevents unauthorized access to Computer Setup, and can also be 
used as an override to the power-on password. That is, when prompted for the power-on 
password, entering the setup password instead will allow access to the computer.

A network-wide setup password can be established to enable the system administrator to log in to 
all network systems to perform maintenance without having to know the power-on password, 
even if one has been established.

Establishing a Setup Password Using Computer Setup
Establishing a setup password through Computer Setup prevents reconfiguration of the computer 
(use of the Computer Setup utility) until the password is entered.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart the 
computer.

2. When the F10 Setup message appears in the lower-right corner of the screen, press the F10 
key. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key while the message is displayed, you must restart the computer to 
access the utility.

3. Select Security, then select Setup Password and follow the instructions on the screen.

4. Before exiting, click File > Save Changes and Exit. 

Establishing a Power-On Password Using Computer Setup
Establishing a power-on password through Computer Setup prevents access to the computer 
when power is turned on, unless the password is entered. When a power-on password is set, 
Computer Setup presents Password Options under the Security menu. The password options 
include Network Server Mode and Password Prompt on Warm Boot. 

Ownership Tag Displays ownership 
information, as defined by 
the system administrator, 
during system startup 
(protected by setup 
password).

From the Setup Utilities menu.

Kensington Cable Lock 
Provision

Inhibits access to the interior 
of the computer to prevent 
unwanted configuration 
changes or component 
removal. Can also be used to 
secure the computer to a 
fixed object to prevent theft. 

Install a Kensington cable 
lock to secure the computer 
to a fixed object.

✎ For more information about Computer Setup, see the Computer Setup (F10) Utility Guide.

Security Features Overview  (Continued)
Feature Purpose How It Is Established
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When Network Server Mode is disabled, the password must be entered each time the computer is 
turned on when the key icon appears on the monitor. When Password Prompt on Warm Boot is 
enabled, the password must also be entered each time the computer is rebooted. When Network 
Server Mode is enabled, the password prompt is not presented during POST, but any attached 
PS/2 keyboard will remain locked until the user enters the power-on password.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart the 
Computer.

2. When the F10 Setup message appears in the lower-right corner of the screen, press the F10 
key. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key while the message is displayed, you must restart the computer to 
access the utility.

3. Select Security, then Power-On Password and follow the instructions on the screen.

4. Before exiting, click File > Save Changes and Exit.

Entering a Power-On Password 
To enter a power-on password, complete the following steps:

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart the 
Computer. 

2. When the key icon appears on the monitor, type your current password, then press Enter.

✎ Type carefully; for security reasons, the characters you type do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three 
unsuccessful tries, you must turn off the computer, then turn it on again before you can continue.

Entering a Setup Password
If a setup password has been established on the computer, you will be prompted to enter it each 
time you run Computer Setup.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart the 
computer. 

2. When the F10=Setup message appears in the lower-right corner of the screen, press the F10 
key.

✎ If you do not press the F10 key while the message is displayed, you must restart the computer to 
access the utility.

3. When the key icon appears on the monitor, type the setup password, then press the Enter key.

✎ Type carefully; for security reasons, the characters you type do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three 
unsuccessful tries, you must turn off the computer, then turn it on again before you can continue.
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Changing a Power-On or Setup Password
1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart the 

Computer. To change the setup password, run Computer Setup.

2. When the key icon appears, type your current password, a slash (/) or alternate delimiter 
character, your new password, another slash (/) or alternate delimiter character, and your new 
password again as shown: 
current password/new password/new password

✎ Type carefully; for security reasons, the characters you type do not appear on the screen.

3. Press the Enter key.

The new password takes effect the next time you turn on the computer.

✎ Refer to the “National Keyboard Delimiter Characters” section in this chapter for information 
about the alternate delimiter characters. 
 
The power-on password and setup password may also be changed using the Security options in 
Computer Setup.

3.4.2 Deleting a Power-On or Setup Password
1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart the 

Computer. To delete the setup password, run Computer Setup.

2. When the key icon appears, type your current password followed by a slash (/) or alternate 
delimiter character as shown: 
 
current password/

3. Press the Enter key.

✎ Refer to “National Keyboard Delimiter Characters” table for information about the alternate 
delimiter characters. The power-on password and setup password may also be changed using the 
Security options in Computer Setup.

National Keyboard Delimiter Characters
Each keyboard is designed to meet country-specific requirements. The syntax and keys that you 
use for changing or deleting your password depend on the keyboard that came with your 
computer.

National Keyboard Delimiter Characters
Arabic / Greek - Russian /
Belgian = Hebrew . Slovakian -
BHCSY* - Hungarian - Spanish -
Brazilian / Italian - Swedish/Finnish /
Chinese / Japanese / Swiss -
Czech - Korean / Taiwanese /
Danish - Latin American - Thai /
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Clearing Passwords 
If you forget your password, you cannot access the computer. Refer to the Troubleshooting Guide 
for instructions on clearing passwords.

3.4.3 Network Server Mode
Network Server Mode provides unique security features for computers being used as servers. It is 
only available when a power-on password has been set in Computer Setup. When the Network 
Server Mode is enabled, the power-on password is not required to boot the hard drive, and a 
keyboard is not required to be attached to the system. If a PS/2 keyboard is present, it will be 
locked until the user enters the power-on password. If a USB keyboard is present, it will remain 
usable by default. To prevent USB keyboard access after the operating system has loaded, a user 
must hide the USB Port under the Device Security option of Computer Setup’s Security menu. 
When used in conjunction with the Computer Setup After Power Loss power-on option, Network 
Server Mode permits the “server” to automatically reboot after a power interruption without user 
intervention. While Network Server Mode is enabled, the power-on password must be entered to 
boot the removable media (e.g. diskettes) or removable devices (e.g. USB flash devices).

3.4.4 DriveLock
DriveLock is a security feature that prevents unauthorized access to the data on specific hard 
drives. DriveLock has been implemented as an extension to Computer Setup. It is only available 
on certain systems and only when DriveLock-capable hard drives are detected. 

DriveLock employs a two-password security scheme. One password is intended to be set and 
used by a system administrator while the other is typically set and used by the end-user. There is 
no “back-door” that can be used to unlock the drive if both passwords are forgotten. Therefore, 
DriveLock is most safely used when the data contained on the hard drive is replicated on a 
corporate information system or is regularly backed-up.

In the event that both DriveLock passwords are lost, the hard drive is rendered unusable.

Using DriveLock
The DriveLock option appears under the Security menu in Computer Setup. The user is 
presented with options to set the master password or to enable DriveLock. A user password must 
be provided in order to enable DriveLock. Since the initial configuration of DriveLock is 
typically performed by a system administrator, a master password should be set first. HP 
encourages system administrators to set a master password whether they plan to enable 
DriveLock or keep it disabled. This will give the administrator the ability to modify DriveLock 
settings if the drive is locked in the future. Once the master password is set, the system 
administrator may enable DriveLock or choose to keep it disabled.

French ! Norwegian - Turkish .
French 
Canadian

é Polish - U.K. English /

German - Portuguese - U.S. English /
* For Bosnia-Herzegovina, Croatia, Slovenia, and Yugoslavia

National Keyboard Delimiter Characters
Arabic / Greek - Russian /
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If a locked hard drive is present, POST will require a password to unlock the device. If a 
power-on password is set and it matches the device’s user password, POST will not prompt the 
user to re-enter the password. Otherwise, the user will be prompted to enter a DriveLock 
password. Either the master or the user password may be used. Users will have two attempts to 
enter a correct password. If neither attempt succeeds, POST will continue but the data on the 
drive will remain inaccessible.

DriveLock Applications
The most practical use of the DriveLock security feature is in a corporate environment where a 
system administrator provides users with multibay hard drives for use in some desktop 
computers. The system administrator would be responsible for configuring the multibay hard 
drive which would involve, among other things, setting the DriveLock master password. In the 
event that the user forgets the user password or the equipment is passed on to another employee, 
the master password can always be used to reset the user password and regain access to the hard 
drive.

HP recommends that corporate system administrators who choose to enable DriveLock also 
establish a corporate policy for setting and maintaining master passwords. This should be done to 
prevent a situation where an employee intentionally or unintentionally sets both DriveLock 
passwords before leaving the company. In such a scenario, the hard drive would be rendered 
unusable and require replacement. Likewise, by not setting a master password, system 
administrators may find themselves locked out of a hard drive and unable to perform routine 
checks for unauthorized software, other asset control functions and support.

For users with less stringent security requirements, HP does not recommend enabling DriveLock. 
Users in this category include personal users or users who do not maintain sensitive data on their 
hard drives as a common practice. For these users, the potential loss of a hard drive resulting 
from forgetting both passwords is much greater than the value of the data DriveLock has been 
designed to protect. Access to Computer Setup and DriveLock can be restricted through the 
Setup password. By specifying a Setup password and not giving it to end users, system 
administrators are able to restrict users from enabling DriveLock.
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3.4.5 Smart Cover Sensor
Smart Cover Sensor is a combination of hardware and software technology that can alert you 
when the computer cover or side panel has been removed. There are three levels of protection, as 
described in the following table.

Setting the Smart Cover Sensor Protection Level
To set the Smart Cover Sensor protection level, complete the following steps:

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart the 
Computer.

2. When the F10 Setup message appears in the lower-right corner of the screen, press the F10 
key. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key while the message is displayed, you must restart the computer to 
access the utility.

3. Select Security, then Smart Cover, and follow the instructions on the screen.

4. Before exiting, click File > Save Changes and Exit.

Smart Cover Sensor Protection Levels
Level Setting Description

Level 0 Smart Cover = Disabled Smart Cover Sensor is 
disabled (default).

Level 1 Smart Cover = Notify User When the computer is 
restarted, the screen displays 
a message indicating that the 
computer cover or side panel 
has been removed.

Level 2 Setup Password = enabled
and
Smart Cover = notify user

When the computer is 
restarted, the screen displays 
a message indicating that the 
computer cover or side panel 
has been removed. You must 
enter the setup password to 
continue.
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3.4.6 Smart Cover Lock
The Smart Cover Lock is available as an option on hp workstation xw4000 models. When 
installed, the Smart Cover Lock can prevent unauthorized access to the internal components.

Ä
CAUTION: For maximum cover lock security, be sure to establish a setup password. The setup password 
prevents unauthorized access to the Setup utility.

Locking the Smart Cover Lock
To activate and lock the Smart Cover Lock, complete the following steps:

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart the 
Computer.

2. When the F10 Setup message appears in the lower-right corner of the screen, press the F10 
key. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key while the message is displayed, you must restart the computer to 
access the utility.

3. Select Security, then select Smart Cover and the Locked option.

4. Before exiting, click File > Save Changes and Exit.

Unlocking the Smart Cover Lock
1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart the 

Computer.

2. When the F10 Setup message appears in the lower-right corner of the screen, press the F10 
key. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key while the message is displayed, you must restart the computer to 
access the utility.

3. Select Security > Smart Cover > Unlocked.

4. Before exiting, click File > Save Changes and Exit.
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Using the Smart Cover FailSafe Key
If you enable the Smart Cover Lock and cannot enter your password to disable the lock, you will 
need a Smart Cover FailSafe Key to open the computer cover. You will need the key in any of the 
following circumstances:

■ Power outage

■ Startup failure

■ PC component failure (such as processor or power supply)

■ Forgotten password

Ä
CAUTION: The Smart Cover FailSafe Key is a specialized tool available from HP. Be prepared; order 
this key before you need one.

To obtain the FailSafe Key, do any one of the following:

■ Contact your authorized HP reseller or service provider.

■ Refer to the HP web site (www.hp.com) for ordering information.

■ Call the appropriate number listed in the warranty.

For more information about using the Smart Cover FailSafe Key, consult the Hardware 
Reference Guide.

3.4.7 Master Boot Record Security
The Master Boot Record (MBR) contains information needed to successfully boot from a disk 
and to access the data stored on the disk. Master Boot Record Security may prevent unintentional 
or malicious changes to the MBR, such as those caused by some computer viruses or by the 
incorrect use of certain disk utilities. It also allows you to recover the “last known good” MBR, 
should changes to the MBR be detected when the system is restarted.

To enable MBR Security, complete the following steps:

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart the 
Computer.

2. When the F10 Setup message appears in the lower-right corner of the screen, press the F10 
key. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key while the message is displayed, you must restart the computer to 
access the utility.

3. Select Security > Master Boot Record Security > Enabled. 

4. Select Security > Save Master Boot Record.

5. Before exiting, click File > Save Changes and Exit.

When MBR Security is enabled, the BIOS prevents any changes being made to the MBR of the 
current bootable disk while in MS-DOS or Windows Safe Mode. 

✎ Most operating systems control access to the MBR of the current bootable disk; the BIOS cannot 
prevent changes that may occur while the operating system is running.
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Each time the computer is turned on or restarted, the BIOS compares the MBR of the current 
bootable disk to the previously saved MBR. If changes are detected and if the current bootable 
disk is the same disk from which the MBR was previously saved, the following message is 
displayed:

1999 - Master Boot Record has changed.

Press any key to enter Setup to configure MBR Security.

Upon entering Computer Setup, you must

■ Save the MBR of the current bootable disk;

■ Restore the previously saved MBR; or

■ Disable the MBR Security feature.

You must know the setup password, if one exists. If changes are detected and if the current 
bootable disk is not the same disk from which the MBR was previously saved, the following 
message is displayed:

2000 - Master Boot Record Hard Drive has changed.

 Press any key to enter Setup to configure MBR Security.

Upon entering Computer Setup, you must 

■ Save the MBR of the current bootable disk; or

■ Disable the MBR Security feature.

You must know the setup password, if one exists.

In the unlikely event that the previously saved MBR has been corrupted, the following message is 
displayed:

1998 - Master Boot Record has been lost.

Press any key to enter Setup to configure MBR Security.

Upon entering Computer Setup, you must 

■ Save the MBR of the current bootable disk; or

■ Disable the MBR Security feature.

You must know the setup password, if one exists.
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Before You Partition or Format the Current Bootable Disk
Ensure that MBR Security is disabled before you change partitioning or formatting of the current 
bootable disk. Some disk utilities, such as FDISK and FORMAT, attempt to update the MBR. If 
MBR Security is enabled when you change partitioning or formatting of the disk, you may 
receive error messages from the disk utility or a warning from MBR Security the next time the 
computer is turned on or restarted. To disable MBR Security, complete the following steps:

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart the 
Computer.

2. When the F10 Setup message appears in the lower-right corner of the screen, press the F10 
key. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key while the message is displayed, you must restart the computer to 
access the utility.

3. Select Security > Master Boot Record Security > Disabled. 

4. Before exiting, click File > Save Changes and Exit.

3.4.8 Cable Lock Provision
The rear panel of the chassis can accommodate a cable lock accessory that allows the computer 
to be physically secured to a work area. 

For illustrated instructions, please see the Hardware Reference Guide on the Documentation 
Library CD.

3.4.9 Fingerprint Identification Technology
Eliminating the need to enter user passwords, Compaq Fingerprint Identification Technology 
tightens network security, simplifies the login process, and reduces the costs associated with 
managing corporate networks. 

✎ Support for Fingerprint Identification Technology varies by model.

See www.compaq.com/products/options/fit/index.html for more information.

3.5 Fault Notification and Recovery
Fault Notification and Recovery features combine innovative hardware and software technology 
to prevent the loss of critical data and minimize unplanned downtime.

When a fault occurs, the computer displays a Local Alert message containing a description of the 
fault and any recommended actions. You can then view current system health by using the 
Management Agent. If the computer is connected to a network managed by a HP Insight 
Manager product or other management products from HP Management Solutions Partners, the 
computer also sends a fault notice to the network management application.
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3.5.1 Drive Protection System
The Drive Protection System (DPS) is a diagnostic tool built into the hard drives installed in 
select HP workstations. DPS is designed to help diagnose problems that might result in 
unwarranted hard drive replacement. 

Each installed hard drive is tested using DPS, and a permanent record of key information is 
written onto the drive. Each time DPS is run, test results are written to the hard drive. Your 
service provider can use this information to help diagnose conditions that caused you to run the 
DPS software. Refer to the Troubleshooting Guide for instructions on using DPS.

3.5.2 Ultra ATA Integrity Monitoring
Ultra ATA Integrity Monitoring monitors the integrity of data as it is transferred between an Ultra 
ATA hard drive and the system’s core logic. If the computer detects an abnormal number of 
transmission errors, the computer displays a Local Alert message with recommended actions.

3.5.3 ECC Fault Prediction and Prefailure Warranty
When the computer encounters an excessive number of error checking and correcting (ECC) 
memory errors, the computer displays a Local Alert message. This message contains detailed 
information about the errant memory module, allowing you to take action before you experience 
non-correctable memory errors. The Prefailure Warranty for ECC memory modules allows you 
to replace these modules, free of charge, before the modules actually fail. ECC memory modules 
are optional on selected HP systems.

✎ To use this feature, you must replace the standard DIMMs or RIMMs with ECC DIMMs or ECC 
RIMMs.

3.5.4 Surge-Tolerant Power Supply
An integrated surge-tolerant power supply provides greater reliability when the computer is hit 
with an unpredictable power surge. This power supply is rated to withstand a power surge of up 
to 2000 volts without incurring any system downtime or data loss.

3.5.5 Thermal Sensor
The thermal sensor is a hardware and software feature that tracks the internal temperature of the 
computer. This feature displays a warning message when the normal range is exceeded, which 
gives you time to take action before internal components are damaged or data is lost.
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4
Ultra ATA Drive Guidelines and Features

4.1 Ultra ATA Jumpers
Ultra ATA drives are configured by means of jumper settings. These systems use drives ship with 
the jumpers preset to the cable-select mode; therefore, no jumper setting changes are required on 
factory preinstalled, replacement, or option drives. With cable-select, the drive is configured as 
either Master (Drive/Device 0) or Slave (Drive/Device 1) by its physical attachment to the cable. 

If you purchase a third-party hard drive, refer to the documentation included with the drive kit to 
ensure proper cable installation and configuration.

✎ All drives on a controller channel need to have their jumpers either in the cable-select mode or 
have the individual drive jumper installed on the appropriate Master (Drive/Device 0) or Slave 
(Drive/Device 1) position.

4.2 Ultra ATA Cables
When installing a second device on either the primary or secondary controller, you must use an 
industry standard 80-conductor Ultra ATA cable for optimal performance. These cables have a 
maximum length of 18 inches and a maximum distance of 6 inches between the two devices for a 
two-drive cable.

Drives operating at speeds faster than those of the Ultra ATA-33 devices require 
industry-standard 40-pin, 80-conductor cables to maintain the higher data transfer rates possible 
with the improved technology. 

When using Ultra ATA-100, -66, and slower -33 drives in the same system, each drive will 
operate at its appropriate data transfer rate.

4.2.1 Cable Layout
The faces of industry-standard cable connectors are color coded for easy recognition:

■ System board connector = blue face

■ Device 0 connector = black face

■ Device 1 connector = gray face

✎ The color code of an industry-standard cable is valid only if the drive’s jumper is in the 
cable-select position.
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Single-Drive Cable

Two-Drive Cable

On a two-drive cable, the Drive/Device 0 connector is always the farthest one from the system 
board connector and the Drive/Device 1 connector is always the closest to the system board 
connector. 

✎ Some cables may be labeled “Drive 0” instead of “Device 0” and “Drive 1” instead of “Device 
1”.

4.3 Drive Installation Guidelines
Most computer system boards have two ATA (IDE) controller channels with a dedicated 
connector for each controller. One controller is designated as the primary and the other as the 
secondary controller. 

Each of the two controllers can have up to two devices attached to it. Each computer system may 
therefore have a maximum of four ATA/ATAPI drives. All drives are connected to these 
controllers using an industry-standard 80-conductor cable.

✎ The industry standard 1.44 MB diskette drive has its own separate channel and is not included as 
a part of the maximum four drives.

Any drive attached to a controller must have a drive designation. If only a single drive is 
connected to a controller and its jumper is in the cable-select position, it is designated as the 
Master Drive (Drive/Device 0) by its attachment to the Drive/Device 0 cable position. If two 
cable-selected drives are connected to a single controller, one will be designated by its 
attachment to the cable as the Master (Drive/Device 0) and the other as Slave (Drive/Device 1).

For optimal performance of a computer system, all drives need to be attached to the ATA 
controllers in a specified sequence. This sequence is determined by the device class of the drives 
and by specific attach sequence rules.

System 
Board

Device 0
(master)

Black 
Face

Blue 
Face

System 
Board

Device 1
(slave)

Device 0
(master)

Black 
Face

Blue 
Face

Gray 
Face
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4.3.1 Device Classes
In order to determine the best drive attach sequence, ATA/ATAPI drives are segregated into four 
different classes based upon the bandwidth demands they place on an ATA controller. The most 
demanding devices are in Class 1 and the least demanding are in Class 4.

General Attach Guidelines
■ The lower the device class number, the faster the device and the more bandwidth required. 

■ Drives installed in the Device 0 positions on both the primary and secondary controllers 
receive the greatest possible bandwidth.

■ The bootable ATA hard drive should always be installed on the primary controller in the 
Device 0 position.

4.3.2 Attach Sequence Rules by Class Priority
Drives should be attached in the sequence shown for optimum performance starting at position 
1.

*If there are three or more devices, two or more of which are hard drives, two hard drives should 
be attached to the primary controller first before following the General Attach Sequence Rule. 

Class 1 
Hard 
Drives

Class 2 
High Speed 

Optical Drives

Class 3
Optical Storage 

Drives

Class 4
Magnetic 

Storage Drives

ATA-100
ATA-66
ATA-33

DVD 
DVD-CD R/W

R/W CD-ROM  
CD-ROM 

LS-120 
Tape  
Zip 

1

2

4

3

Primary 
Controller*

4 1

Secondary 
Controller

3 2

Device 1 Device 0
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The attach sequence rule may also be stated in table format:

*If there are three or more devices, two or more of which are hard drives, two hard drives should 
be attached to the primary controller first before following the General Attach Sequence Rule. 

The rules allow for:

■ Keeping the hard drive on a separate controller channel maximizes drive performance until a 
fourth device is added.

■ Keeping the hard drives and removable media drives on separate controller channels 
maximizes compatibility.

■ Keeping the hard drive and the writable optical drive on separate controller channels 
maximizes optical drive reliability.

4.3.3 Attach Sequence Worksheet
Use the worksheet below for obtaining optimum system performance when setting up a computer 
with multiple drives. Use the General Attach Sequence Rule to determine the best drive 
installation sequence.

Two examples of how to use the worksheet are:

■ Three device installation

■ Four device installation

General Attach Sequence Rule*

Sequence Description

1 The lowest class drive - bootable hard drive recommended.

2 If only two drives, the last drive goes here; otherwise the lowest class of the 
remaining drives.

3 If only three drives, attach the final drive here. If a fourth drive exists, attach 
the lowest class drive here.

4 If there is a fourth drive, attach the final drive here - the drive with the 
highest class number of all devices. 

Attach Sequence Worksheet

Device Name
Device 
Class

Position 
Number

Controller 
Name

Device 
Number
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Example 1: Three Device Installation Sample
A system has three devices: Ultra ATA-100 hard drive, CD-ROM drive, and a DVD drive. Using 
the Device Class Table in Section 4.3.1, the devices may be identified as:

■ Ultra ATA-100 hard drive = Class 1

■ DVD drive = Class 2

■ CD-ROM drive = Class 3

Example 2: Four Device Installation Sample
A system has four devices: Ultra ATA-100 hard drive, Ultra ATA-100 hard drive, DVD-CDR/W 
drive, and a ZIP-250 drive. Using the Device Class Table in Section 4.3.1, the devices may be 
reidentified as:

■ Ultra ATA-100 hard drive = Class 1

■ Ultra ATA-100 hard drive = Class 1

■ DVD-CDR/W drive = Class 2

■ ZIP-250 drive = Class 4

Attach Sequence Worksheet - Three Device Installation (Sample)

Device Name
Device 
Class

Position 
Number

Controller 
Name

Device 
Number

Ultra ATA-100 hard drive 1 1 Primary 0

DVD drive 2 2 Secondary 0

CD-ROM drive 3 3 Secondary 1

1

2

4

3

Primary 
Controller*

4 1

Secondary 
Controller

3 2

Device 1 Device 0
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*If there are three or more devices, two or more of which are hard drives, two hard drives should 
be attached to the primary controller first before following the General Attach Sequence Rule.

4.3.4 Additional Drive Application Notes
■ When replacing a hard drive, the replacement should be of the same type (Ultra ATA -33, 

-66, or -100) as that being removed to retain the same level of performance.

■ When Ultra ATA and SCSI hard drives are mixed in the same system, the Ultra ATA drive 
will become the boot drive unless the boot order is changed in Computer Setup (F10 Setup).

4.4 SMART
The Self Monitoring Analysis and Recording Technology (SMART) ATA drives for the HP 
workstations have built-in drive failure prediction that warns the user or the network 
administrator of an impending failure or crash of the hard drive. The SMART drives track fault 
prediction and failure indication parameters such as reallocated sector count, spin retry count, 
and calibration retry count. If the drive determines that a failure is imminent, it generates a fault 
alert. 

Attach Sequence Worksheet - Four Device Installation (Sample)

Device Name
Device 
Class

Position 
Number

Controller 
Name

Device 
Number

Ultra ATA-100 hard drive 1 1 Primary 0

DVD-CDR/W drive 2 2 Secondary 0

ZIP-250 drive 4 3 Secondary 1

Ultra ATA-100 hard drive* 1 4 Primary 1

1

2

4

3

Primary 
Controller*

4 1

Secondary 
Controller

3 2

Device 1 Device 0
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4.5 Drive Capacities
The combination of the file system and the operating system used in the computer determines the 
maximum usable size of a drive partition. A drive partition is the largest segment of a drive that 
may be properly accessed by the operating system. A single hard drive may therefore be 
subdivided into a number of unique drive partitions in order to make use of all of its space. The 
table that follows identifies the capabilities and restrictions imposed on the computer by the 
combinations of file and operating systems.

Microsoft to Drive Manufacturer Size Conversion Table*
Drive Size as Identified by 

Microsoft Operating System
Drive Size as Identified by 

Drive Manufacturers

2 GB 2.1 GB

4 GB 4.3 GB

32 GB 34.4 GB

64 GB 68.7 GB

128 GB 137 GB

2 TB 2.199 TB

*Drive size calculations by drive manufacturers are bytes to the base 10 
while calculations by Microsoft are bytes to the base 2.

Drive/Partition Capacity Limits
Maximum Size

File 
System

Controller 
Type Operating System

 
Partition Drive 

FAT 16 ATA or SCSI DOS/Windows 95 2 GB 128 GB

FAT 16 ATA or SCSI Windows NT 4 GB 128 GB

FAT 32 ATA or SCSI Windows 98/SE 64 GB 128 GB

FAT 32 ATA Windows 98/SE with 
QFE* and Windows ME

128 GB 128 GB

FAT 32 SCSI Windows 98/SE with 
QFE* and Windows ME

2 TB 2 TB

FAT 32 ATA Windows 2000/ XP 32 GB 128 GB

FAT 32 SCSI Windows 2000/ XP 32 GB 2 TB

NTFS ATA Windows NT/2000/XP 128 GB 128 GB

NTFS SCSI Windows NT/2000/XP 2TB 2TB

*For Windows 98/SE with QFE see www.microsoft.com, search for Q263044 for 
details on how to expand partition size.
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SCSI Devices

5.1 SCSI Guidelines

✎ These systems support a mixed configuration of UATA/IDE and SCSI hard drives. In a mixed 
configuration the UATA/IDE drive must be specified as the boot drive. 

When installing and operating SCSI devices, you must follow these guidelines:

■ A narrow (50-pin) SCSI controller allows you to daisy-chain up to 7 additional SCSI 
devices. Counting the controller, that amounts to 8 total SCSI devices.

■ A wide (68-pin) SCSI controller allows you to daisy-chain up to 15 additional SCSI devices. 
Counting the controller, that amounts to 16 total SCSI devices.

■ If two narrow (50-pin) SCSI controllers are each connected to separate system board SCSI 
connectors, each controller may have seven SCSI devices attached. Counting the controller, 
this gives a total of 16 SCSI devices on the system. 

■ HP does not recommend mixing different width SCSI devices on the same SCSI chain or on 
the same SCSI channel. Mixing devices of different widths on the same chain or channel will 
always result in a data transfer rate of the slowest machine in that chain. The only exception 
to this is that Ultra Wide SCSI devices will cause a speed degradation when mixed with other 
68-pin devices. 

■ If multiple SCSI devices are used, split the devices between Channels A and B for optimum 
performance. Cable length for the second channel should not be longer than 18 inches.

■ If two controllers are used, each may use SCSI devices having widths and speeds different 
from the other. If a 68-pin data cable is used on a controller having 50-pin SCSI devices, use 
an internal cable adapter (Compaq number 199618-001) or an external cable adapter 
(Compaq number 270187-B21). 

Ä
CAUTION: Do not route data cables near the air intake to the power supply. Cables routed in this 
manner may block the airflow and cause the computer to overheat.

■ All SCSI controllers require a unique SCSI ID (0-7 or 8-15) for each SCSI device installed. 
The controller identifies a SCSI device by its SCSI ID number rather than its location. 
Moving a SCSI device from one position to another on the SCSI chain does not affect 
communication between the controller and the device. The reserved and available SCSI ID 
numbers for SCSI devices are:

❏ 0 is reserved for the primary hard drive.

❏ 7 is reserved for the SCSI controller.

❏ 1 through 6 and 8 through 15 are available for all other SCSI devices.
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■ 68-pin SCSI controllers require a 53 inch maximum length-twisted pair, LVD cable with 
built-in terminator, maximum of 5 drives with a minimum driving spacing of 5.25 inches.

■ Every SCSI chain or circuit must be terminated (closed) at both ends. Some system boards 
have both ends of the SCSI cable connected to, and terminated by, the system board. 
Termination can be accomplished in one of several ways:

❏ Use a cable with a built-in terminator.

❏ Use a cable with a terminating resistor plug in the last connector.

❏ Connect a SCSI device with its termination enabled into the last connector. 

❏ Connect an external SCSI device with its termination enabled to the external SCSI 
connector on the rear panel of the computer. 

■ Turn on all external SCSI devices before turning on the power to the computer. This enables 
the SCSI controller to recognize the external devices. 

5.2 Using the Multi-Mode SCSI Cable
Some products ship standard with a multi-mode SCSI cable having a terminator 1 on one end. 
This cable supports both low voltage differential (LVD) and single ended (SE) devices. One end 
of the cable connects to the internal LVD/SE connector on the system board, with the remaining 
connectors used on the hard drives.

✎ The multi-mode cable included with the computer may differ from the one pictured.

For additional information about installing optional SCSI devices, refer to the documentation 
included with the device option kit.

1
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5.3 Using SCSISelect with SCSI Devices
The Ultra160 and faster SCSI host adapters include the SCSISelect utility to configure the host 
adapter and to run the SCSI disk utilities. To run the SCSISelect utility:

■ In POST Messages Enabled mode: Press Ctrl+A when the Press<Ctrl><A> for SCSISelect 
Utility message appears during POST.

■ In POST Messages Disabled mode: When the HP/Compaq logo screen appears, press any 
key to exit the logo screen. Immediately after exiting the logo screen, press Ctrl+A to access 
the SCSISelect utility

A menu appears with the following options:

■ Configure/View Host Adapter Settings

❏ SCSI Bus Interface Definitions

◆ Host Adapter SCSI ID

◆ SCSI Parity Checking

◆ Host Adapter SCSI Termination

❏ Additional Options

◆ Boot Device Options

◆ SCSI Device Configuration

◆ Advanced Configuration Options

■ SCSI Disk Utilities

❏ Lists all SCSI devices and SCSI ID numbers

✎ For additional information about configuring POST message display status, refer to the 
Computer Setup (F10) Utility Guide.

5.4 SMART
The Self Monitoring Analysis and Reporting Technology (SMART) IDE and SCSI hard drives 
for HP workstations have built-in drive failure prediction that warns the user or the network 
administrator of an impending failure or crash of the hard drive. SMART drives track fault 
prediction and failure indication parameters such as re-allocated sector count, spin retry count, 
and calibration retry count. If the drive determines that a failure is imminent, it generates a fault 
alert.
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5.5 Jumpers
The specifications included below are the standard drive configurations. 

5.5.1 Ultra3 SCSI Hard Drive

✎ 1. Drive intended only for non-pluggable applications. Migration to a 
hot-pluggable drive tray is not supported.

2. All jumper and switch settings shown in the factory default setting, including 
those not labeled.

3. Termination is disabled/removed.

SCSI ID Settings
SCSI ID Bit 2 Bit 1 Bit 0

0

1 jumper

2 jumper

3 jumper jumper

4 jumper

5 jumper jumper

6 jumper jumper

Default Settings
Signal Description Jumper

S Start unit command 
enabled

P Parity enabled jumper

W Write protect disabled

X Switch data transfer 
enabled

jumper
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5.5.2 CD-ROM or DVD-ROM Drive

5.5.3 Zip Drive

✎ After changing the jumper settings, reboot the computer to recognize the new address.

C S M
S L A

C S M
S L A

C S M
S L A

Use CSEL Slave Master

Jumper Settings
Configuration Pair 1 Pair 2 Pair 3

Device 0 (Master) jumper

Device 1 (Slave)

Cable Select (Default) jumper
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6
SATA Devices

6.1 SATA guidelines

✎ The xw6000 system supports a mixed configuration of UATA/IDE, SCSI, and SATA hard drives. 
Review the following diagram and table to determine the correct drive configuration for your 
system.

When installing and operating SATA devices, you must follow these guidelines:

■ Connect the 4-2 pin LED cable (225537-001, included with SATA RAID controller kit) from 
the RAID card header “JP1” (4 pin header) to the system board header labeled “SCSI LED” 
(2 pin header).

■ Use the 14 inch SATA data cable with a straight connectors (326965-004) for the hard drive 
bays. 

■ Use the longest data cable with the straight connectors (326965-002) if installing a hard drive 
in an optical bay (with adaptor). 

To maintain Class B standards for radiated emissions, SATA cables on HP workstation xw6000 
systems must be routed so they do not contact the access panel. Loosely tie-wrap the SATA 
cables to the audio cable as shown in the following illustrations.

cable routing shown with a standard graphics card (left photo) and with an AGP support bracket (right photo) 
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6.2 boot order
The following flow diagram shows the boot order of hard drives (C:) connected to the different 
controllers in the workstation system. 

Using the F10 Computer Setup Utility, you can modify the boot order by arranging the Controller 
Order on the Storage tab. Although not shown, other bootable device options such as a diskette, 
CD-ROM, USB, network, and so on can be set up from the Storage tab as well.

✎ The F10 Computer Setup Utility can be accessed by pressing F10 during boot.
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6.3 hard drive configurations
The following table presents common physical hard drive configurations for the HP workstation 
xw6000. 

*Part of logical hard drive in a RAID array.

** This could be part of logical hard drives in a RAID array or stand alone physical drive.

✎ The first hard drive bay is the recommended position for the drive containing the bootable OS.  
 
For systems with bootable RAID array, the bootable logical drive can exist on multiple physical 
hard drives. SATA plug-in Controller are only recommended for RAID purposes. 

First Hard Drive Bay Second Hard Drive Bay Third Hard Drive at 
Optical Bay

IDE/SCSI empty empty

IDE/SCSI IDE empty

IDE/SCSI SCSI empty

IDE/SCSI SCSI SCSI

IDE/SCSI SCSI (plug-in Controller)

IDE/SCSI SCSI (plug-in Controller)** SCSI (plug-in Controller)**

IDE/SCSI SATA (plug-in Controller)* SATA (plug-in Controller)*

SATA (plug-in Controller)* SATA (plug-in Controller)* empty

SATA (plug-in Controller)* SATA (plug-in Controller)* SATA (plug-in Controller)*

SCSI (plug-in Controller)** SCSI (plug-in Controller)**

SCSI (plug-in Controller)** SCSI (plug-in Controller)** SCSI (plug-in Controller)**
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7
Identifying the Chassis, Routine Care, and 

Disassembly Preparation

This chapter provides general service information for the computer. Adherence to the procedures 
and precautions described in this chapter is essential for proper service.

Ä
CAUTION: When the computer is plugged into an AC power source voltage is always applied to the 
system board. You must disconnect the power cord from the power source before opening the computer 
to prevent system board or component damage. 

7.1 Chassis Type
The hp workstation xw4000 and hp workstation xw6000 series use a Convertible Minitower 
chassis. The Convertible Minitower chassis features a hard drive bay cluster that may be rotated, 
allowing the chassis to be configured either as a minitower (vertical) or a desktop (horizontal).

The chassis of the hp workstation xw4000 and the hp workstation xw6000 are very similar when 
viewed from the front. When viewed from the rear the systems are distinguished by the number 
of fans (two on the xw4000, three on the xw6000) and minor differences in I/O layout. 
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7.2 Electrostatic Discharge Information
A sudden discharge of static electricity from your finger or other conductor can destroy 
static-sensitive devices or microcircuitry. Often the spark is neither felt nor heard, but damage 
occurs. An electronic device exposed to electrostatic discharge (ESD) may not appear to be 
affected at all and can work perfectly throughout a normal cycle. The device may function 
normally for a while, but it has been degraded in the internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the 
discharge contains enough power to alter device parameters or melt silicon junctions.

7.2.1 Generating Static
The following table shows that:

■ Different activities generate different amounts of static electricity. 

■ Static electricity increases as humidity decreases. 

✎ 700 volts can degrade a product.

Relative Humidity

Event 55% 40% 10%

Walking across carpet 
Walking across vinyl floor 
Motions of bench worker 
Removing DIPs* from plastic tube

7,500 V 
3,000 V 
400 V 
400 V

15,000 V 
5,000 V 
800 V 
700 V

35,000 V 
12,000 V 
6,000 V 
2,000 V

Removing DIPs* from vinyl tray 
Removing DIPs* from Styrofoam 
Removing bubble pack from PCB 
Packing PCBs in foam-lined box

2,000 V 
3,500 V 
7,000 V 
5,000 V

4,000 V 
5,000 V 
20,000 V 
11,000 V

11,500 V 
14,500 V 
26,500 V 
21,000 V

*These are then multi-packaged inside plastic tubes, trays, or Styrofoam.
7–2 Service Reference Guide



Identifying the Chassis, Routine Care, and Disassembly Preparation
7.2.2 Preventing Electrostatic Damage to Equipment 
Many electronic components are sensitive to ESD. Circuitry design and structure determine the 
degree of sensitivity. The following packaging and grounding precautions are necessary to 
prevent damage to electric components and accessories.

■ To avoid hand contact, transport products in static-safe containers such as tubes, bags, or 
boxes.

■ Protect all electrostatic parts and assemblies with conductive or approved containers or 
packaging.

■ Keep electrostatic sensitive parts in their containers until they arrive at static-free stations.

■ Place items on a grounded surface before removing them from their container.

■ Always be properly grounded when touching a sensitive component or assembly.

■ Avoid contact with pins, leads, or circuitry.

■ Place reusable electrostatic-sensitive parts from assemblies in protective packaging or 
conductive foam.

7.2.3 Personal Grounding Methods and Equipment
Use the following equipment to prevent static electricity damage to equipment:

■ Wrist straps are flexible straps with a maximum of one-megohm ± 10% resistance in the 
ground cords. To provide proper ground, a strap must be worn snug against bare skin. The 
ground cord must be connected and fit snugly into the banana plug connector on the 
grounding mat or workstation.

■ Heel straps/Toe straps/Boot straps can be used at standing workstations and are 
compatible with most types of shoes or boots. On conductive floors or dissipative floor mats, 
use them on both feet with a maximum of one-megohm ± 10% resistance between the 
operator and ground.

Static Shielding Protection Levels
Method Voltage

Antistatic plastic 
Carbon-loaded plastic 
Metallized laminate

1,500 
7,500  
15,000
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7.2.4 Grounding the Work Area
To prevent static damage at the work area, use the following precautions:

■ Cover the work surface with approved static-dissipative material. Provide a wrist strap 
connected to the work surface and properly grounded tools and equipment.

■ Use static-dissipative mats, foot straps, or air ionizers to give added protection.

■ Handle electrostatic sensitive components, parts, and assemblies by the case or PCB 
laminate. Handle them only at static-free work areas.

■ Turn off power and input signals before inserting and removing connectors or test 
equipment.

■ Use fixtures made of static-safe materials when fixtures must directly contact dissipative 
surfaces.

■ Keep work area free of nonconductive materials such as ordinary plastic assembly aids and 
Styrofoam.

■ Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

7.2.5 Recommended Materials and Equipment
Materials and equipment that are recommended for use in preventing static electricity include:

■ Antistatic tape

■ Antistatic smocks, aprons, or sleeve protectors

■ Conductive bins and other assembly or soldering aids

■ Conductive foam

■ Conductive tabletop workstations with ground cord of one-megohm +/- 10% resistance

■ Static-dissipative table or floor mats with hard tie to ground

■ Field service kits

■ Static awareness labels

■ Wrist straps and footwear straps providing one-megohm +/- 10% resistance

■ Material handling packages

■ Conductive plastic bags

■ Conductive plastic tubes

■ Conductive tote boxes

■ Opaque shielding bags

■ Transparent metallized shielding bags

■ Transparent shielding tubes
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7.3 Routine Care

7.3.1 General Cleaning Safety Precautions
1. Never use solvents or flammable solutions to clean the computer.

2. Never immerse any parts in water or cleaning solutions; apply any liquids to a clean cloth 
and then use the cloth on the component.

3. Always unplug the computer when cleaning with liquids or damp cloths.

4. Always unplug the computer before cleaning the keyboard, mouse, or air vents.

5. Disconnect the keyboard before cleaning it.

6. Wear safety glasses equipped with side shields when cleaning the keyboard.

7.3.2 Cleaning the Computer Case
Follow all safety precautions in Section 6.2.1 before cleaning the computer.

To clean the computer case, follow the procedures described below:

■ To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

■ For stronger stains, use a mild dishwashing liquid diluted with water. Rinse well by wiping it 
with a cloth or swab dampened with clear water.

■ For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed as the alcohol will 
evaporate quickly and not leave a residue.

■ After cleaning, always wipe the unit with a clean, lint-free cloth.

■ Occasionally clean the air vents on the computer. Lint and other foreign matter can block the 
vents and limit the airflow.

7.3.3 Cleaning the Keyboard
Follow all safety precautions in Section 6.2.1 before cleaning the keyboard.

To clean the tops of the keys or the keyboard body, follow the procedures described in Section 
6.2.2.

When cleaning debris from under the keys, review all rules in Section 6.2.1 before following 
these procedures:

Ä
CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from under 
the keys. 

■ Visible debris underneath or between the keys may be removed by vacuuming or shaking.

■ Canned, pressurized air may be used to clean debris from under the keys. Caution should be 
used as too much air pressure can dislodge lubricants applied under the wide keys.
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■ If you remove a key, use a specially designed key puller to prevent damage to the keys. This 
tool is available through many electronic supply outlets.

Ä
CAUTION: Never remove a wide leveled key (like the space bar) from the keyboard. If these keys are 
improperly removed or installed, the keyboard may not function properly.

■ Cleaning under a key may be done with a swab moistened with isopropyl alcohol and 
squeezed out. Be careful not to wipe away lubricants necessary for proper key functions. Use 
tweezers to remove any fibers or dirt in confined areas. Allow the parts to air dry before 
reassembly.

7.3.4 Cleaning the Monitor
■ Wipe the monitor screen with a clean cloth moistened with water or with a towelette 

designed for cleaning monitors. Do not use sprays or aerosols directly on the screen; the 
liquid may seep into the housing and damage a component. Never use solvents or flammable 
liquids on the monitor.

■ To clean the monitor body follow the procedures in Section 6.2.2.    

7.3.5 Cleaning the Mouse
Before cleaning the mouse, ensure that the power to the computer is turned off.

■ Clean the mouse ball by first removing the retaining plate and the ball from the housing. Pull 
out any debris from the ball socket and wipe the ball with a clean, dry cloth before 
reassembly. 

■ To clean the mouse body, follow the procedures in 6.2.2.

7.4 Service Considerations
Listed below are some of the considerations that you should keep in mind during the disassembly 
and assembly of the computer.

7.4.1 Power Supply Fan
The power supply fan is a variable-speed fan based on the temperature in the power supply.

Ä
CAUTION: The cooling fan is off only when the computer is turned off or the power cable has been 
disconnected. 
 
The cooling fan is always on when the computer is either in the “On,” “Standby,” or “Suspend” modes. 
 
You must disconnect the power cord from the power source before opening the computer to prevent 
system board or component damage. 
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7.4.2 Tools and Software Requirements
To service the computer, you need the following:

■ Torx T-15 screwdriver (Compaq screwdriver with bits, PN 161946-001)

■ Torx T-15 screwdriver with small diameter shank (for certain front bezel removal)

■ Flat-bladed screwdriver (may sometimes be used in place of the Torx screwdriver)

■ Diagnostics software

■ Compaq tamper-resistant T-15 wrench (Smart Cover FailSafe Key, PN 166527-001) or 
Compaq tamper-resistant bits (Smart Cover FailSafe Key, PN 166527-002)

7.4.3 Screws
The screws used in the computer are not interchangeable. They may have standard or metric 
threads and may be of different lengths. If an incorrect screw is used during the reassembly 
process, it can damage the unit. HP strongly recommends that all screws removed during 
disassembly be kept with the part that was removed, then returned to their proper locations.

✎ Metric screws have a black finish. 
U.S. screws have a silver finish.

✎ As each subassembly is removed from the computer, it should be placed away from the work 
area to prevent damage.

7.4.4 Cables and Connectors
Most cables used throughout the unit are flat, flexible cables. These cables must be handled with 
care to avoid damage. Apply only the tension required to seat or unseat the cables during 
insertion or removal from the connector. Handle cables by the connector whenever possible. In 
all cases, avoid bending or twisting the cables, and ensure that the cables are routed in such a way 
that they cannot be caught or snagged by parts being removed or replaced.

Ä
CAUTION: When servicing this computer, ensure that cables are placed in their proper location during 
the reassembly process. Improper cable placement can damage the computer. 
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7.4.5 Hard Drives
Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. 
This applies to failed drives as well as replacement spares.

■ If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective 
packaging and label the package “Fragile: Handle With Care.”

■ Do not remove hard drives from the shipping package for storage. Keep hard drives in their 
protective packaging until they are actually mounted in the CPU.

■ Avoid dropping drives from any height onto any surface.

■ If you are inserting or removing a hard drive, turn off the computer. Do not remove a hard 
drive while the computer is on or in standby mode.

■ Before handling a drive, ensure that you are discharged of static electricity. While handling a 
drive, avoid touching the connector. For more information about preventing electrostatic 
damage, refer to Section 6.1, “Electrostatic Discharge Information.”

■ Do not use excessive force when inserting a drive.

■ Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic 
fields such as monitors or speakers.

7.4.6 Lithium Coin Cell Battery
The battery that comes with the computer provides power to the real-time clock and has a 
minimum lifetime of about three years. 

See Chapter 9, “Removal and Replacement Procedures–Small Components,” for instructions on 
the replacement procedures. 

Å
WARNING: This computer contains a lithium battery. There is a risk of fire and chemical burn if the 
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose in 
water or fire, or expose it to temperatures higher than 140ºF (60ºC).

Ä
CAUTION: Batteries, battery packs, and accumulators should not be disposed of together with the 
general household waste. 
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Security Components

This chapter describes the security components for the Convertible Minitower chassis. For an 
overview of the chassis refer to Chapter 6 “Identifying the Chassis, Routine Care, and 
Disassembly Preparation.” 

Ä
CAUTION: When the computer is plugged into an AC power source voltage is always applied to the 
system board. You must disconnect the power cord from the power source before opening the computer 
to prevent system board or component damage.

This chapter provides general service information for the computer. Adherence to the procedures 
and precautions described in this chapter is essential for proper service.

After completing all necessary removal and replacement procedures, run the Diagnostics utility 
to verify that all components operate properly.

✎ Not all features listed in this guide are available on all computers.

8.1 Preparation for Disassembly
See Chapter 6, “Identifying the Chassis, Routine Care, and Disassembly Preparation,” for initial 
procedures.

1. Remove/disengage any security devices that prohibit opening the computer.

2. Close any open software applications.

3. Exit the operating system.

4. Remove any diskette, compact disc, or MultiBay device from the computer.

5. Turn off the computer and any peripheral devices that are connected to it.

Ä
CAUTION: Turn off the computer before disconnecting any cables.

Ä
CAUTION: The cooling fan is off only when the computer is turned off or the power cable has been 
disconnected. The cooling fan is always on when the computer is in the “On,” “Standby,” or “Suspend” 
modes. You must disconnect the power cord from the power source before opening the computer to 
prevent system board or component damage.

6. Disconnect the power cord from the electrical outlet and then from the computer.

7. Disconnect all peripheral device cables from the computer.
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8.2 Security Devices

8.2.1 Smart Cover Lock
The hp workstation xw4000 supports an optional Smart Cover Lock. This software-controllable 
lock prevents unauthorized access to the internal components when the Smart Cover Lock and 
setup password are enabled.

If you enabled the Smart Cover Lock, use Computer Setup to unlock it. If you cannot enter your 
password to disable the lock, you will need a Smart Cover FailSafe Key (Compaq spare PN 
166527-001 or 166527-002) to open the computer cover. You will also need the key in any of the 
following circumstances:

■ Power outage

■ Startup failure

■ PC component (e.g., processor or power supply) failure

■ Lost password

Ä CAUTION: The cooling fan is off only when the computer is turned off or the power cable has 
been disconnected. The cooling fan is always on when the computer is in the “On,” “Standby,” 
or “Suspend” modes. You must disconnect the power cord from the power source before 
opening the computer to prevent system board or component damage.

1. Prepare the computer for disassembly.

2. Using the Smart Cover FailSafe Key, remove the two tamper-proof screws that secure the 
Smart Cover Lock to the chassis. Use the special Compaq tamper-resistant T-15 wrench (PN 
166527-001) or screwdriver bit (PN 166527-002) for this operation.

smart cover lock mounting (hp workstation xw4000 shown)

3. Remove the Smart Cover Lock.

To reattach the Smart Cover Lock, secure the lock in place with the tamper-proof screws.
8–2 Service Reference Guide



Removal and Replacement Procedures Security Components
8.2.2 Smart Cover Sensor
The Smart Cover Sensor is a software-controllable feature standard on hp workstation xw4000 
and hp workstation xw6000 systems. This sensor can be activated with the Setup utility to detect 
access panel removal and can be used as a security or maintenance aid. The sensor switch is 
located on a mounting bracket toward the front of the chassis next to the drive bay area. 

To remove the sensor switch use the following procedure:

1. Prepare the computer for disassembly.

2. Remove the access panel.

3. Disconnect the sensor switch cable 1 from the system board.

4. Push the sensor switch toward the front of the chassis 2 and then remove it downward from 
the mounting bracket 3.

Installation is the reverse of removal. 
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8.2.3 Security Lock Bracket 
The computer includes a provision for securing the access panel and/or computer with an 
optional lock. With the access panel in place a padlock may be hooked through a holed flange (as 
shown in the figure below) to deter unauthorized access to the inside of the computer. 

A cable lock may be attached (using the same method as with a padlock) to secure the unit to a 
desk and/or other equipment. 
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Drives

This chapter describes the procedures for removal and replacement of hard drives. For an 
overview of the Convertible Minitower chassis, refer to Chapter 6 “Identifying the Chassis, 
Routine Care, and Disassembly Preparation.”

Å
WARNING: Power is applied to the system board and power supply even when the power switch is 
turned off. To prevent damage to the unit, disconnect the power cord from the power source or the unit 
before beginning disassembly procedures.

9.1 Introduction
When installing additional drives, follow these guidelines:

■ For optimal performance, connect hard drives to the primary controller. Connect expansion 
devices, such as CD-ROM, IDE tape, and diskette drives to the secondary controller.

✎ Refer to Chapter 4 for more detailed information on Ultra ATA drives and to Chapter 5 for SCSI 
drives.

■ You must install guide screws to ensure that the drive lines up correctly in the drive cage. 
Extra guide screws are provided that are installed in the front of the computer chassis behind 
the front bezel. Some options require metric hardware. Factory-supplied metric screws are 
black. 

■ Drive installation requires no jumper setting changes on the existing or optional drives. All 
factory-installed drives have the jumpers preset for cable-select installation.

■ The system automatically recognizes hard drives any Plug and Play hard drive and will 
automatically reconfigure the computer. If you installed a hard drive that is not a Plug and 
Play device, you must run Computer Setup to reconfigure the computer.

✎ If installing a second device on the primary controller, you must use an 80-conductor Ultra ATA 
cable for optimal performance. This cable is available as an HP option.

Ä
CAUTION: When servicing the computer, ensure that cables are placed in their proper locations during 
the reassembly process. Improper cable placement can damage the computer.
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9.2 Removing a Drive
Use the following procedure for removing a hard drive:

1. Prepare the computer for disassembly.

✎ The computer should be placed in the horizontal (desktop) position for best stability.

2. Remove the access panel.

3. Remove the front bezel.

4. Disconnect the power, data, and audio (if applicable) cables from the back of the drive.

5. Press the drivelock mechanism to unlock the drives. Drivelock 1 (yellow) secures the 
external drives in the desktop configuration; drivelock 2 (green) secures all drives in the 
minitower configuration and the internal drives in the desktop configuration.
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6. While holding the drivelock in the unlocked position, remove the drive from the  
drive bay.

7. Remove the four guide screws from the drive.

8. Install two guide screws on each side of the replacement drive.

✎ Metric screws (M3) have a black finish; U.S. screws have a silver finish.

Replace the drive by reversing the above procedure. 

Ä
CAUTION:  Use only 3/16-inch or 5-mm long screws as guide screws. Longer screws can damage the 
internal components of the drive.

9.3 Installing a New Drive
Use the following procedure for installing a hard drive:

1. Install two guide screws on each side of the replacement drive 1.

2. Ensure that the guide screws line up with the guide slots 2, then slide the drive into the drive 
bay until it snaps into place.

3. Connect the power and signal cables to the back of the drive.

4. Remove the bezel blank from the subpanel, if necessary.

5. Reinstall the subpanel and the front bezel.

✎ Refer to the previous drawing for these steps.
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9.4 Removing a 3.5-Inch Drive From a 5.25-Inch Drive 
Adapter

A 3.5-inch drive must be installed into a 5.25-inch drive adapter in order to install the smaller 
drive into a standard 5.25-inch drive bay. 

1. Remove the bracket brace 1 from the top of the drive adapter by squeezing inward on both 
sides, then rotating the brace up and out.

2. Remove the drive bezel 2.

✎ Buttonless drives use a different front bezel but the removal procedure is the same.

3. Remove the three screws 3 that secure the drive to the left and right sides of the drive 
adapter.

4. Slide the drive 4 to the rear of the drive adapter until the diskette drive eject button is free of 
the button protector, then lift the drive out of the drive adapter. 

5. Remove the guide screws from the drive 5.

To replace the drive, reverse the previous procedures. 

✎ The primary 3.5-inch diskette drive should only be installed into bay 3 (the bottom bay in the 
minitower).  
 
When replacing the drive, use the existing screws. Metric screws (M3) have a black finish while 
U.S. screws (#6) have a silver finish.

Ä
CAUTION: Use only 3/16-inch or 5-mm long screws as guide screws. Longer screws can damage the 
internal components of the drive.
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Chassis

This chapter describes the procedures for removal and replacement of chassis subassemblies. For 
an overview of the chassis refer to Chapter 6 “Identifying the Chassis, Routine Care, and 
Disassembly Preparation.”

Ä
CAUTION: When the computer is plugged into an AC power source, voltage is always applied to the 
system board. You must disconnect the power cord from the power source before opening the computer 
to prevent system board or component damage.

10.1 Access Panel Removal

Ä CAUTION: The cooling fan is off only when the computer is turned off or the power cable has 
been disconnected. The cooling fan is always on when the computer is in the “On,” “Standby,” or 
“Suspend” modes.Access Panel Models with Thumbscrews

1. Prepare the computer for disassembly.

2. Loosen the thumbscrews that secure the access panel to the back of the computer chassis. 

✎ Not all thumbscrews used are captive. Thumbscrew design may vary by model.

3. Slide the access panel backward approximately 1-inch (2.5-cm); then lift it up and off the 
unit. 

removing CMT access panel
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10.2 Front Bezel and Related Components

10.2.1 Front Bezel Removal - Tabs
The front bezel assembly consists of a bezel base and a bezel front and is removed as a single 
assembly. The front bezel assembly is connected to the chassis using tabs.

1. Prepare the computer for disassembly.

2. Remove the computer cover.

3. Press the two release tabs 1 to disconnect the bezel from the left side of the chassis.. .

4. Swing the front bezel towards the right of the chassis and unhook it from the unit.

✎ When replacing the front bezel, ensure that the bottom hinge points are properly 
placed in the chassis before rotating the front bezel back into its original position. 

To replace the front bezel, reverse the removal procedure.
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10.2.2 Subpanel and Bezel Blanks
The subpanel and bezel blanks must be removed from the front bezel if you are installing a mass 
storage device for the first time, or if you are converting the unit from a desktop to a minitower 
configuration or from a minitower to a desktop. See Section 9.7 in this book for more 
information on changing unit configuration.

1. Prepare the computer for disassembly.

2. Lay the computer down on its large base for greater stability.

3. Remove the access panel.

4. Remove the front bezel.

5. Pull on the subpanel to remove it from the inside of the front bezel.

Ä
CAUTION: Hold the subpanel straight when you pull it away from the front bezel. Pulling at an angle 
could damage the pins that align the subpanel within the front bezel.

6. Gently push on the bezel blanks to remove them from the subpanel. 

Ä
CAUTION: When replacing the subpanel, ensure that the aligning pins and any remaining bezel 
blanks are in the proper orientation to prevent damage to the alignment pins.

✎ The subpanel has markings on it to facilitate installation.

To reassemble the front bezel assembly, reverse the disassembly procedure.
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Front Bezel USB/Audio/1394 Card
1. Prepare the computer for disassembly.

2. Lay the computer down on its large base for greater stability.

3. Remove the access panel.

4. Remove the front bezel assembly.

5. Disconnect the audio and USB cables (that are attached to the USB/Audio/1394 card) from 
the system board.

6. Disconnect the 1394 cable from the 1394 card (if present).

7. Remove the two screws that secure the card to the chassis 1.

8. Remove the card from the chassis by first sliding it away from the chassis panel until the 
audio jacks are clear from the chassis cutouts and then lifting the card out.

To replace the card, reverse the removal procedures. If necessary, replace the front bezel insert 
with the appropriate insert to allow access to the new ports.
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10.3 Power Switch
To remove the power switch use the following procedure:

1. Prepare the computer for disassembly.

2. Remove the access panel. 

3. Remove the front bezel.

4. Move/remove any components necessary to gain access to the power switch.

5. Disconnect the Power/LED cable from the system board 1.

6. Push the release tab 2 toward the drive bays, then remove the power switch assembly from 
the chassis.

Power switch removal

To install the new power switch, reverse the above procedure. Ensure that the orienting pins are 
properly aligned with the locating holes before seating the switch assembly. The switch is fully 
seated when it snaps into place. 

To install a Power/LED cable, reverse the above procedure. The Power/LED connector is keyed 
to ensure proper installation.

✎ When replacing the power switch, make sure that the power switch LED cable assembly is 
routed under the hard drive.
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10.4 Board Guide
On the hp workstation xw4000, it is necessary to remove the board guide before removing the 
speaker. On the hp workstation xw6000, it is necessary to remove the board guide in order to 
install or replace the chassis fan. To remove the board guide use the following procedure:

1. Prepare the computer for disassembly.

2. Remove the access panel. 

3. Move/remove any components necessary to gain access to the board guide.

4. Remove any full-length expansion boards.

5. On the hp workstation xw6000, disconnect the front chassis fan cable from the system board.

6. Push down on the two tabs on the side of the board guide.

7. While holding the tabs down, remove the guide from the chassis.

hp workstation xw4000 CMT shown

To install the board guide, reverse the removal procedure.
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10.5 Speaker
In hp workstation xw4000 models the speaker is mounted on the front of the chassis behind the 
board guide. In hp workstation xw6000 models the speaker is mounted on the drive bay next to 
the board guide. The speaker is held in place by screws that are removed from the inside of the 
chassis. To remove the speaker use the following procedure:

1. Prepare the computer for disassembly.

2. Remove the access panel.

3. On hp workstation xw4000 models remove the board guide as described in section 9.4. 

4. Disconnect the speaker wire 1 from the system board.

5. Remove the screws that secure the speaker to the chassis. 

6. Remove the speaker.

hp workstation xw4000 speaker mounting

hp workstation xw6000 speaker mounting

To install the speaker, reverse the removal procedure.
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10.6 Feet 
Four (4) rubber feet are mounted to the chassis, as shown below. No parts have to be removed to 
access the feet. The replacement feet have an adhesive surface and are shipped with a protective 
backing in place. Remove the backing from the feet before installation. 

If necessary, remove the old feet and remove any adhesive residue from the chassis before 
attaching the replacements.
.
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10.7 Converting a Desktop to a Minitower 
1. Prepare the computer for disassembly.

2. Lay the computer down on its large base for greater stability.

3. Remove the access panel. 

4. Remove the front bezel.

5. Remove the drives from the 5.25-inch drive bays by pressing drivelock 1 for desktop 
configuration, drivelock 2 for minitower configuration.

6. Rotate the drives 90 degrees, then reinstall them into the drive bays.

✎ The diskette drive should always be placed in bay number 3, the bay nearest the internal 3.5-inch 
drives, for proper placement within the chassis.

Ä
CAUTION: The use of unnecessary force may result in damage to the drives.

7. Reconnect the power, signal, and audio cables to the drives.

Minitower configuration Desktop configuration
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8. Remove the subpanel and rotate it 90 degrees in a clockwise direction.

Ä
CAUTION: Hold the subpanel straight when you pull it away from the front bezel. Pulling the subpanel 
away at an angle could damage the pins that align it within the front bezel.

1 = Desktop configuration;  2 = Minitower configuration 

9. Replace the subpanel, front bezel, and the computer access panel.

10. Rotate the nameplate 180 degrees so that it can be easily read when looking at it from the 
front of the computer.

11. Reassemble the computer.
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Expansion Cards and Memory

For an overview of the different chassis discussed in this chapter, refer to Chapter 6 “Identifying 
the Chassis, Routine Care, and Disassembly Preparation.”

Ä
CAUTION: .Voltage is always applied to the system board when the system is plugged into an AC 
power source. You must disconnect the power cord from the power source before opening the 
computer to prevent system board or component damage.

11.1 Memory Expansion

11.1.1 hp workstation xw4000 DDR Memory
The hp workstation xw4000 DDR system features an Intel 845E-based system board that 
includes two memory sockets that accept industry-standard double-data rate (DDR) SDRAM 
DIMMs. The two memory module slots are populated with at least one preinstalled memory 
module. To achieve the maximum memory support, you may be required to replace the 
preinstalled DIMM with a higher capacity DIMM.

For proper system operation, the DIMMs must be industry-standard 184-pin, unbuffered 
PC2100- compliant DDR DIMMs. The DIMMs must support CAS Latency 2 or 2.5 (CL = 2 or 
CL = 2.5). They must also contain the mandatory Joint Electronic Device Engineering Council 
(JEDEC) Serial Presence Detect (SPD) information. DIMMs constructed with x4 SDRAM (16 
ICs per side) are not supported; the system will not start using unsupported DIMMs.

The Intel 845E chipset supports both PC1600 and PC2100 DDR DIMMs. These systems are 
shipped with PC2100 DDR DIMMs, which provide optimal (266-MHz) performance. If both 
PC1600 and PC2100 DDR DIMMs are installed in a computer, the system memory will run at 
the lower (200-MHz) speed. 

✎ The Intel 845E chipset-based systems ship with non-ECC memory, but will support ECC 
memory. To utilize ECC functionality all installed DIMMs must be ECC types. Mixing ECC and 
non-ECC DIMMs is not supported.

Ä
CAUTION:  Memory module sockets have gold metal contacts. When upgrading the memory, it is 
important to use memory modules with gold metal contacts to prevent corrosion and/or oxidation 
resulting from having incompatible metals in contact with each other.
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11.1.2 hp workstation xw6000 Memory
The hp workstation xw6000 system features an Intel E7505 chipset-based system board that 
provides dual-channel DDR SDRAM memory support. The four memory module slots accept 
industry-standard 184-pin DDR SDRAM DIMMs and are configured with at least two 
preinstalled DDR DIMMs (one per channel). To achieve the maximum memory support, you 
may be required to replace the preinstalled DDR DIMMs with higher-capacity DDR DIMMs. 
The DDR DIMMs must support CAS Latency 2 or 2.5 (CL = 2 or CL = 2.5) and must also 
contain the mandatory Joint Electronic Device Engineering Council (JEDEC) Serial Presence 
Detect (SPD) information. DIMMs constructed with x4 SDRAM are not supported; the system 
will not start using unsupported DIMMs.

The Intel E7505 chipset supports both PC1600 and PC2100 DDR DIMMs. These systems are 
shipped with PC2100 DDR DIMMs, which provide optimal (266-MHz) performance. If a mix of 
PC1600 and PC2100 DDR DIMMs are installed in the computer, the system memory will run at 
the lower (200-MHz) speed. 

When adding, upgrading, or replacing PC2100 DDR SDRAM memory modules in the hp 
workstation xw6000, care must be taken to avoid incorrect pairing of modules in the same 
channel. This system does not support mixed DIMM pairing on the same channel.

Å
WARNING: To reduce the risk of personal injury from hot surfaces, allow the internal system 
components to cool before touching.

Å
WARNING: To reduce the risk of personal injury when replacing or removing DIMMs, allow the 
module being removed from the DIMM socket sufficient time to cool. DIMM temperatures can reach 
212° F (100° C).

Ä
CAUTION: When handling a memory module, do not touch any of the contacts. Doing so may damage 
the module.

Ä
CAUTION: Static electricity can damage the electronic components of the workstation or option boards. 
Before beginning these procedures, ensure that you are discharged of static electricity by briefly touching 
a grounded metal object.

Ä
CAUTION:  Memory module sockets have gold metal contacts. When upgrading the memory, it is 
important to use memory modules with gold metal contacts to prevent corrosion and/or oxidation 
resulting from having incompatible metals in contact with each other.

✎ The Intel E7505 chipset-based systems support ECC memory. To utilize ECC functionality all 
installed DIMMs must be ECC types. Mixing ECC and non-ECC DIMMs is not supported.

✎ The xw6000 only suports registered (buffered) DDR DIMMs.

✎ The hp workstation xw6000 can be configured with up to eight gigabytes of memory using 2-GB 
DIMMs (when available). Windows XP Server, Windows XP Advanced Server, and Red Hat 
Linux operating systems support eight gigabytes of memory. The Windows XP Professional and 
Windows 2000 operating systems support up to four gigabytes of memory. 
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■ DIMMs should be installed in pairs.

■ Do not mix DIMMs of different memory speeds. Performance will reflect the speed of the 
slowest DIMM.

■ Each DIMM within a pair should be identical in size. For example, a 256MB DIMM must be 
paired with a similar 256MB DIMM.

■ Each DIMM within a pair should be identical in technology. For example, you cannot mix a 
256 MB 9-device DIMM with a 128MB 18-device DIMM on the same channel. 

✎ To identify which DIMM technology you are using, compare the memory size and number of 
DRAM components on the module. A 128 MB DIMM has 18 DRAM components that fully 
populate both sides of the module. A 256MB DIMM has 9 DRAM components; four on one side, 
five on the other.

■ The first pair of DIMMS should be installed in slots 1 and 2. The DIMM slots are numbered 
sequentially. Slot 1 is closest to the CPUs.

■ The second pair of DIMMS, if any, should be installed in slots 3 and 4.

■ DIMMs must be installed correctly. Be sure to match the keyed slot on the DIMM with the 
tab on the DIMM socket.

■ For optimal system performance, DIMMs should be installed in identical pairs in the 
following three configurations: slot 1 and 2, slot 3 and 4, or all DIMM slots populated in 
paired format.

■ If you are using a single DIMM configuration, the DIMM should be installed in slot 1 or slot 
3.

✎ Although a single-DIMM configuration is possible, it does not provide the optimal system 
performance that a dual-DIMM (dual-channel) of matching sizes, configuration provides.

■ If you are installing two DIMMs of different sizes, they can only be installed in slot 1 and 
slot 3 with each DIMM occupying either slot.

✎ Although a mixed size dual-DIMM configuration is possible, it does not provide the optimal 
system performance that a dual-DIMM (dual-channel) of matching sizes, configuration provides.

■ No other memory configurations are supported. Attempts to install memory in other 
configurations will result in unpredictable system performance.

✎ The following table provides acceptable pairing configurations but do not cover all module 
capacities. However, the same pairing configuration applies regardless of the module type and 
capacity.
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Available Memory Configurations for the xw6000

Channel A Channel B

Module 
Total

Slot
XMM1

Slot 
XMM3

Slot 
XMM2

Slot 
XMM4

2 9-device Empty 9-device Empty

2 Empty 18-device Empty 18-device

2 18-device Empty 18-device Empty

2 Empty 9-device Empty 9-device

4 18-device 9-device 18-device 9-device

4 9-device 18-device 9-device 18-device

NOTE: Modules must be paired as indicated in this table where slots indicated by like shading 
must contain like modules.
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11.1.3 DIMM Installation        
1. If the computer has a locked Smart Cover Lock, use Computer Setup to unlock the lock and 

disable the Smart Cover Sensor.

2. Shut down the operating system properly and turn off the computer and any external devices; 
then, disconnect the power cord from the power outlet.

3. Remove the access panel and locate the memory module sockets.

Å
WARNING: To reduce risk of personal injury from hot surfaces, allow the internal system components to 
cool before touching.

4. Open both latches of the memory module socket 1, and insert the memory module into the 
socket 2. 
 
Begin by installing a module into the socket nearest the preinstalled module, and install the 
modules following the numerical order of the sockets. 
 
A memory module can be installed only one way. Match the notch on the module with the 
tab on the memory socket. Push the module down into the socket, ensuring that the module is 
fully inserted and properly seated 3.

✎ When the computer starts up, it will recognize the system memory upgrades and automatically 
reconfigure the computer. 
 
Do not exceed 1 GB of memory on a system. Exceeding that limit will cause the system to halt.
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11.2 Expansion Cards
Expansion cards in these systems are installed in slots on the system board and secured to the 
chassis with a single screw. For removing or installing an expansion card, use the following 
procedure:

1. Prepare the computer for disassembly.

2. Remove the access panel. If installing an expansion card, skip to step 8.

3. To remove an expansion card, disconnect any cables attached to the expansion card.

4. Remove the screw at the top of the expansion slot.

5. Hold the card at each end and carefully rock it back and forth until the connectors pull free 
from the socket. Be sure not to scrape the card against other components.

6. Store the card in anti-static packaging.

7. Install an expansion slot cover or new expansion card to close the open slot.

If installing an expansion card, skip to step 9. 
If not installing a new expansion card, skip to step 10.

8. Remove the expansion slot cover.

9. Slide the expansion card into the expansion socket and press it firmly into place.

✎ When installing an expansion card, make sure you press firmly on the card so that the entire 
connector seats properly in the expansion card socket.

10. Replace the screw at the top of the expansion slot.

11. Replace the access panel.

12. Connect external cables to the installed card, if needed.

13. Reconfigure the computer, if necessary.
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11.3 Graphics Sockets with Retention Mechanisms   
The AGP expansion socket may come with a retention mechanism installed around it to hold the 
graphics cards securely in place. There are two different types of retention mechanisms that may 
be installed around the AGP expansion socket.

11.3.1 AGP Card with a Type 1 Retention Mechanism

✎ The AGP type 1 retention method is not used on hp workstation xw6000 systems.

To remove an AGP card use the following procedure.

1. Prepare the computer for disassembly.

2. Remove the access panel.

3. Remove the screw at the top of the expansion slot.

4. Pull the arm on the right side of the retention mechanism.

5. Pull the card straight up to remove it from the expansion socket.

To install the graphics card, reverse the above procedures.

✎ Some models may not require a retaining screw.
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11.3.2 AGP Card with a Type 2 Retention Mechanism
To remove an remove an AGP card use the following procedure. 

1. Prepare the computer for disassembly.

2. Remove the access panel.

3. Remove the screw at the top of the expansion slot.

4. Pull the arm on the right side of the retention mechanism.

5. Pull the card straight up to remove it from the expansion socket.

To install the graphics card, reverse the above procedures.

✎ Some models may not require a retaining screw.
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11.3.3 AGP Card with Type 1 or Type 2 Retention Mechanism

To remove an AGP card using these types of mechansims use the following procedure.

1. Prepare the computer for disassembly.

2. Remove the access panel.

3. Remove the screw at the top of the expansion slot.

4. Remove the AGP graphics card as you would any PCI expansion card.

To install the graphics card, reverse the above procedures.

✎ Some models may not require a retaining screw.
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Removal and Replacement Procedures 
System Board with Major Components

For an overview of the chassis discussed in this chapter, refer to Chapter 6 “Identifying the 
Chassis, Routine Care, and Disassembly Preparation.” 

Ä
CAUTION: When the computer is plugged into an AC power source, voltage is always applied to the 
system board. You must disconnect the power cord from the power source before opening the computer 
to prevent system board or component damage.

12.1 Identifying the System Board
The xw6000 workstation contains one of two types of system boards and processor heatsinks 
(fansinks). Use this section to identify which type you have.

12.1.1 Configuration 1
This board is identified by the presence of a cooling tower over the primary processor and a 
secondary VRM socket. The system board part number is 263661-xxx.

cooling tower

secondary VRM socket
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12.1.2 Configuration 2
This board is identified by the presence of a fansink over the primary processor. The system 
board part number is 339100-xxx.

12.2 Heatsink/Processor
The processor(s) in these systems may be upgraded by replacing it with a faster component. The 
hp workstation xw6000 systems may also be upgraded by adding a second processor to the 
system board. 

12.2.1 Preparing the System for Processor Removal
Removal of a processor requires first separating the heatsink from the processor, which are 
bonded together with a compound. To break the compound bond between the heatsink and the 
processor the heatsink processor assembly must be cooled or heated to the optimum temperature 
as described in the following subsections:

■ Heatsink Cool-Down Time

■ Heatsink Warm-up Time

Å
WARNING: To reduce the risk of personal injury from hot surfaces, allow the internal system 
components to cool before touching them.

Ä
CAUTION: Installing the processor incorrectly may cause damage to the processor and/or system 
board. Processor removal and replacement should be performed by qualified personnel. Read all 
instructions carefully before beginning the procedure. 

Ä
CAUTION: Electrostatic discharge (ESD) can damage electronic components. Before beginning these 
procedures discharge your body by touching a ground metal object. Use of a grounding strap is 
recommended when handling system boards and/or electronic components. Review static discharge 
information and procedures in chapter 6. 

fansink
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Heatsink Cool-Down Time
The heat generated from the processor core transfers to the heatsink, making the assembly too 
hot to handle. After transitioning from a power-on state to a power-off state (assuming the system 
has been on for a while), the heatsink takes about 13 minutes to cool sufficiently so that it can be 
handled comfortably while the bonding compound is still pliable enough to break. 

Heatsink Warm-Up Time
A shut-down (cold) system requires minimal warm-up time to bring the heatsink-processor 
assembly to the temperature necessary to make the bonding compound pliable enough to safely 
break. 

Ä
CAUTION: Lifting the heatsink straight up while it is cold can result in pulling the processor out of the 
processor socket, resulting in possible damage to the processor and/or socket. If no socket damage has 
occurred, remember to open the socket by raising the retention lever before installing the new processor.

To warm up the heatsink/processor assembly:

1. Turn on the workstation and allow the operating system to boot and the “desktop” to appear. 

✎ The system requires approximately four to eight minutes of running time for the primary 
heatsink/processor assembly to reach the temperature required for loosening the bond between 
the heatsink and processor. A secondary heatsink/processor assembly (if present) requires about 
12 minutes of running time to reach the necessary temperature for separation.

2. Shut down the operating system normally, allowing the software to turn off the system 
hardware. If necessary, turn off the system manually.
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12.2.2 Removing the Heatsink/Processor Assembly
Once the system has been prepared (section 11.1.1) for processor removal, the heatsink may be 
separated from the processor using the following procedure:

1. Prepare the computer for disassembly.

2. Remove the access panel, and, if necessary, rotate the computer to ensure that the system 
board is parallel to the work table (desktop position).

3. On hp workstation xw4000 systems use the following procedure (for hp workstation xw6000 
systems go to step 4):

a. Disconnect the heatsink fan power cable 1 from the system board connector (see the 
figure below). 

b. Ensure that the heatsink is warm to the touch. Release the two clips 2 retaining the 
heatsink/fan assembly to the processor socket and twist the heatsink/fan assembly off the 
processor. 

Ä
CAUTION: Always twist when trying to remove a heatsink. If the bond between the heatsink and the 
processor does not break with moderate twisting pressure then repeat the warm-up procedure described 
previously. Never pull the heatsink straight out or damage may occur to the processor, socket, or both.

c. Raise the processor locking lever 3 up to the upright position. 

d. Remove the processor by grasping it by the edges and pulling it straight up and out of the 
socket. 

hp workstation xw4000 heatsink and processor components
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4. On hp workstation xw6000 systems use the following procedure:

a. Remove the air baffle by lifting it straight up and out.

hp workstation xw6000 (Configuration 1) air baffle removal

✎ The xw6000 Configuration 2 does not have an air baffle to remove.

b. On the Configuration 2 system, disconnect the fansink from the system board.

c. Loosen the four captive screws 1 securing the heatsink to the chassis. 

d. Remove the heatsink 2 by first twisting then lifting it off the processor.

Ä
CAUTION: The captive screws allow minimal but adequate lateral movement of the heatsink. If the bond 
between the heatsink and the processor does not break with moderate twisting pressure then repeat the 
warm-up procedure described previously. Never pull the heatsink straight out or damage may occur to 
the processor, socket, or both. 

e. Raise the handle 3 on the ZIF socket about 135o . 

f. Remove the processor by grasping it by the edges and pulling it straight up and out of the 
socket.

hp workstation xw6000 (Configuration 1) heatsink and processor components

To install a heatsink and processor refer to section 11.1.3. 
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12.2.3 Installing the Heatsink/Processor Assembly
1. Raise the socket locking lever into the vertical (fully open) position.

2. Place the processor into the processor socket.

3. While holding the processor in place with a finger, lower the locking lever into the down 
(horizontal) position. Install the processor and latch it securely in the socket. Ensure that the 
processor is flush to the top of the socket (fully seated). See section 11.1.2 in this chapter.

Ä
CAUTION: Multiprocessor-capable systems require that the primary processor socket be occupied in 
order for the system to operate. The primary processor should be installed before installing a secondary 
processor.

4. On hp workstation xw6000, Configuration 1 systems, a secondary VRM must be installed 
before installing the secondary processor. See the following illustration.

5. Use an alcohol pad or a clean dry wipe to clean the top of the replacement processor. If 
reusing the heatsink, clean any residue from the bottom of the heatsink. Allow the alcohol to 
dry before continuing.

Ä
CAUTION: The processor should be installed on the system board prior to cleaning to prevent 
damaging its pins. 

6. Apply the thermal grease evenly onto the top of the processor or remove the thermal grease 
protective liner from the bottom of the heatsink.

Ä
CAUTION: Not using thermal interface material could result in the system overheating and could cause 
a computer failure. 

7. Install the heatsink, ensuring that it is properly seated before securing it in place with the 
clips or screws.

8. On hp workstation xw4000 and xw6000 (Configuration 2) systems connect the heatsink fan 
cable to the system board. On hp workstation xw6000 (Configuration 1) systems, install the 
air baffle.

9. Replace the access panel. 

10. Connect the power cord and power up the computer.
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12.2.4 Multiprocessor Information
The hp workstation xw6000 systems have multiprocessor capability. When installing a second 
processor, remember that the secondary processor must be the same speed, cache size, and type 
as the primary processor.

Ä
CAUTION: A primary processor must be installed in the primary processor socket before installing a 
second processor or the workstation will not function. The primary processor socket is the upper most 
socket on the system board (when in the vertical or tower configuration).

Ä
CAUTION: The Voltage Regulator Module (VRM) circuitry for the primary processor is integrated onto 
the hp workstation xw6000 system board. When installing a secondary processor a VRM board 
(HP-approved) must also be installed. Using a VRM board that is incompatible with the primary VRM 
board may severely or permanently damage the system board.

✎ Units that ship with only one processor will have two screws installed in two of the four heatsink 
mounting holes of the secondary processor. These screws must be removed before installing the 
secondary processor and heatsink. 

Hardware Abstraction Layer    
To update Windows NT 4.0 or Windows 2000 to recognize a second processor using the 
Hardware Abstraction Layer (HAL), complete the following steps:

1. Start Windows.

2. Insert the upgrade diskette. Then select Start > Run.

3. Type 

A:\setup.exe 

and select OK.

4. Select Uniprocessor HAL and Kernel.

5. Select Upgrade and insert the media used to upgrade the operating system to a new Service 
Pack if requested; then click Retry.

6. If prompted, insert the operating system CD and click OK.

7. After the installation is complete, close the setup program and restart the computer.

✎ A manual upgrade is necessary when installing a second processor after the system has gone 
through the software bundling process. If a second processor is installed prior to unbundling, a 
manual upgrade is not necessary. 
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12.3 System Board 
1. Prepare the computer for disassembly.

2. Remove the access panel.

3. On the hp workstation xw6000 system, remove the air baffle and processor heatsink) as 
described in section 11.1.2

✎ The processor does not need to be removed in order to remove the system board. However, if the 
processor is to be removed from the system board refer to Section 11.1.1 in this chapter for 
complete instructions.

4. Remove all expansion boards.

5. Remove all graphics cards.

6. Disconnect all cables connected to the system board, noting their location for reinstallation.

7. Remove the screws connecting the system board to the chassis (see figures on next page for 
screw positions).

✎ On hp workstation xw6000 units, the processor heatsink(s) must be removed prior to removing 
the system board. Refer to Section 11.1.2 in this chapter for heatsink removal.

8. After checking the position of all cables and wires, carefully lift the system board straight up 
and out of the computer. 

Ä
CAUTION: The hp workstation xw4000 system board actually consists of two boards: the main system 
board and a PCI slot expansion board. These boards are removed as one assembly. Insure that the all 
mounting screws for both boards are removed before removing the assembly or damage may result. 

Install the system board using the reverse of the removal procedure.
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hp workstation xw4000 system board mounting screw locations

hp workstation xw6000 system board mounting screw locations
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12.4 Battery
The battery that comes with your computer provides power to the real-time clock and has a 
minimum lifetime of about three years. When replacing the battery, use a battery equivalent to 
the battery originally installed on the computer. The computer comes with a 3-volt lithium coin 
cell battery.

✎ The lifetime of the lithium battery can be extended by plugging the computer into a live AC wall 
socket. The lithium battery is only used when the computer is NOT connected to AC power.

Å
WARNING: This computer contains an internal lithium manganese dioxide battery. There is a risk of fire and 
burns if the battery is not handled properly. To reduce the risk of personal injury:
■ Do not attempt to recharge the battery.
■ Do not expose to temperatures higher than 140°F (60°C) 
■ Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or 

water.
■ Replace the battery only with the HP spare designated for this product.

Ä
CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings. When 
the battery is removed or replaced, the CMOS settings will be cleared. Refer to the Troubleshooting 
Guide for information on backing up the CMOS settings.

N
Batteries, battery packs, and accumulators should not be disposed of together with the general 
household waste. In order to forward them to recycling or proper disposal, please use the public 
collection system or return them to HP, their authorized partners, or their agents.

Ä
CAUTION: Static electricity can damage the electronic components of the computer or optional 
equipment. Before beginning these procedures, ensure that you are discharged of static electricity by 
briefly touching a grounded metal object.

1.  Prepare the computer for disassembly.

✎ It may be necessary to remove an expansion card to gain access to the battery.

2. Locate the battery and battery holder on the system board.

3. Depending on the type of battery holder on your system board, complete the following 
instructions to replace the battery.
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12.4.1 Type 1 Battery Holder
1. Lift the battery out of its holder.

2. Slide the replacement battery into position, positive side up.

3. The battery holder automatically secures the battery in the proper position.

4. Replace the computer cover or access panel.

5. Plug in the computer and turn on power to the computer.

6. Reset the date and time, your passwords, and any special system setups, using the Setup 
utility. Refer to the Computer Setup (F10) Utility Guide.

12.4.2 Type 2 Battery Holder
1. To release the battery from its holder, squeeze the metal clamp that extends above one edge 

of the battery.

2. When the battery pops up, lift it out.
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3. To insert the new battery, slide one edge of the replacement battery under the holder’s lip 
with the positive side up. Push the other edge down until the clamp snaps over the other edge 
of the battery.

✎ After the battery has been replaced, use the following steps to complete this procedure.

4. Replace the computer cover or access panel.

5. Plug in the computer and turn on power to the computer.

6. Reset the date and time, your passwords, and any special system setups, using the Setup 
utility. Refer to the Computer Setup (F10) Utility Guide.
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Power and Cooling

For an overview of the chassis refer to Chapter 6 “Identifying the Chassis, Routine Care, and 
Disassembly Preparation.” 

Ä
CAUTION: When the computer is plugged into an AC power source, voltage is always applied to the 
system board. You must disconnect the power cord from the power source before opening the computer 
to prevent system board or component damage. 

13.1 Power Supply
The power supply is accessed from the rear of the chassis using the following procedure: 

1. Power down the computer.

2. Disconnect the power cord from the AC outlet and from the system unit.

✎ The rest of this procedure is more easily performed with the system unit in the desktop 
(horizontal) position. 

3. Remove the access panel.

4. Disconnect all power cables from the mass storage devices and from the system board.

5. Remove the screws that connect the bracket to the chassis 1.

6. Remove the screws that connect the power supply to the chassis 2.

7. Slide the power supply toward the front of the computer until it clears the notches in the              
base pan, then lift it out of the computer.
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13.2 Air Baffle
The hp workstation xw6000 (Configuration 1) uses a single air baffle that controls airflow for the 
two chassis-mounted CPU fans. The hp workstation xw6000 (configuration 2) and xw4000 do 
not use an air baffle. To remove the air baffle on the hp workstation xw6000 (Configuration 1):

1. Prepare the computer for disassembly.

2. Remove the access panel.

✎ Although it is not required, the rest of this procedure is more easily performed with the system 
unit in the desktop (horizontal) position. 

3. The air baffle is removed by lifting it straight up from the fans and processor heat sinks. 

hp workstation xw6000 (Configuration 1 only) air baffle removal

To install the air baffle reverse the removal procedure.

Ä
CAUTION: Always ensure that the air baffle is correctly installed before operating the computer. Failure 
to do so may cause the computer to overheat and could result in loss of data or damage to the computer.
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13.3 Chassis Fans
In addition to the power supply fan, the hp workstation xw4000 series uses a single rear 
chassis-mounted fan while the hp workstation xw6000 series uses one front chassis fan and two 
rear chassis-mounted CPU fans. The locations of fan power cable connectors differ between the 
xw4000 and the xw6000 systems. 

13.3.1 Rear Chassis-Mounted Fan
To remove a rear chassis-mounted fan use the following procedure:

1. Power down the computer and disconnect the power cord from the AC outlet.

2. Remove the access panel.

✎ The rest of this procedure is more easily performed with the system unit in the desktop 
(horizontal) position. 

3. On hp workstation xw6000 systems remove the air baffle as described in section 12.2. 

4. Disconnect the fan power cable(s) from the system board 1.

5. Remove the screws that secure the fan to the chassis 2.

6. Lift the fan out of the chassis 3.

hp workstation xw6000 system shown

To replace the fan(s), reverse the above procedure. 

Ä
CAUTION: The correct air flow of the computer is front to back. Ensure that the rear fans blow air out or 
proper cooling will not occur, resulting in overheating and possible data loss and/or damage.
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13.3.2 Front Chassis Fan
To remove the front chassis fan of the hp workstation xw6000 system use the following 
procedure:

1. Prepare the computer for disassembly.

2. Remove the access panel.

3. Remove expansion boards if necessary.

4. Disconnect the fan power cable from the system board.

5. Remove the board guide 1 by pressing two tabs to release the guide from the chassis.

6. The fan 2 is removed from the board guide by prying the holding tabs back slightly and 
pulling the fan away from the board guide.

To install the fan proceed as follows: 

1. Place the fan in position with the fan power cable next to the inside wall of the board guide 
and snap into place.

2. Install the board guide as described in Chapter 9, section 9.4. 

3. Connect the fan power cable to the system board.

4. Replace expansion boards if necessary.

5. Replace access panel.

6. Connect and power up the computer.

7. Check for proper air flow. If air flow is not correct, fan will need to be repositioned.

Ä
CAUTION: The correct air flow of the computer is front to back. Ensure that the front fan pulls air in or 
proper cooling will not occur, resulting in overheating and possible data loss and/or damage. 
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Connector Pin Assignments

This appendix contains the pin assignments for many computer and workstation connectors. 
Some of these connectors may not be used on the product being serviced.

Enhanced Keyboard
Connector and Icon Pin Signal

1 
2 
3

Data 
Unused 
Ground

4 
5 
6

+5 VDC 
Clock 
Unused

Mouse
Connector and Icon Pin Signal

1 
2 
3

Data 
Unused 
Ground

4 
5 
6

+5 VDC 
Clock 
Unused

Ethernet BNC
Connector and Icon Pin Signal

1 (Center) Data

2 (Shield) Ground
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Ethernet RJ-45
Connector and Icon Pin Signal

1 
2 
3 
4

(+) Transmit Data 
(-) Transmit Data 
(+) Receive Data 
Unused

5 
6 
7 
8

Unused 
(-) Receive Data 
Unused 
Unused

Ethernet AUI

Connector and Icon

Pin Signal Pin Signal

1 
2 
3 
4

Ground 
Negative AUI Differential Collision 
Positive AUI Differential Collision 
Negative AUI Differential Transmit

9 
10 
11 
12

Positive AUI Differential Receive 
+12V 
Ground 
Ground

5 
6 
7 
8

Positive AUI Differential Transmit 
Ground 
Ground 
Negative AUI Differential Receive

13 
14 
15 
16

Unused 
Unused 
Unused 
Unused
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Connector Pin Assignments
Parallel Interface
Connector and Icon

Pin Signal Pin Signal Pin Signal

1 
2 
3

Strobe 
Data Bit 0 
Data Bit 1

7 
8 
9

Data Bit 5 
Data Bit 6 
Data Bit 7

13 
14 
15

Select 
Auto Linefeed 
Error

4 
5 
6

Data Bit 2 
Data Bit 3 
Data Bit 4

10 
11 
12

Acknowledge 
Busy 
Paper End

16 
17 
18-25

Initialize Printer 
Select IN 
Signal Ground

Serial Interface
Connector and Icon Pin Signal

1 
2 
3

Carrier Detect 
Receive Data 
Transmit Data

4 
5 
6

Data Terminal Ready 
Signal Ground 
Data Set Ready

7 
8 
9

Request to Send 
Clear to Send 
Ring Indicator

USB
Connector and Icon Pin Signal

1 
2 
3 
4

VCC 
- Data 
+ Data 
Ground

Microphone
Connector and Icon (1/8” miniphone) Pin Signal

1 (Tip) Audio

2 (Ring) Power

3 (Shield) Ground

1 2 31 2 3
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Connector Pin Assignments
Headphone
Connector and Icon (1/8” miniphone) Pin Signal

1 (Tip) Audio_Left

2 (Ring) Audio_Right

3 (Shield) Ground

Line-In Audio
Connector and Icon (1/8” miniphone) Pin Signal

1 (Tip) Audio_In_Left

2 (Ring) Audio_In_Right

3 (Shield) Ground

Line-Out Audio
Connector and Icon (1/8” miniphone) Pin Signal

1 (Tip) Audio_Out_Left

2 (Ring) Audio_Out_Right

3 (Shield) Ground

SCSI Low Voltage Differential/Single Ended (LVD/SE)
Connector and Icon

Pin Signal Pin Signal Pin Signal Pin Signal

1-16 
17-18 
19

Ground 
TERMPWR 
Reserved

40 
41 
42

-D0 
-D1 
-D1

49-50 
51-52 
53

Ground 
TERMPW 
Reserved

60 
61 
62

-MSG 
-SEL 
-C/D

20-34 
35 
36

Ground 
-D12 
-D13

43 
44 
45

-D3 
-D4 
-D5

54 
55 
56

Ground 
-ATN 
Ground

63 
64 
65

-REQ 
-I/O 
-D

37 
38 
39

-D14 
-D15 
-DP1

46 
47 
48

-D6 
-D7 
-DP0

57 
58 
59

-BSY 
-ACK 
-RST

66 
67 
68

-D 
-D 
-D

1 2 3

1 2 3

1 2 3
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Connector Pin Assignments
SATA
Connector

Pin Signal Pin Usage Pin Usage

data 
cable

power 
cable

power 
cable

S-1 Ground P-1 3.3 V power P-8 5 V power

S-2* A+ P-2 3.3 V power P-9 5 V power

S-3* A- P-3 3.3 V power P-10 Ground

S-4 Ground P-4 Ground P-11 Reserved

S-5** B- P-5 Ground P-12 Ground

S-6** B+ P-6 Ground P-13 12 V power

S-7 Ground P-7 5 V power P-14 12 V power

* S2 and S3 differential signal pair
**S5 and S6 differential signal pair

P-15 12 V power

Ultra SCSI
Connector and Icon

Pin Signal Pin Signal Pin Signal Pin Signal

1-11 
12 
13 
14

Ground 
Reserved 
Open 
Reserved

29 
30 
31 
32

DB3 
DB4 
DB5 
DB6

37 
38 
39 
40

Reserved 
TERMPWR 
Reserved 
Ground

45 
46 
47 
48

RST # 
MSG # 
SEL # 
C/D

15-25 
26 
27 
28

Ground 
DB0 
DB1 
DB2

33 
34 
35 
36

DB7 
DBP 
Ground 
Ground

41 
42 
43 
44

ATN # 
Ground 
BSY # 
ACK #

49 
50

REQ # 
Input/Output
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Connector Pin Assignments
External Infrared Transceiver
Connector and Icon

Pin Signal Pin Signal Pin Signal

1 
2 
3

Transmit 
Receive 
Ground

4 
5 
6

5V 
Mode 
Not Used

7 
8 

Not Used 
Not Used

Monitor
Connector and Icon

Pin Signal Pin Signal Pin Signal

1 
2 
3

Red Analog 
Green Analog 
Blue Analog

6 
7 
8

Ground 
Ground 
Ground

11 
12 
13

Monitor ID 
DDC Serial Data 
Horizontal Sync

4 
5

Monitor ID 
Ground

9 
10

+5V DC 
Ground

14 
15

Vertical Sync 
DDC Serial Clock
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Connector Pin Assignments
ATA/ATAPI (IDE) Standard Drive Cable
Connector

Pin Signal Pin Signal Pin Signal

1 
2 
3 
4 
5

Reset 
Ground 
DD7 
DD8 
DD6

15 
16 
17 
18 
19

DD1 
DD14 
DD0 
DD15 
Ground

29 
30 
31 
32 
33

DMAK 
Ground 
INTRQ 
IOCS16 
DA1

6 
7 
8 
9 
10

DD9 
DD5 
DD10 
DD4 
DD11

20 
21 
22 
23 
24

(Key) 
DMARQ 
Ground 
DIOW 
Ground

34 
35 
36 
37 
38

PDIAG (cable detect) 
DA0 
DA2 
CS1FX 
CS3FX

11 
12 
13 
14

DD3 
DD12 
DD2 
DD13

25 
26 
27 
28

DIOR 
Ground 
IORDY 
CSEL

39 
40 
 

DASP 
Ground 
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Connector Pin Assignments
MultiBay CD-ROM Adapter
Connector

Pin Signal Pin Signal Pin Signal Pin Signal

1 
2 
3 
4 
5

RESDRV_ 
GROUND 
D07 
D08 
D06

18 
19 
20 
21 
22

D15 
GROUND 
(key) 
DRQ 
GROUND

35 
36 
37 
38 
39

A0 
A2 
CS1FX 
CS3FX 
DASP

52 
53 
54 
55 
56

FP05 
FP06 
FP07 
FP08 
FP09

6 
7 
8 
9 
10

D09 
D05 
D10 
D04 
D11

23 
24 
25 
26 
27

IOW 
GROUND 
IOR 
GROUND 
IOCHDRY

40 
41 
42 
43 
44

GROUND 
+5VMLOG 
-5VMOT 
GROUND 
AUDIO_L

57 
58 
59 
60 
61

FP10 
FP11 
FP12 
FP13 
FP14

11 
12 
13 
14 
15

D03 
D12 
D02 
D13 
D01

28 
29 
30 
31 
32

CABLE SELECT 
DAK 
GROUND 
IRQ 
IO16

45 
46 
47 
48 
49

A_GROUND_R 
A_GROUND_I 
audio_r 
FP01 
FP02

62 
63 
64 
65 
66

FP15 
FP16 
FP17 
FP18 
FP19

16 
17

D14 
D00

33 
34

A1 
PDIAG

50 
51

FP03 
FP04

67 
68

FP20 
FP21
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Connector Pin Assignments
Accelerated Graphics Port (AGP) 
Connector

Pin Signal A Signal B Pin Signal A Signal B

1 
2 
3 
4 
5

+12 V 
TYPEDET# 
Reserved 
USB- 
Ground

OVRCNT# 
+ 5V  
+ 5V  
USB+ 
Ground

34 
35 
36 
37 
38

Vddq  
AD22 
AD20 
Ground 
AD18

Vddq  
AD21 
AD19 
Ground 
AD17

6 
7 
8 
9 
10

INTA# 
RST# 
GNT# 
VCC3.3 
ST1

INTB# 
CLK 
REQ# 
VCC3.3 
ST0

39 
40 
41 
42 
43

AD16 
Vddq 
FRAME# 
Reserved 
Ground

C/BE2# 
Vddq 
IRDY# 
3.3VAux 
Ground

11 
12 
13 
14 
15

Reserved 
PIPE# 
Ground 
WBF# 
SBA1

ST2 
RBF# 
Ground 
Reserved 
SBA0

44 
45 
46 
47 
48

Reserved 
VCC 3.3 
TRDY# 
STOP# 
PME#

Reserved 
VCC 3.3 
DEVSEL# 
Vddq  
PERR#

16 
17 
18 
19 
20

VCC 3.3 
SBA3 
SB_STB# 
Ground 
SBA5

VCC 3.3 
SBA2 
SB_STB 
Ground 
SBA4

49 
50 
51 
52 
53

Ground 
PAR 
AD15 
Vddq 
AD13

Ground 
SERR# 
C/BE1# 
Vddq 
AD14

21 
22 
23 
24 
25

SBA7 
Reserved 
Ground 
Reserved 
VCC 3.3

SBA6 
Reserved 
Ground 
3.3 Vaux 
VCC 3.3

54 
55 
56 
57 
58

AD11 
Ground 
AD9 
C/BE0# 
Vddq 

AD12 
Ground 
AD10 
AD8 
Vddq 

26 
27 
28 
29 
30

AD30 
AD28 
VCC 3.3 
AD26 
AD24

AD31 
AD29
VCC 3.3 
AD27 
AD25

59 
60 
61 
62 
63

AD_STB0# 
AD6 
Ground 
AD4 
AD2

AD_STB0 
AD7 
Ground 
AD5
AD3

31 
32 
33

Ground 
AD_STB1# 
C/BE3#

Ground 
AD_STB1 
AD23

64 
65 
66

Vddq  
AD0 
VREFGC

Vddq 
AD1 
VREFCG
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Connector Pin Assignments
Slimline IDE CD-ROM Connector for SFF chassis using 
810 and 810e Chipsets

Connector

Pin Signal Pin Signal Pin Signal Pin Signal

1 
2 
3 
4 
5

RESDRV_  
D06 
D04 
D02 
D00

14 
15 
16 
17 
18

GROUND 
D09 
D11 
D13 
D15

27 
28 
29 
30 
31

D07 
D05 
D03 
D01 
Ground

40  
41 
42 
43 
44

D08 
D10 
D12 
D14 
(KEY)

6 
7 
8 
9 
10

DREQ 
IOR 
DAK 
A1 
CS1FX

19 
20 
21 
22 
23

Ground 
Ground 
Ground 
PDIAG 
CS3FX

32 
33 
34 
35 
36

IOW 
OCHRDY 
IRQ 
A0 
DASP

45 
46 
47 
48 
49

Ground 
CABLE SELECT 
IO16 
A2 
Ground

11 
12 
13

AUDIO_R 
+5VMOT1 
+5VMLOG1

24 
25 
26

AUDIO_L 
+5VMOT2 
+5VMLOG2

37 
38 
39

A_GND_R 
+5VMOT3 
DASP

49 
50 

A_GND_L 
+5VMOT4 

14-Pin Power (BX Chipset-Based Board
Connector

Pin Signal Pin Signal Pin Signal Pin Signal

1 
2 
3 
4

+3.3 V 
+3.3 V Sense 
RTN 
+5 V

5 
6 
7 
8

RTN 
+5 V 
RTN 
+3.3 V

9 
10 
11 
12

-12 v 
Fan OFF 
ON/STBY 
+5 V Aux

13 
14 
 

+3.3 V Sense return 
+12 V 

1

2

13

14
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Connector Pin Assignments
14-Pin Power (810, 810E, 820, and 845 Chipset-Based 
Boards)

Connector

Pin Signal Pin Signal Pin Signal Pin Signal

1 
2 
3 
4

+3.3 V 
+3.3 V Aux 
RTN 
+5 V

5 
6 
7 
8

RTN 
+5 V 
RTN 
+3.3 V

9 
10 
11 
12

-12 v 
Fan OFF 
ON/STBY 
+5 V Aux

13 
14 
 

Fan speed 
+12 V 

20-Pin Power (Deskpro EP)
Connector

Pin Signal Pin Signal Pin Signal Pin Signal

1 
2 
3 
4 
5

+3.3 V 
+3.3 V 
RTN 
+5 V 
RTN

6 
7 
8 
9 
10

+5 V 
RTN 
Fan OFF 
+5 V Aux 
+12 V

11 
12 
13 
14 
15

+3.3 V 
-12 V 
RTN 
ON/STBY 
RTN

16 
17 
18 
19 
20

RTN 
RTN 
-5 V 
+5 V 
+5 V

1

2

13

14

1

2

19

20
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Connector Pin Assignments

20-Pin Power (Deskpro EN)
Connector

Pin Signal Pin Signal Pin Signal Pin Signal

1 
2 
3 
4 
5

3 V 
3 V/RS 
RTN 
+5 V 
RTN

6 
7 
8 
9 
10

+5 V 
Aux RTN 
Fan OFF 
+5 V Aux 
+12 V

11 
12 
13 
14 
15

+3 V 
-12 V 
RTN 
ON/STBY 
RTN

16 
17 
18 
19 
20

RTN/RS 
RTN 
-5 V 
+5 V 
+5 V

24-Pin Power 
Connector

Pin Signal Pin Signal Pin Signal Pin Signal

1 
2 
3 
4 
5 
6

+3.3 V 
+3.3 V 
RTN 
+5 V 
RTN 
+5 V

7 
8 
9 
10 
11 
12

Aux RTN 
Fan OFF 
+5 V Aux 
+12 V 
3.3 V Aux 
Fan CMD

13 
14 
15 
16 
17 
18

+3.3 V 
-12 V 
RTN 
ON/STBY 
RTN 
RTN/(R/S)

19 
20 
21 
22 
23 
24

RTN 
-5 V 
+5 V 
+5 V 
3.3 V R/S 
Fan Sink

4-Pin Power (for CPU)
Connector and Icon Pin Signal

1 RTN

2 RTN

3 12.8 Vcpu

4 12.8 Vcpu

1

2

19

20

1

2

19

20

6-Pin Power (for CPU)
Connector and Icon Pin Signal Pin Signal

1 RTN 4 12.8 Vcpu

2 RTN 5 12.8 Vcpu

3 RTN 6 12.8 Vcpu

64



B
Power Cord Set Requirements

The voltage select switch feature on the computer permits it to operate from any line voltage 
between 100-120 or 220-240 volts AC. 

The power cord set received with the computer meets the requirements for use in the country 
where you purchased the equipment.

Power cord sets for use in other countries must meet the requirements of the country where you 
use the computer. For more information on power cord set requirements, contact your authorized 
HP dealer, reseller, or service provider.

General Requirements
The requirements listed below are applicable to all countries: 

1. The length of the power cord set must be at least 6.00 feet (1.8 m) and a maximum of 9.75 
feet (3.0 m).

2. All power cord sets must be approved by an acceptable accredited agency responsible for 
evaluation in the country where the power cord set will be used.

3. The power cord set must have a minimum current capacity of 10A and a nominal voltage 
rating of 125 or 250 volts AC, as required by each country’s power system.

4. The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 
Standard Sheet C13 connector, for mating with appliance inlet on the Switch Box.
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Power Cord Set Requirements
Country-Specific Requirements
Additional requirements specific to a country are shown in parentheses and explained below. 

Country
Accrediting

Agency Country
Accrediting

Agency

Australia (1) 
Austria (1) 
Belgium (1)  
Canada (2)

EANSW 
OVE 
CEBC 
CSA

Italy (1) 
Japan (3) 
Norway (1) 
Sweden (1)

IMQ 
METI 
NEMKO 
SEMKO

Denmark (1) 
Finland (1)  
France (1)  
Germany (1) 

DEMKO 
SETI 
UTE 
VDE

Switzerland (1) 
United Kingdom (1) 
United States (2) 

SEV 
BSI 
UL 

1. The flexible cord must be <HAR> Type HO5VV-F, 3-conductor, 1.0 mm2 conductor size. 
Power cord set fittings (appliance coupler and wall plug) must bear the certification mark of 
the agency responsible for evaluation in the country where it will be used.

2. The flexible cord must be Type SJT or equivalent, No. 18 AWG, 3-conductor. The wall plug 
must be a two-pole grounding type with a NEMA 5-15P (15A, 125V) or NEMA 6-15P 
(15A 250V) configuration.

3. Appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration 
number in accordance with the Japanese Dentori Law. Flexible cord must be Type VCT or 
VCTF, 3-conductor, 1.0 mm2 conductor size. Wall plug must be a two-pole grounding type 
with a Japanese Industrial Standard C8303 (7A, 125V) configuration.
B–2 Service Reference Guide



C
POST Error Messages

An error message results if the Power-On Self-Test (POST) encounters a problem. This test runs 
when the system is turned on, checking assemblies within the computer and reporting any errors 
found. 

POST Error Messages

Screen Message Beeps* Probable Cause Recommended Action

101-Option ROM Error 1L, 1S System ROM checksum. Verify the correct ROM.
Flash the ROM if needed.
If an expansion card was recently 
added, remove it and see if the 
problem remains. 
Clear CMOS.
If the message disappears, there 
may be a problem with the 
expansion card.
Replace the system board.

102-System Board 
Failure

None DMA, timers, etc. Clear CMOS.
Remove expansion boards.
Replace the system board.

103-System Board 
Failure

None DMA, timers, etc. Clear CMOS.
Remove expansion boards.
Replace the system board.

150-SafePost Active None A PCI expansion card is 
not responding.

Restart the computer. 
Disable SafePost.
If the expansion card does not 
respond, replace the card. 

162-System Options 
Not Set

2S Configuration incorrect. 
RTC (real-time clock) 
battery may need to be 
replaced. Battery life is 
approximately 3 years.

Run Computer Setup (F10 Setup).
Set the date and time under Control 
Panel or in F10 Setup depending on 
the operating system.
If the problem persists, replace the 
RTC battery.

* L = Long, S = Short
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POST Error Messages
163-Time & Date Not 
Set

2S Invalid time or date in 
configuration memory. 
RTC (real-time clock) 
battery may need to be 
replaced. Battery life is 
approximately three 
years. 
CMOS jumper may not 
be properly installed.

Set the date and time under Control 
Panel or in F10 Setup depending on 
the operating system. 
If the problem persists, replace the 
RTC battery. 
Check for proper placement of the 
CMOS jumper.

164-Memory Size Error 2S Memory configuration is 
incorrect.

Run Computer Setup (F10 Setup) or 
Windows utilities.
Make sure memory module(s) (if 
any) are installed properly.
If third party memory has been 
added, test using HP-only memory.
Verify proper memory module type.

183-Invalid Processor 
Jumper Setting

2S System board jumper 
improperly set.

Reset system board jumpers to match 
processor and bus speeds.

201-Memory Error None RAM failure. Run Computer Setup (F10 Setup) or 
Windows utilities.
Ensure memory and continuity 
modules are installed correctly.
Verify proper memory module type.
Remove and replace memory 
module(s) one at a time to isolate 
faulty module.
Replace the faulty memory 
module(s).
If error persists after replacing 
memory modules, replace the system 
board.

202-Memory Type 
Mismatch

None Memory modules do not 
match each other.

Replace memory modules with 
matched sets.

* L = Long, S = Short

POST Error Messages

Screen Message Beeps* Probable Cause Recommended Action
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POST Error Messages
207-ECC Corrected 
Single Bit Errors in 
Memory Socket(s) y,y

2S Single Bit ECC error. Verify proper memory module type.
Try another memory socket.
Replace memory module if problem 
persists.

212-Failed Processor None Processor has failed to 
initialize.

Reseat the processor in its socket.
If the processor does not respond, 
replace it.

213-Incompatible 
memory Module in 
memory Socket(s)  
X,X, X

2S A memory module in 
memory socket identified 
in the error message is 
missing critical SPD 
information, or is 
incompatible with the 
chipset.

Verify proper memory module type.
Try another memory socket.
Replace memory with a module 
conforming to the SPD standard.

214-Memory Device 
Failure. Error Code: XX 
Memory Module 
Socket(s):XX

None A specific error has 
occurred in a RDRAM 
device installed in the 
identified socket.

Verify proper memory module type.
Try another memory socket.
Replace memory module if problem 
persists.

215-RIMM 
Configuration Error

None RIMMs not properly 
installed.

Populate RIMM sockets starting with 
slot no. 1 and do not leave any 
memory sockets empty.

301-Keyboard Error None Keyboard failure. Reconnect keyboard with computer 
turned off.
Check connector for bent or missing 
pins.
Ensure that none of the keys are 
depressed.
Replace keyboard.

304-Keyboard or 
System Unit Error

None Keyboard failure. Reconnect the keyboard with 
computer turned off.
Ensure that none of the keys are 
depressed.
Replace keyboard.
Replace system board. 

401-Parallel Port 1 
Address Assignment 
Conflict

2S IRQ address conflicts 
with another device.

Reset the IRQ.

* L = Long, S = Short

POST Error Messages

Screen Message Beeps* Probable Cause Recommended Action
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POST Error Messages
402-Monochrome 
Adapter Failure

1L, 2S Monochrome display 
controller.

Replace monochrome display 
controller.

403-Parallel Port 3 
Address Assignment 
Conflict

2S IRQ address conflicts 
with another device.

Reset the IRQ.

404-Parallel Port 
Address Conflict 
Detected

2S Both external and 
internal ports are 
assigned to parallel port 
X.

Remove any parallel expansion 
cards.
Clear CMOS.
Reconfigure card resources and/or 
run Computer Setup (F10 Setup). 

410-Audio Interrupt 
Conflict

2S IRQ address conflicts 
with another device.

Reset the IRQ.

411-Network Interface 
Card Interrupt Conflict

2S IRQ address conflicts 
with another device.

Reset the IRQ.

501-Display Adapter 
Failure

1L, 2S Graphics display 
controller.

Reseat the graphics card (if 
applicable).
Clear CMOS.
Verify that the monitor is attached 
and turned on.
Replace the graphics controller.

510-Splash Screen 
image corrupted

None Splash Screen image 
has errors.

Install latest version of ROMPaq to 
restore image.

511-CPU, Rear, or Front 
Fan not detected

None Fan is not connected or 
may have 
malfunctioned.

Reseat fan cable.
Replace the fan.

512-Chassis fan not 
detected

None Fan is not connected, 
may have 
malfunctioned, or fan 
driver on system board is 
not working.

Reseat fan cable.
Replace the fan.
Replace system board.

601-Diskette Controller 
Error

None Diskette controller 
circuitry or floppy drive 
circuitry incorrect.

Run Computer Setup (F10 Setup).
Check and/or replace cables.
Clear CMOS.
Replace diskette drive. 
Replace the system board.

602-Diskette Boot 
Record Error

None Diskette in drive A not 
bootable.

Replace the diskette.

* L = Long, S = Short

POST Error Messages

Screen Message Beeps* Probable Cause Recommended Action
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POST Error Messages
605-Diskette Drive Type 
Error

2S Mismatch in drive type. Run Computer Setup (F10 Setup) or 
Windows NT, Windows 95, or 
Windows 98 utilities.
Disconnect any other diskette 
controller devices (tape drives).
Clear CMOS.

610-External Storage 
Device Failure

None External tape drive not 
connected.

Reinstall tape drive or press F1 and 
allow system to reconfigure without 
the drive.

611-Primary Floppy Port 
Address Assignment 
Conflict

2S Configuration error. Run Computer Setup (F10 Setup). 
Remove expansion cards.
Clear CMOS.

612-Secondary Floppy 
Port Address 
Assignment Conflict

2S Configuration error. Run Computer Setup (F10 Setup). 
Remove expansion cards.
Clear CMOS.

660-Display Cache is 
Detected Unreliable

None Integrated video 
controller display cache 
not working properly 
and will be disabled.

Replace system board if minimal 
video degrading is an issue.

912-Computer Cover 
Has Been Removed 
Since Last System Start 
Up

None No action required.

914-Hood Lock Coil is 
not Connected

None Hood lock mechanism is 
missing or not 
connected.

Reconnect or replace hood locking 
mechanism.
Reseat or replace hood locking 
mechanism cable.

916-Thermal Sensor 
from Processor Heatsink 
is not Connected.

None Processor heatsink cable 
not connected to system 
board.

Reseat or replace the processor 
heatsink cable going to the system 
board.

917-Expansion Riser not 
Detected

None Riser board not seated 
or not installed.

Install riser board if missing or 
remove and reseat to ensure good 
connection.

* L = Long, S = Short

POST Error Messages

Screen Message Beeps* Probable Cause Recommended Action
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1151-Serial Port 1 
Address Conflict 
Detected

2S Both external and 
internal serial ports are 
assigned to COM1.

Remove any Comm port expansion 
cards.
Clear CMOS.
Reconfigure card resources and/or 
run Computer Setup (F10 Setup). 
Run Computer Setup or Windows 
utilities.

1152-Serial Port 2 
Address Conflict 
Detected

2S Both external and 
internal serial ports are 
assigned to COM2.

Remove any Comm port expansion 
cards.
Clear CMOS.
Reconfigure card resources and/or 
run Computer Setup (F10 Setup). 
Run Computer Setup or Windows 
utilities.

1155-Serial Port 
Address Conflict 
Detected

2S Both external and 
internal serial ports are 
assigned to same IRQ.

Remove any Comm port expansion 
cards.
Clear CMOS.
Reconfigure card resources and/or 
run Computer Setup (F10 Setup).Run 
Computer Setup or Windows 
utilities.

1201-System Audio 
Address Conflict 
Detected

2S Device IRQ address 
conflicts with another 
device.

Reset the IRQ.

1202-MIDI Port Address 
Conflict Detected

2S Device IRQ address 
conflicts with another 
device.

Reset the IRQ.

1203-Game Port 
Address Conflict 
Detected

Device IRQ address 
conflicts with another 
device.

Reset the IRQ

1611- Fan failure 
detected

None Chassis fan not 
connected to the system 
board.

Reconnect the fan.
Replace the fan.
Replace the system board.

* L = Long, S = Short

POST Error Messages

Screen Message Beeps* Probable Cause Recommended Action
C–6 Service Reference Guide



POST Error Messages
1720-SMART Hard 
Drive Detects Imminent 
Failure

None Hard drive is about to 
fail. (Some hard drives 
have a firmware patch 
that will fix an erroneous 
error message.)

Determine if hard drive is giving 
correct error message. Run the Drive 
Protection System test available.
Apply firmware patch if applicable 
(see 
www.compaq.com\support\techpu
bs\customer_advisories).
Back up contents and replace hard 
drive.

1721-SMART SCSI 
Hard Drive Detects 
Imminent Failure

None Hard drive is about to 
fail. (Some hard drives 
have a firmware patch 
that will fix an erroneous 
error message.)

Determine if hard drive is giving 
correct error message. Run the Drive 
Protection System test available.
Apply firmware patch if applicable.
Back up contents and replace hard 
drive.

1771-Primary Disk Port 
Address Assignment 
Conflict

2S Internal and external 
hard drive controllers are 
both assigned to the 
primary address.

Remove any disk controller 
expansion cards.
Clear CMOS.
Reconfigure card resources and/or 
run Computer Setup (F10 Setup).

1772-Secondary Disk 
Port Address 
Assignment Conflict

2S Internal and external 
hard drive controllers are 
both assigned to the 
primary address.

Remove any disk controller 
expansion cards.
Clear CMOS.
Reconfigure card resources and/or 
run Computer Setup (F10 Setup).

1780-Disk 0 Failure None Hard drive/format error. Run Computer Setup  
(F10 Setup).
Clear CMOS.
Check cables/jumper settings.
Run hard drive diagnostics.
Disconnect additional drives.
Run the Drive Protection System test if 
available.
Replace the hard drive.

* L = Long, S = Short

POST Error Messages

Screen Message Beeps* Probable Cause Recommended Action
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1781-Disk 1 Failure None Hard drive/format error. Run Computer Setup (F10 Setup).
Clear CMOS.
Check cable seating/jumper 
settings.
Run hard drive diagnostics.
Disconnect additional drives.
Run the Drive Protection System test if 
available.
Replace the hard drive.

1782-Disk Controller 
Failure

None Hard drive circuitry 
error.

Run Computer Setup (F10 Setup).
Clear CMOS.
Check cable seating /jumper 
settings.
Run hard drive diagnostics.
Disconnect additional drives.
Run the Drive Protection System test if 
available.
Check www.compaq.com\support\ 
techpubs\customer_advisories for 
possible changes when using 
Windows NT4.0 Service Pack 4.
Replace the hard drive.
Replace the system board.

* L = Long, S = Short

POST Error Messages

Screen Message Beeps* Probable Cause Recommended Action
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1790-Disk 0 Failure None Hard drive error or 
wrong drive type.

Run Computer Setup (F10 Setup).
Clear CMOS.
Check cable seating /jumper 
settings.
Run hard drive diagnostics.
Disconnect additional drives.
Confirm that drive is supported on 
this computer (large drive ROM 
support).
Run the Drive Protection System test if 
available.
Replace the hard drive.
Replace the system board.

1791-Disk 1 Failure None Hard drive error or 
wrong drive type.

Run Computer Setup (F10 Setup).
Clear CMOS.
Check cable seating /jumper 
settings.
Run hard drive diagnostics.
Disconnect additional drives.
Confirm that drive is supported on 
this computer (large drive ROM 
support).
Run the Drive Protection System test if 
available.
Replace the hard drive.
Replace the system board.

1792-Secondary Disk 
Controller Failure

None Hard drive circuitry 
error.

Run Computer Setup (F10 Setup).
Clear CMOS.
Check cable seating /jumper 
settings.
Run hard drive diagnostics.
Disconnect additional drives.
Run the Drive Protection System test if 
available.
Replace the hard drive.

* L = Long, S = Short

POST Error Messages

Screen Message Beeps* Probable Cause Recommended Action
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1793-Secondary 
Controller or Disk 
Failure

None Hard drive circuitry 
error.

Run Computer Setup (F10 Setup).
Clear CMOS.
Check cable seating /jumper 
settings.
Run hard drive diagnostics.
Disconnect additional drives.
Run the Drive Protection System test if 
available.
Replace the hard drive.

1800-Temperature Alert None Internal temperature 
exceeds specification.

Check that computer air vents are 
not blocked and cooling fan is 
running.
Verify processor speed selection.
Replace the processor.
Replace the system board.

1801-Microcode Patch 
Error

None Processor not supported 
by ROM BIOS.

Upgrade BIOS to proper version.

Audible 1L, 3S System ROM is bad; 
system is running in 
Failsafe Boot Block 
mode.

Reflash the ROM using a ROMPaq 
diskette. Refer to the “Failsafe Boot 
Block ROM” section of the Software 
Reference Guide.

Audible 2S Power-on successful. None.

Fixed Disk Parameter 
Table or BIOS Error 
System Halted

3L Configuration or 
hardware failure.

Run Computer Setup and Diagnostic 
Utilities.

Flashing Caps Lock LED 
on Keyboard

1L, 2S Graphics controller not 
present or incorrectly 
initialized.

Clear CMOS.
If graphics card has been added, 
remove and reseat.
Reset the riser board.

Flashing Num Lock LED 
on Keyboard (Most 
models. Blue LED glows 
on Evo W8000 
Workstation.)

1S, 2L System memory not 
present.

Check memory module.
Remove and reseat memory module.
See “Memory” in Appendix F. 

* L = Long, S = Short

POST Error Messages

Screen Message Beeps* Probable Cause Recommended Action
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Flashing Scroll Lock LED 
on Keyboard (Most 
models. Orange LED 
glows on Evo W8000 
Workstation.)

2L, 1S System board hardware 
failure (prior to video).

Replace system board.

Invalid Electronic Serial 
Number

None Electronic serial number 
has become corrupted.

Run Computer Setup (F10 Setup). If 
Setup already has data in the field 
or will not allow the serial number to 
be entered, download and run 
SP5572.EXE (SNZERO.EXE).
Run F10 Setup and try to enter serial 
number under Security, System ID, 
then save changes.

Num Lock LED on 
Keyboard

None Failed Boot Block. Reflash the ROM using a ROMPaq 
diskette.

(Resume = F1 KEY) None As indicated to continue. Press F1.

XXOOOYZZ Parity 
Check 

None Parity RAM failure. Run Computer Setup and Diagnostic 
Utilities.

* L = Long, S = Short

POST Error Messages

Screen Message Beeps* Probable Cause Recommended Action
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D
Diagnostic Indicator Lights

✎ All indicator lights are not available on all products.

Keyboard Lights
LED Color LED Activity State/Message

Num Lock 
Caps Lock 
Scroll Lock

Green 
Green 
Green

Flashing  
Flashing 
Flashing

Memory error 
No video 
System board failure, prior to video

Chassis Indicator Lights—Desktop Computers and Workstations

LED Color LED Activity State/Message

Power 
Power 
Power

Green 
Green 
Green

On 
1 blink/second 
1 blink/second

Computer on 
Normal suspend mode 
Suspend to RAM

Power 
Power

None 
Red

None 
On

Computer off 
CPU not installed/fetching code

Power 
Power 
Power

Red* 
Red* 
Red*

4 blinks/second 
Computer shuts down 
2 blinks 1 second apart 
followed by 2 second 
pause then repeat pattern

CPU thermal shutdown 
CPU thermal shutdown 
CPU thermal shutdown

Power 
Power 
Power and 
hard drive

Red 
Red 
Red

1 blink/second 
1 blink/2 or more seconds 
On

ROM error 
Power supply overheated 
Riser board not seated

*Varies by model. 
**Most models. Blue LED glows on Evo Workstation W8000.
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System Board Diagnostic Lights1—Desktop Computers and Workstations
Main 
Power 
Switch 
Status

3.3 V_Aux 
LED

5 V_Aux/
PSON LED

Power Button 
LED6

OFF2 ON ON4 OFF

ON3 ON OFF5 ON

1. ON and OFF state of LEDs apply only to a good, working system board with AC 
power applied to the power supply. 
2. Power LED is OFF. 
3. Power LED is ON. (Green) 
4. 5V_Aux is ON. 
5. PSON is active = power supply turned ON. 
6. All except SFF.
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E
Diagnostic Error Codes

Diagnostic error codes occur if the system recognizes a problem while running the HP 
Diagnostics program. These error codes help identify possibly defective subassemblies. 

Diagnostic error messages consist of three components, AABB-CC, where

AA = Device Code

BB = Subtest Code

CC = Error Code

The following table lists the device codes (AABB-CC) and the subtest code (AABB-CC) 
covered by HP Diagnostics Tests. Some codes listed in this table will not apply to the computers 
described in this manual and will not be detailed in the tables that follow.

Summary of Test Error Codes

Error 
Code 

Range Device Description

Error 
Code 

Range Device Description

0100 - 0199 
0200 - 0210 
0301 - 0304 
0401 - 0498

Processor (P1) 
Memory 
Keyboard 
Parallel Port

3113 - 3199 
3206 - 3206 
3300 - 3333 

Third Processor (P3) 
Audio System 
Mediavision Spectrum 16 
Multimedia

0501 - 0516 
0600 - 0699 
0802 - 0824 
1101 - 1109

Video Display Unit 
Diskette Drive 
Monochrome Video Card 
Serial Port

3400 - 3401 
4113 - 4199 
5100 - 5130 
5234 - 5240

TV Tuner Card Fourth 
Processor 
Plasma Display System 
Advanced Color Graphics (AGC)

1201 - 1210 
1700 - 1799 
1800 - 1823 
1900 - 1906

Modem 
Hard Drive 
CD-ROM 
Tape Drive

6000 - 6089 
6500 - 6599 
6600 - 6699 
6700 - 6799

Network Card 
SCSI Hard Drives 
CD-ROM Drives 
SCSI Tape Drives

2113 - 2199 
2402 - 2480 
 
2502

Second Processor (P2) 
Enhanced Color Graphics 
(ECG/VGA) 
Pen/Digitizer

7000 
8601 
8700 - 8702

Server Manager/R Card 
Auxiliary Input Interface 
Game Port
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The remaining tables list possible error codes (AABB-CC), descriptions of each error condition, 
and recommended actions to resolve the error condition.

✎ Retest the system after completing each step. If the problem has been resolved, do not proceed 
with the remaining steps.

For assistance in the removal and replacement of a particular subassembly, see the “Removal and 
Replacement Procedures” chapter in this manual.

Microprocessor

Error Code Description Recommended Action

0101-xx CPU test failed. The following steps apply to 0101-xx through 
0102-xx:

0102-xx Coprocessor error. 1. Run Computer Checkup or Computer Setup 
and retest.

2. Replace processor and retest.
3. Replace the system board and retest.

0103-xx DMA controller failed. The following step applies to 0103-xx through 
0106-xx:

0104-xx Interrupt controller failed. Replace the system board and retest.

0105-xx Port error.

0106-xx Keyboard controller self-test 
failed.

0107-xx CMOS RAM test failed. The following steps apply to 0107-xx through 
0109-xx:

0108-xx CMOS interrupt test failed. 1. Replace the battery/clock module and 
retest.

0109-xx CMOS clock test failed. 2. Replace the system board and retest.

0110-xx Programmable timer test 
failed.

3. Replace the system board and retest.

0113-01 Protected mode test failed. Replace the system board and retest.

0114-01 Speaker test failed. Verify the speaker connection.
Replace speaker (if applicable) and retest.
Replace the system board and retest.

0199-xx Installed devices test failed. Check system configuration.
Verify cable connections.
Check switch settings.
Run Diagnostics utility.
Remove all devices except processor and 
replace one-at-a-time until a failure occurs.
Replace the system board.
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✎ Holding any key down during the boot-up sequence causes the Basic Input Output System 
(BIOS) to beep, as a warning of possible keyboard problems. Wait until after the system has 
booted, then press the Num Lock key. If the Num Lock light on the keyboard toggles on and off 
with each press of the key, the keyboard is functioning properly. 

Memory

Error Code Description Recommended Action

0200-xx Machine ID test failed. Reinsert memory modules and retest.

0202-xx System ROM checksum failed. The following steps apply to 0202-xx through 
0212-xx:

0203-xx Write/read test failed. 1. Remove one memory module at a time until 
the error message stops.

0204-xx Address test failed. 2. Replace other removed modules one at a 
time, testing each to ensure the error does 
not return.

0205-xxx Walking 1s test failed. 3. Replace defective modules.

0209-xxx RAM long test failed. 4. If error continues, replace system board 
and retest.

0211-xx Random pattern test failed.

0212-xxx Cache test failed.

0214-xx Noise test failed. The following steps apply to 0214-xx through 
0215-xx:

0215-xx Random address test failed. 1. Remove one memory module at a time until 
the error message stops.

2. Replace other removed modules one at a 
time, testing each to ensure the error does 
not return.

3. Replace the system board and retest.

Keyboard

Error Code Description Recommended Action

0300-xx ID test failed. The following steps apply 0300-xx through 
0304-xx:

0301-xx Self-test/interface test failed. 1. Check the keyboard connection. If 
disconnected, turn the computer off and 
connect the keyboard.

0302-xx Individual key test failed. 2. Replace the keyboard and retest.

0304-xx Repeat test failed. 3. Replace the system board and retest.
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Parallel Port

Error Code Description Recommended Action

0401-xx Failed or not connected. The following steps apply to 0401-xx through 
0403-xx:

0402-xx Printer port test failed. 1. Connect the printer.

0403-xx Pattern test failed. 2. Check power to the printer.

3. Install the loop-back connector and retest.

4. Replace system board and retest.

Diskette Drive

Error Code Description Recommended Action

0600-xx ID drive types test failed. The following steps apply to 0600-xx through 
0698-xx:

0601-xx Format failed. 1. Replace the diskette media and retest.

0602-xx Read test failed. 2. Reseat and/or replace the diskette power 
and signal cables and retest. 

0603-xx Write, read, compare test 
failed.

3. Replace the diskette drive and retest. 

0604-xx Random seek test failed. 4. Replace the system board and retest.

0605-xx ID media test failed.

0606-xx Speed test failed.

0609-xx Diskette reset controller failed.

0610-xx Change line test failed.

0697-xx Diskette type error.

0698-xx Diskette drive speed not within 
limits.

0699-xx Diskette drive/media error. 1. Replace the diskette media and retest.
2. Run Computer Setup and TEST.
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Serial Port

Error Code Description Recommended Action

1101-xx Serial port test failed. 1. Run Computer Setup or Windows NT, 
Windows 98/2000/ME utilities.

2. Replace the system board and retest.

Modem Communications

Error Code Description Recommended Action

1201-xx Internal test failed. The following steps apply to 1201-xx through 
1210-xx:

1203-xx External termination test failed. 1. Disconnect from the phone line and retest.

1204-xx Auto originate test failed. 2. Check the phone number.

1205-xx Auto answer test failed. 3. Check the modem line.

1210-xx Direct connect test failed. 4. Replace the modem and retest.
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Hard Drive

Error Code Description Recommended Action

1701-xx Format test failed. The following steps apply to 1701-xx through 
1736-xx:

1702-xx Read test failed. 1. Run Computer Setup and verify drive type.

1703-xx Write/read/compare test 
failed.

2. Reseat or replace the hard drive signal and 
power cables and retest. 

1704-xx Random seek test failed. 3. Clear CMOS.

1705-xx Controller test failed. 4. Run the hard drive DPS test.

1708-xx Format bad track test failed. 5. Replace the hard drive and retest.

1710-xx Park head test failed. 6. Replace the system board and retest.

1715-xx Head select test failed.

1716-xx Conditional format test failed.

1717-xx ECC* test failed.

1719-xx Power mode test failed.

1724-xx Network preparation test 
failed.

1736-xx Monitoring test failed.

*Error Correction Code

Tape Drive

Error Code Description Recommended Action

1900-xx ID test failed. The following steps apply to 1900-xx through 1910-xx

1901-xx Servo test failed. 1. Replace the tape cartridge and retest.

1902-xx Format or format 
verification test failed.

2. Reseat and/or replace the signal cable and retest.

1903-xx Sensor test failed. 3. Check the switch settings on the adapter card (if 
applicable).

1904-xx BOT/EOT test failed. 4. Replace the tape adapter card (if applicable) and 
retest.

1905-xx Read test failed. 5. Replace the tape drive and retest.

1906-xx Write/read/compare 
failed.

6. Replace the system board and retest.

1910-xx Tape erase test failed.
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Video

Error Code Description Recommended Action

501-xx Graphics controller test failed. The following steps apply to 501-xx through 
516-xx:

502-xx Video memory test failed. 1. Replace the monitor and retest.

503-xx Video attribute test failed. 2. Replace the graphics controller and retest.

504-xx Video character test failed. 3. Replace the system board and retest.

505-xx Video 80 × 25 mode 9 × 14 
character cell test failed.

506-xx Video 80 × 25 mode 8 × 8 
character cell test failed.

507-xx Video 40 × 25 mode test failed.

508-xx Video 300 × 200 mode color set 
0 test failed.

509-xx Video 320 × 200 mode color set 
1 test failed.

510-xx Video 640 × 200 mode test 
failed.

511-xx Video screen memory page test 
failed.

512-xx Video gray scale test failed.

514-xx Video white screen test failed.

516-xx Video noise pattern test failed.

2401-xx Graphics controller test failed. 1. Reseat the video card (if applicable) and 
retest.

2. Replace the video card and retest.
3. Replace the system board and retest.

2402-xx Memory test failed. The following steps apply to 2402-xx through 
2419-xx:

2403-xx Attribute test failed. 1. Reseat the video card (if applicable) and 
retest.

2404-xx Character set test failed. 2. Run the Configuration and Diagnostics 
utilities.

2405-xx 80 × 25 mode 9 × 14 character 
cell test failed.

3. Replace the monitor and retest.

2406-xx 80 × 25 mode 8 × 8 character 
cell test failed.

4. Replace the video/system board and retest.

2408-xx 320 × 200 mode color set 0 test 
failed.

2409-xx 320 × 200 mode color set 1 test 
failed.
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2410-xx 640 × 200 mode test failed.

2411-xx Screen memory page test failed.

2412-xx Gray scale test failed.

2418-xx ECG/VGC memory test failed.

2419-xx ECG/VGC ROM checksum test 
failed.

2420-xx Graphics attribute test failed. Replace the monitor and retest.

2421-xx ECG/VGC 640 × 200 graphics 
mode test failed.

1. Reseat the video card (if applicable) and 
retest.

2. Replace the video/system board and retest.

2422-xx ECG/VGC 640 × 350 16 color 
set test failed.

The following steps apply to 2422-xx through 
2456-xx:

2423-xx ECG/VGC 640 × 350 64 color 
set test failed.

1. Reseat the video card (if applicable) and 
retest.

2424-xx ECG/VGC monochrome text 
mode test failed.

2. Run the Configuration and Diagnostics 
utilities.

2425-xx ECG/VGC monochrome graphics 
mode test failed.

3. Replace the monitor and retest.

2431-xx 640 × 480 graphics test failed. 4. Replace the video/system board and retest

2432-xx 320 × 200 graphics (256 color 
mode) test failed.

2448-xx Advanced VGA Controller test 
failed.

2451-xx 132-column Advanced VGA test 
failed.

2456-xx Advanced VGA 256 Color test 
failed.

2458-xx Advanced VGA BitBLT test. The following steps apply to 2458-xx through 
2480-xx:

2468-xx Advanced VGA DAC test. 1. Reseat the video card (if applicable) and 
retest.

2477-xx Advanced VGA data path test. 2. Replace the video card and retest.

2478-xx Advanced VGA BitBLT test. 3. Replace the system board and retest.

2480-xx Advanced VGA Linedraw test.

Video

Error Code Description Recommended Action
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Audio

Error Code Description Recommended Action

3206-xx Audio System Internal Error. Replace the system board and retest.

✎ When Windows 98/2000/ME is installed, changes to ESS sound device configuration do not take 
effect until the computer is restarted (turned off and on). 

Network Interface

Error Code Description Recommended Action

6000-xx ID test failed. The following steps apply to 6000-xx through 
6089-xx:

6014-xx Configuration test failed.* 1. Run Computer Setup or Windows NT, 
Windows 95, 98, 2000, or ME utilities.

6016-xx Reset test failed.* 2. Verify test procedures.

6028-xx Internal test failed.* 3. Replace the network card, if installed.

6029-xx External test failed.* 4. Replace the system board.

6054-xx Configuration test failed.**

6056-xx Reset test failed.**

6068-xx Internal test failed.**

6069-xx External test failed.**

6089-xx Open test failed.**

* Ethernet only. 
**Token Ring only.

CD-ROM and DVD-ROM

Error Code Description Recommended Action

3301-xx CD-ROM drive read test failed. The following steps apply to 3301-xx through 
3305-xx and 6600-xx through 6623-xx:

3305-xx CD-ROM drive seek test failed. 1. Replace the CD media and retest.

6600-xx ID test failed. 2. Check the jumper settings on the adapter 
card.

6605-xx Read test failed. 3. Verify that the speakers are connected.

6608-xx Controller test failed. 4. Reseat and/or replace the power and 
signal cables and retest.

6623-xx Random read test failed. 5. Replace the CD-ROM drive and retest.
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Special Error Codes
This section includes the error codes for the following devices:

■ SCSI hard drives

■ SCSI tape drives

■ SCSI PD-CD drives

■ All CD-ROM drives

The SCSI error codes consist of three components, AABB-CC, where

AA = Device Name

BB = Test Name

CC = Error Code

For example, a diagnostic error code of 6523-05 indicates that the diagnostics program was 
testing the hard drive random-read function and received a seek failure. The device is faulty and 
must be replaced.

Pointing Device

Error Code Description Recommended Action

8601-xx Mouse test failed. The following steps apply to 8601-xx through 
8602-xx:
1. Replace with a working mouse and retest.

8602-xx Interface test failed. 2. Replace the system board and retest.

Device Names

65XX-XX 
66XX-XX 
67XX-XX

Hard Drive 
CD-ROM Drive and PD-CD Drive 
Tape Drive

Test Names

XX00-XX 
XX05-XX 
XX06-XX 
XX08-XX

ID 
Read 
SA/Media 
Controller

XX09-XX 
XX23-XX 
XX28-XX

Media erase 
Random read 
Media load/unload
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Test Error Codes 

Error Code Description Recommended Action

XXXX-02 Drive not installed. Check cable connections.

XXXX-03 Media not in drive. Check for and install data CD or write-enabled 
tape in drive.

XXXX-05 Seek failure. Replace the indicated device.

XXXX-06 Drive timed out. Replace the indicated device.

XXXX-07 Drive busy. Replace the indicated device.

XXXX-08 Drive already reserved. Replace the indicated device.

XXXX-09 Unknown.

XXXX-10 Unknown.

XXXX-11 Media soft error. Replace the indicated device.

XXXX-12 Drive not ready. Replace the indicated device.

XXXX-13 Media error. Replace the indicated device.

XXXX-14 Drive hardware error. Replace the indicated device.

XXXX-15 Illegal drive command. Replace the indicated device.

XXXX-16 Media was changed. Replace the indicated device.

XXXX-17 Tape write-protected. 1. Disable write-protect on tape cartridge.
2. Replace tape drive.

XXXX-18 No data detected. Replace the indicated device.

XXXX-21 Drive command aborted. Replace the indicated device.

65XX-24 Media hard error. 1. Back up data and perform Surface Analysis 
to reallocate defect.

2. Replace drive.

66XX-24 Media hard error. 1. Replace current data CD with different data 
CD.

2. Replace drive.

67XX-24 Media hard error. 1. Ensure correct media type for this tape 
drive.

2. Replace current tape with new tape.
3. Replace tape drive.

XXXX-25 Unknown.

XXXX-30 Controller timed out. Replace the indicated device.

XXXX-31 Unrecoverable error. Replace the indicated device.

XXXX-32 Controller/drive disconnected. Replace the indicated device.

XXXX-33 Illegal controller command. Replace the indicated device.

XXXX-34 Invalid SCSI bus phase. Replace the indicated device.
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XXXX-35 Invalid SCSI bus phase. Replace the indicated device.

XXXX-36 Invalid SCSI bus phase. Replace the indicated device.

XXXX-39 Error status from drive. Replace the indicated device.

XXXX-40 Target timed out. Replace the indicated device.

XXXX-41 SCSI bus stayed busy. Replace the indicated device.

XXXX-42 ACK/REQ lines bad. Replace the indicated device.

XXXX-43 ACK did not deassert. Replace the indicated device.

XXXX-44 Parity error. Replace the indicated device.

XXXX-50 Data pins bad. Replace the indicated device.

XXXX-51 Data line 7 bad. Replace the indicated device.

XXXX-52 MSG, C/D, and/or I/O lines 
bad.

Replace the indicated device.

XXXX-53 BSY never went busy. Replace the indicated device.

XXXX-54 BSY stayed busy. Replace the indicated device.

XXXX-60 Controller CONFIG-1 register 
bad

Replace the indicated device.

XXXX-61 Controller CONFIG-2 register 
bad

Replace the indicated device.

XXXX-65 Media not unloaded. Replace the indicated device.

XXXX-90 Fain failure. 1. Ensure fan(s) connected.
2. Replace nonfunctional fan(s).

XXXX-91 Over temperature. 1. Ensure proper air flow.
2. Perform required maintenance and 

cleaning.

XXXX-99 Autoloader reported tapes not 
loaded properly.

1. Install tape(s) in autoloader tape drive 
according to test instructions.

2. Change autoloader magazine.

Test Error Codes (Continued)

Error Code Description Recommended Action
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Troubleshooting Without Diagnostics

E-Support
For online access to technical support information and tools, go to http://www.hp.com/support. 
Support resources include Web-based troubleshooting tools, technical knowledge databases, 
driver and patch downloads, online communities, and proactive notification services.

Preliminary Checklist
This section describes some simple, preliminary tests and guidelines for troubleshooting the 
computer without using the diagnostics. 

If you encounter some minor problem with the computer or a software application, go through 
the following checklist for possible solutions before running any of the diagnostic utilities:

■ Are the computer and monitor connected to a working electrical outlet?

■ Is the computer turned on?

■ Is the green power light illuminated?

■ Is the monitor turned on?

■ Is the green monitor light illuminated?

■ Turn up the monitor brightness and contrast controls if the monitor is dim.

■ Press and hold any key. If the system beeps, then the keyboard is operating correctly.

■ Check all cables for loose or incorrect connections.

■ Reconfigure the computer after installing a non–Plug and Play expansion board or other 
option, such as a diskette drive.

■ Are all of the necessary device drivers installed?

■ Have all printer drivers been installed for each application?

■ Remove all diskettes from the diskette drives before you turn on the system.

■ Are all switches set correctly?

■ Is the NIC Remote Wakeup cable (featured on some models) connected between the NIC and 
the riser/system board?

■ Are all memory sockets filled on computers using RIMMs?

■ Ensure that memory module types are not mixed on the same system board. The system will 
not boot if RIMMs and DIMMs are mixed.
Service Reference Guide F–1
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Solving Minor Problems 

Problem Possible Solution

Computer will not turn on. 1. Ensure that the computer is properly connected to an 
external power source and the wall outlet is active.

2. A PCI or ISA card that has been installed is defective. 
Remove any expansion card that was just installed.

3. Reseat drive power, data, and power supply cables.
4. Disconnect all drive cables and reboot. Add devices 

back one at a time to isolate problem.

Computer appears locked up and 
won’t turn off when the power button is 
pressed.

Software control of the power button may not be functional. 
Press and hold the button for four seconds, then release. This 
invokes the hardware override for the power button.

Computer date and time display is 
incorrect.

First, reset the date and time under Control Panel. If the 
problem persists, the real-time clock (RTC) battery may need 
to be replaced. Refer to Section 9.1 in this guide. When 
booting from a network, the PC clock may be reset to that of 
the server. The PC clock may also change when using other 
services through the server.

Computer powered off automatically. 1. The unit temperature was exceeded because the unit is 
in an exceedingly hot environment or the fan is blocked. 
Let the unit cool down.

2. The fan may not be functioning correctly or the air vents 
are blocked.

3. The unit temperature was exceeded because the 
computer was functioning with the cover or side panel 
removed. Replace cover or side panel, and let the 
computer cool down.

4. The unit temperature was exceeded because the air 
baffle is not properly installed to direct air flow over the 
processor. 

Insufficient power to the components. Ensure that both power supply cables are connected to the 
system board (on some workstations).

Computer appears to pause 
periodically

Network driver is loaded and no network connection is 
established. Establish a network connection, or use 
Computer Setup or Windows Device Manager to disable 
the network controller.

Cannot remove computer cover or side 
panel.

1. Smart Lock, featured on some computers, is locked. 
Unlock the Smart Cover Lock using Computer Setup.

2. The Smart Cover FailSafe Key, a device for manually 
disabling the Smart Cover Lock, is available from 
Compaq. You need the FailSafe Key in cases of 
forgotten password, power loss, or computer 
malfunction.

Computer does not boot up and power 
and hard drive LEDs are blinking.

Ensure that the riser board is properly seated.
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Computer does not boot up and Num 
Lock LED is blinking; you may hear one 
short and two long beeps.

Memory may be improperly installed or may be bad.

The Caps Lock LED is flashing; you may 
hear one long and two short beeps.

The video controller is not present or is incorrectly initialized. 
Clear configuration memory (CMOS). If a video card has 
been added, remove and reseat it.

Computer does not boot up and the 
Scroll Lock LED is flashing; you may 
hear two long and one short beeps.

System board hardware failure (prior to video). Replace 
system board.

✎ If the standard keyboard has been replaced with a Universal Serial Bus (USB) keyboard, you will hear 
the beep sequences mentioned above but will not see the flashing lights.

Solving Minor Problems (Continued)

Problem Possible Solution

Diskette Drive 

Problem Possible Solution

Diskette drive light stays on. 1. Diskette is damaged. In Windows 98, 2000, or Me run 
ScanDisk. Click Start > Programs > Accessories > 
System Tools > ScanDisk. 
In Windows NT, right–click Start, click Explore, and 
select a drive. Select File > Properties > Tools. Under 
Error-checking, click Check Now.

2. Diskette is incorrectly inserted. Remove the diskette and 
reinsert.

3. Software program may be damaged. Check the 
program diskettes.

4. Drive button is not pushed in. Push in drive button.
5. Drive cable is not properly connected. Reconnect drive 

cable.

Diskette drive cannot write to a 
diskette.

1. Diskette is not formatted. Format the diskette.
2. Diskette is write-protected. Either use another diskette 

that is not write-protected or disable the write protection 
on the diskette.

3. Writing to the wrong drive. Check the drive letter in the 
path statement.

4. Not enough space is left on the diskette. Use another 
diskette.

5. Diskette write control is enabled. Check the Removable 
Media write settings in Computer Setup.

Cannot format diskette. Invalid media reported. When formatting a diskette in DOS, 
you may need to specify diskette capacity. For example, to 
format a 1.44-MB diskette, type the following command at 
the DOS prompt: 
FORMAT A: /F:1440
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Diskette drive cannot read a diskette. 1. Diskette is not formatted. Format the diskette.
2. Using the wrong diskette type for the drive type. Check 

the drive type and use a compatible diskette.
3. Reading the wrong drive. Check the drive letter in the 

path statement.
4. Diskette drive has been disabled by Computer Setup, 

Windows NT, Windows 98, 2000 or Me utilities. Run 
Computer Setup and enable the diskette drive.

A problem has occurred with a disk 
transaction.

The directory structure is bad, or there is a problem with a 
file. In Windows 98, 2000, or Me run ScanDisk. Click Start 
> Programs > Accessories > System Tools > ScanDisk.
In Windows NT, right–click Start, click Explore, and select a 
drive. Select File > Properties > Tools. Under Error-checking, 
click Check Now.

Non-system disk message. The system is trying to start from a nonsystem diskette. 
Remove the diskette from the drive.

Drive not found. 1. Reseat the diskette drive cable. 
2. If a second diskette drive has been installed, follow the 

computer reconfiguration directions in the “Hardware 
Installation Problems” section.

System has misidentified the diskette 
drive type.

If a diskette drive other than a 3.5-inch, 1.44-MB drive has 
been installed, ensure that the drive type is identified 
correctly under Computer Setup. 

Diskette Drive (Continued)

Problem Possible Solution
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Display 

Problem Possible Solution

Screen is blank. 1. Monitor is not turned on and the monitor light is not on. 
Turn on the monitor and check that the monitor light is 
on.

2. Screen save has been initiated. Press any key or move 
the mouse to light the screen.

3. The cable connections are not correct. Check the cable 
connection from the monitor to the computer and to the 
electrical outlet.

4. The brightness need adjusting. Adjust the brightness 
control.

5. The energy saver feature has been enabled. Press any 
key or click the mouse button and, if one has been set, 
type the password.

6. The RGB (Red, Green, Blue) input switch on the back of 
the monitor is incorrectly set. Set the monitor's input 
switch to 75 ohms and, if there is a sync switch, set it to 
External.

7. System ROM is bad and system is running in FailSafe 
Boot Block mode (indicated by one long beep and three 
short beeps). Reflash the ROM using a ROMPaq 
diskette. Refer to “FailSafe Boot Block ROM” in section 
3.4.3 of this book. 

8. If a fixed-sync monitor is used, be sure that the monitor 
can accept the same sweep rate as the resolution 
chosen. 

9. Ensure the VGA/BNC selector is properly set.

Graphics colors are wrong. Either the cabling or the monitor impedance is incorrect.
1. Ensure that the Red, Green, and Blue BNC cables are 

connected to the corresponding monitor connectors.
2. Be sure the monitor's RGB inputs are set to 75 ohms.

Characters are dim. 1. Adjust the monitor's brightness and contrast controls.
2. Check that the video cable is securely connected to the 

graphics card and monitor.
3. Set the RGB switch (and sync options, if available) to 75 

ohms, with the sync set to External. Refer to the 
documentation included with the monitor.

Monitor does not function properly 
when used with the energy saver 
features.

Monitor without the energy saver feature is being used with 
energy saver features enabled. Disable the monitor energy 
saver features.

Blurry display or requested resolution 
cannot be set.

If the graphics controller was upgraded, the correct display 
drivers may not be loaded. Install the correct display drivers 
from the diskette included in the upgrade kit.
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The picture is broken up; it rolls, jitters, 
or blinks.

1. Be sure the monitor cable is securely connected to the 
computer.

2. In a two-monitor system or if another monitor is in close 
proximity, move the monitors apart to be sure they are 
not interfering with the other's magnetic field.

3. Fluorescent lights or fans may be too close to the 
monitor.

Screen goes blank. A screen blanking utility may be installed or energy saver 
features may be enabled. Press any key or type password.

Monitor overheats. There is not enough ventilation space for proper airflow. 
Leave at least 3 inches (7.6 cm) of ventilation space. Be sure 
there is nothing on top of the monitor obstructing the air 
flow.

Cursor will not move using the arrow 
keys on the numeric keypad.

The Num Lock key is on. Press the key to turn it off. The Num 
Lock light should not be on when you want to use the arrow 
keys.

Display (Continued)

Problem Possible Solution

SCSI

Problem Possible Solution

System with IDE and SCSI drives will 
not boot from SCSI hard drive.

The IDE drive needs to be disabled. Under the Computer 
Setup Advanced menu, disable the primary IDE controller.

System will not boot from a SCSI drive. 1. The SCSI drive is not configured correctly.
2. Ensure that drive cabling and jumpers are set correctly. 

To boot a SCSI drive, the drive ID number must be set to 
0. 
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Hard Drive
The information provided by the diagnostics tests includes: error code, system serial number, 
drive serial number, drive model, and drive firmware revision. Specific details of the drive failure 
are not included.

When you run the diagnostics, the test results are stored in a log. After completing the test, you 
can print this log to a local printer or save it to a file. Alternatively, before running the test, you 
can configure the test options to send the results to a local printer or file.

Printer

Problem Possible Solution

Printer will not print. 1. Printer is not turned on and online. Turn the printer on 
and ensure it is online.

2. Run printer self-test.
3. Reseat both ends of the printer cable.
4. Verify that printer port is enabled in BIOS and in 

Windows using F10 Setup.
5. Try printing using the DOS command  

C:\ [printer port].  
Where [printer port] is the port address to which the 
printer is connected.  
If the printer works, the problem is with the printer 
driver. Reload the driver.

6. If the computer is on a network, you may not have made 
the connection to the printer. Make the proper network 
connections to the printer.

Printer will not turn on. The cables may not be connected properly. Reconnect all 
cables and check the power cord and electrical outlet.

Prints garbled information. 1. The correct printer driver for the application are not 
installed. Install the correct printer driver for the 
application.

2. The cables may not be connected properly. Reconnect 
all cables.

Printer is offline. The printer may be out of paper. Check the paper tray and 
refill it if empty. Select online.
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Hard Drive

Problem Possible Solution

Hard drive error occurs. Hard disk has bad sectors or has failed. Use a utility to 
locate and block usage of bad sectors. If necessary, 
reformat the hard disk.

Disk transaction problem. Either the directory structure is bad or there is a problem 
with a file. In Windows 98, 2000, or Me run ScanDisk. 
Click Start > Programs > Accessories > System Tools > 
ScanDisk.
In Windows NT, right–click Start, click Explore, and select a 
drive. Select File > Properties > Tools. Under Error-checking, 
click Check Now.

Drive not found (identified). 1. Cable could be loose. Check cable connections.
2. The system may not have automatically recognized a 

newly installed device. See reconfiguration directions in 
the “Hardware Installation Problems” section. If system 
still does not recognize the new device, check to see if 
the device is listed within Computer Setup. If it is listed, 
the probable cause is a driver problem. If it is not listed, 
the probable cause is a hardware problem.

3. Check drive jumper settings. If the drive is a secondary 
drive that has just been installed on the same controller 
as the primary drive, verify that the jumpers for both 
drives are set correctly.

4. Check SCSI IDs to ensure none are duplicated.

Nonsystem disk message. 1. The system is trying to start from a diskette that is not 
bootable. Remove the diskette from the diskette drive.

2. The system is trying to start from the hard drive but the 
hard drive may have been damaged. Insert a bootable 
diskette into the diskette drive and restart the computer.

3. Diskette boot has been disabled in Computer Setup. Run 
Computer Setup and enable diskette boot.

Second Ultra ATA hard drive does not 
perform optimally.

The cable is not compatible with the drive type. Reinstall the 
second Ultra ATA hard drive using an 80-conductor cable.
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Audio

Problem Possible Solution

Sound does not come out of the 
speaker.

Software volume control is turned down electronically, or 
CD-ROM volume control on the front or back of the 
computer is turned down. Double–click on the speaker icon 
located on the taskbar, then set the volume by adjusting the 
volume slider. 

CD or DVD volume control on the front of the computer may 
be turned down. Increase the volume by turning the volume 
control dial.

External speakers not turned on. Turn on the speakers.

External speakers plugged into wrong jacks. Refer to the 
Computer User’s Guide or sound card documentation for 
proper speaker connection.

Audio cable not connected. Connect audio cable between 
CD or DVD drive and the system board.

Noise or silence comes from the 
speakers or headphones.

Computer may not detect correct speaker/headphone type 
or output or analog–to–digital auto–sense is not engaged. 
1. If using digital speakers with a stereo jack, use the 

stereo–to–mono adapter to engage the auto–sense 
feature.

2. If a the stereo–to–mono adapter is not available, use the 
multimedia device properties to manually switch the 
audio signal from analog to digital.

3. If the headphones have a mono jack, use the 
multimedia device properties to manually switch the 
system to analog out.

✎ If you set digital as the Output mode, the internal speaker 
and external analog speakers will no longer output audio 
until you switch back to an auto–sense or analog mode.
If you set analog as your Output Mode, external digital 
speakers will not function until you change the output 
mode back to auto–sense or digital mode.
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Hardware Installation
You may need to reconfigure the computer when you add or remove hardware, such as an 
additional diskette drive. If you install a Plug and Play device, Windows 98, 2000, or Me in most 
cases will automatically recognize the device and configures the computer. If a third-party Plug 
and Play device is not recognized, contact the device manufacturer. If you install a non–Plug and 
Play device, you must reconfigure the computer after completing installation of the new 
hardware. In Windows 98, 2000, or Me, select the Add New Hardware icon in the Control Panel 
and follow the instructions that appear on the screen. To reconfigure the computer in Windows 
NT Workstation 4.0 after installing new hardware, use the utility provided with the hardware.

Hardware Installation 

Problem Possible Solutions

A new device is not 
automatically recognized as 
part of the computer system.

1. The computer needs to be reconfigured to recognize the new 
device. Follow the reconfiguration instructions above. If system 
still does not recognize the new device, but the device is listed 
within Computer Setup, use Computer Setup to address any 
resource conflicts.

2. When the system advised you of changes to the configuration, 
you did not accept them. Reboot the computer and follow the 
instructions for accepting the changes.

3. A Plug and Play board may not automatically configure when 
added if the default configuration conflicts with other devices. 
Use Windows 98, 2000, or Me Device Manager to deselect the 
automatic settings for the board and choose a basic 
configuration that doesn’t cause a resource conflict. You can also 
use Computer Setup to reconfigure or disable devices to resolve 
the resource conflict.

4. The cables for the new external device are loose or the power 
cables are unplugged. Check all cables, and check that pins in 
the cable or connector are not bent down.

5. The power switch for the new external device is not turned on. 
Turn off the computer, turn on the external device, and then turn 
the computer on to integrate the new device with the computer.

6. If the drive is a secondary drive that has just been installed on 
the same controller as the primary drive, verify that the jumpers 
for both drives are set correctly.

Insufficient power to the 
components.

Ensure both power supply cables are connected to the system board 
(some Workstations).

Installed third-party SCSI hard 
drive adapter not participating 
in the hard drive ordering 
sequence provided in F10 
Setup and/or is always 
coming up as the boot device 
regardless of the 
predetermined sequence.

The third-party adapter is either not supporting BIOS Boot 
Specification or the Boot Vector option. A solution is not available.
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DVD-ROM and CD-ROM

Problem Possible Solution

Cannot read compact disc. 1. CD is not properly seated in the drive. Eject the CD, 
correctly seat it in the drive, then reload.

2. CD has been loaded upside down. Eject the CD, turn it 
over, then reload.

System will not boot from CD-ROM or 
DVD drive.

1. The CD-ROM or DVD boot is not enabled through the 
Computer Setup utility. Run the Computer Setup utility 
and set the drive priorities.

2. Ensure that drive cabling and jumpers are set correctly. 
To boot a SCSI drive, the drive ID number must be set to 
0.

Cannot eject compact disc (tray-load 
unit).

CD is not properly seated in the drive. Turn off the computer 
and insert a thin metal rod into the emergency eject hole 
and push firmly (a straightened paper clip can be used). 
Slowly pull the tray out from the drive until the tray is fully 
extended, then remove the CD. 

Cannot eject compact disc (slot-load 
unit).

1. Remove the drive from the chassis.
2. Remove the front bezel from the drive.
3. Remove the top and bottom drive covers.
4. Release the clamping mechanism to retrieve the CD.

CD-ROM or DVD device is not 
detected; driver is not loaded.

CD-ROM or DVD drive is not connected properly or not 
properly terminated. Open the computer and check the 
drive cable.

Movie will not play in the DVD drive. Movie may be regionalized for a different country. Refer to 
the documentation that came with the device.

Processor

Problem Possible Solution

Computer does not recognize the 
second processor.

Hardware Abstract Layer (HAL) installed is for a single 
processor. Install the multi-processor HAL.
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Memory

Problem Possible Solution

System won't boot or does not function 
properly after installing additional 
memory modules.

Memory module is not the correct type or speed grade for 
the system. Replace module with the correct 
industry-standard device for the computer. 

Out of Memory error. 1. Memory configuration may not be set up correctly; 
check memory configuration using Device Manager.

1. The computer has run out of memory for the application. 
Check the application documentation to determine the 
memory requirements.

Memory count during POST is wrong. Memory modules may not have been installed correctly or 
incorrect modules may have been used. 

✎ On system boards having integrated Intel video that use 
1 MB of memory for video it is normal for POST to have 
the memory count 1 MB short.

Insufficient memory error during 
operation.

1. Too many Terminate and Stay Resident programs (TSRs) 
are installed. Delete any unnecessary TSRs.

2. There is not enough memory for the application. Check 
the memory requirements for the application or add 
more memory.

Unit is on but there is no video and the 
power LED is blinking red.

Memory is not installed correctly and system is not booting. 
Reinstall memory modules.
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Network
Some common causes and solutions for network problems are listed in the following table. These 
guidelines do not discuss the process of debugging network cabling.

Network 

Problem Possible Solution

The Remote Wakeup feature is not 
functioning.

1. The feature is not available when using an AUI network 
connection; use an RJ-45 network connection.

2. Remote Wakeup is not enabled. Use the network control 
application to enable Remote Wakeup.

Network driver does not detect network 
controller.

Network controller is disabled. Run Computer Setup and 
enable network controller.

Network status link light does not turn 
on or flashes.

1. No active network is detected. Check cabling and 
network equipment for proper connection.

2. Network connection is not set up properly. Use the 
network control application to verify that the device is 
working properly.

3. System is configured for AUI connection; link LED does 
not apply to AUI connections.

4. Network driver is not properly loaded. Reinstall network 
drivers.

5. System cannot autosense the network. Disable 
autosensing capabilities and force the system into the 
correct operating mode.

Diagnostics reports a failure. Refer to www.compaq.com/support/files for the latest 
version of diagnostics.
1. The cable is not securely connected or is attached 

incorrectly. Ensure that the cable is securely attached to 
the network connector and that the other end of the 
cable is securely attached to the correct device.

2. There is a problem with the cable or a device at the 
other end of the cable. Ensure that the cable and device 
at the other end are operating correctly.

3. The network controller is defective. Replace the 
controller or the system board.

4. Network controller interrupt is shared with an expansion 
board. Under the Computer Setup Advanced menu, 
change the resource settings for the board.
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Diagnostics passes, but the computer 
does not communicate with the 
network.

1. Network drivers are not loaded, or driver parameters do 
not match current configuration. Make sure the network 
drivers are loaded and the driver parameters match the 
configuration of the network controller.

2. The network controller is not configured for this 
computer. In Windows 98/2000/Me/Windows NT, 
select the Network icon at the Control Panel.

3. Network controller interrupt with an expansion board. 
Under the Computer Setup Advanced menu, change the 
resource settings for the board.

Network controller stopped working 
when an expansion board was added 
to the computer.

1. Network drivers are not loaded or driver parameters do 
not match the current configuration. Make sure that the 
drivers are loaded and that the driver parameters match 
the configuration of the network controller.

2. The cable is not securely connected or is attached 
incorrectly. Ensure that the cable is securely attached to 
the network connector and that the other end of the 
cable is securely attached to the correct device.

3. Network controller interrupt is shared with an expansion 
board. Under the Computer Setup Advanced menu, 
change the resource settings for the board.

4. Network drivers were accidentally deleted when the 
drivers for the new expansion board were installed, or 
the files containing the network drivers are corrupted. 
Reinstall the network drivers, using backup diskettes.

Network controller stopped working 
without apparent cause.

1. The files containing the network drivers are corrupted. 
Reinstall the network drivers, using backup diskettes or 
the Restore CD.

2. The cable is not securely connected or is attached 
incorrectly. Ensure that the cable is securely attached to 
the network connector and that the other end of the 
cable is securely attached to the correct device.

3. The network controller is defective. Replace the network 
controller or system board.

Cannot connect to the network server 
when attempting Remote System 
Installation.

The network controller is not configured properly. Run 
Computer Setup and modify the Embedded NIC Settings.

System Setup utility reports 
unprogrammed EPROM.

1. Boot the workstation without the network drivers using a 
system boot diskette and reconfigure the controller.

2. Replace the controller.
3. Replace the system board.

Network (Continued)

Problem Possible Solution
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Resolving Audio Hardware Conflicts
Hardware conflicts occur when two or more peripheral devices contend for the same signal lines 
or channels. Conflicts between the audio interface and another peripheral device may be due to 
the settings of the base I/O addresses, interrupts, or DMA channels. The audio interface typically 
has the following settings:

To resolve hardware conflicts:

1. Change the hardware settings of your audio card or the peripheral card in your system if the 
peripheral card is using the audio interface setting. You can change settings for integrated 
audio using Computer Setup.

2. If you are unsure of the settings of the peripheral cards, you can isolate the source of the 
problem by temporarily removing all cards and other essential cards such as the disk 
controller. After that, add the cards back one at a time until the card that is causing the 
conflict is found.

Troubleshooting Using HP Intelligent 
Manageability Features

The Local Alert Pop-Up Dialog notifies you of an impending or actual hardware failure. If the 
computer is connected to a network and the HP Insight Management Agents are installed and 
configured, a Simple Network Management Protocol (SNMP) trap (message) is sent to the 
specified SNMP-compliant management application.

The Local Alert Pop-Up Dialog also tells you the steps you need to take prior to a hardware 
failure to avoid loss of data and damage to the computer. The system administrator can create a 
customized action message that might include contact telephone or pager numbers.

To close the Local Alert Pop-Up Dialog, click the Close button. To retrieve fault information 
after closing the dialog, run HP Insight.

For more detailed information, refer to the online Intelligent Manageability Guide.

Item Setting

Base I/O address 
FM Synthesizer I/O address 
Interrupt 
8-bit DMA

220H 
388-38Bh 
IRQ 5 
Channel 1
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System Board and Riser Board Reference 

Designators

These reference designators are used on most but not all hp system and riser boards.

NOTE: To determine which xw6000 system board you have, see the “Identifying the System 
Board” section of this guide for additional information.

Designator Component 
CR1 
CR2 
CR3 
CR34 
CR35

LED - 3.3V Aux 
LED - Power button press 
LED - PS_ON, 5.5V Aux 
Power ON LED 
Hard drive activity LED

E49 
E50 
E51 
J6 
J7

Clear Password header 
CMOS header 
Video pass-through header 
BNC 
RJ-45 Jack

J8 
J9 
J10 - 19 
J20 - 29 
J30

IEEE 1394 
Stacked RJ45/Dual USB connector 
ISA slots 
PCI slots 
Riser board socket

J31 - J35 
J36 
J37 
J38 
J39

Device bay connectors 
AC97 connector 
Primary SCSI connector 
Secondary SCSI connector 
Stacked parallel/SCSI connector

J40 
J50 
J51 
J52 
 

AGP slot 
First parallel port 
Second parallel port 
Double-stacked parallel port 
Top Port B 
Bottom Port A
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J53 
J54 
J55 
J66 
J67 
J68

Parallel port over single Serial Port 
Parallel port over Serial Port and Video Port 
Parallel port over dual VGA ports 
Keyboard connector (Closest to monitor connector) 
Mouse connector 
Double-stacked mouse/keyboard connector 
TopMouse 
BottomKeyboard

J69 
J70 
J71 
J72 
J73

Video connector 
Single USB connector 
Secondary single USB jack 
Microphone jack 
Line-in jack

J74 
J75 
J76 
J77 
 

Line-out jack 
Headphone jack 
Volume control 
Double-stacked headphone/microphone connector 
TopMicrophone 
BottomHeadphone

J78 
 
 
J80

Double-stacked line-in/line-out connector 
TopLine in 
BottomLine out 
Stacked serial/audio connector

J81 
 
 
J82 

Primary double-stack USB 
TopPort 2 
BottomPort 1 
Secondary double-stack USB 
TopPort 4 
BottomPort 3

J83 
J113 
P1 
P2 
P3

Triple-stacked audio jack (line in, line out/headphone, microphone) 
Video cache connector 
P/S connector 
Second P/S connector (as required) 
Third P/S connector (as required)

P5 
 
P6 
P7 
P8 
P8

Main Power switch and HDD and power LED connector (pins 1-9) 
and SCSI LED connector (pins 10-11) 
Speaker connector 
Audio connector (from CD-ROM) 
Chassis fan connector 
Primary chassis fan connector (xw6000 configuration 2)

P9 
P10 
P11 
P12 
P15

WOL connector (NIC cable) 
Diskette drive connector 
Second Audio connector 
Alert on LAN NIC connector 
AUI connector

Designator Component (Continued)
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P20 
P21 
P22 
P23 
P24

Primary IDE connector 
Secondary IDE (Multibay) connector 
Slimline CD-ROM connector 
Header for front audio panel 
Header for front panel USB

P25 - P26 
P27 
P29 
P30 
P31 
P52 
P53 
P54

Video memory upgrade connector 
MultiBay header 
SCSI LED connector 
Primary serial ATA port 
Secondary serial ATA port 
Serial port header 
First serial port 
Second serial port

P55 
 
 
P58 
P70 
P70 
P70

Double stack serial port 
Top            Serial B 
Bottom      Serial A 
Riser edge connector (male-mates with J30) 
Primary chassis fan header (xw6000 Configuration 1) 
Primary CPU fan header (xw6000 Configuration 2) 
CPU fan header (xw4000)

P71 
P71 
P89 
P100 
P101 
P120 
P124

Secondary chassis fan header (xw6000 Configuration 1) 
Secondary CPU fan header (xw6000 Configuration 2) 
Floating serial port /COM port header 
ITP connector 
Security card connector 
Front chassis fan header (xw6000) 
Hood lock header

P125 
P216 
SW1 
SW2 
SW50

Hood sensor header 
White box chassis fan 
Processor speed switch 
Security hood switch 
Clear CMOS switch

SW51 
XBT1 
XMM1 
XMM2 - XMM5 
XU1

Power button switch 
Battery socket 
Memory slot. DIMM1 or RIMM1 populated and tested 
Following memory slots 
Primary processor socket

XU2 
XU15

Secondary processor socket 
ROM socket

Designator Component (Continued)
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H
Model Number Naming for hp Products

hp workstations

X4CP/2.6+/40S+/256D/MXRd

Workstation 
Series

X4 = xw4000 
X6 = xw6000

Chassis Type

C = CMT

Processor

n.n = speed in GHz

xw4000 system:

blank = 400 MHz FSB 
F = 533 MHz FSB

xw6000 system:

+ = 2nd processor

Hard Drive Size, GB

nnn= capacity in GB 

Drive Type 

S = SCSI (10K RPM) 
K = SCSI (15K RPM) 
A = UATA

+ = 2nd Hard Drive

# = 3rd Hard drive

Memory

0 = no memory 
nnn = amount in MB 
n = amount in GB

Memory Type

R =RDRAM 
S = SDRAM 
D = DDR

Graphics

X = no graphics 
EX = Quadro2 EX 
MXR = Quadro2 MXR 
Pro = Quadro2 Pro 
FG2 = FireGL2 
45D = Matrox G450 DualHead 
20Q = Matrox G200 MMS Quad 
55D = Matrox G550 DualHead 
200 = Quadro4 200NVS 
400 = Quadro4 400NVS

Removable Storage

c = CD-ROM 
d = DVD-ROM 
r = CDRW 
z = ZIP 
blank = no device

OS Type

K= Win2000 
X= WinXP Pro 
P= Win2K / XP Pro
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Index

4-pin power pin assignments A–12
14-pin power pin assignments A–10, A–11
20-pin power pin assignments A–11, A–12
24-pin power pin assignments A–12
815e chipset 11–1

A
access panel, removal and replacement 10–1
access to computer, controlling 3–9
AGP card

pin assignments A–9
removal and replacement 11–7 to 11–9
retention mechanism 11–7 to 11–9

AssetControl 3–9
ATA/ATAPI (IDE) drive cable pin assignments 

A–7

B
backup software, ordering 2–15
battery

disposal 7–8
removal and replacement 12–10

blinking power-on light 3–7
board guide

removal and replacement 10–7
board guide, removal and replacement 10–7
Boot Block ROM 3–4
bootable disk, important information 3–20

C
cable

multi-mode SCSI 5–2
proper handling 7–7
SCSI adapter 5–1

cable lock
Kensington 3–20
provision 3–20
type 1 8–4

cable select drive 4–1
card guide, removal and replacement 10–7

cautions
AC power 7–1, 8–1, 10–1, 12–1, 12–2, 12–3
adding devices 1–1
air baffle 13–2, 13–3, 13–4
batteries 7–8
cable placement 9–1
cable routing 5–1
cables 7–7, 8–1
cooling fan 7–6, 8–1, 8–2, 10–1
cover lock security 3–17
ECC memory 11–1, 11–2
FailSafe Key 3–18
guide screws 9–3
installation 1–1
keyboard cleaning 7–5
keyboard keys 7–6
memory 11–1, 11–2
protecting ROM 3–4
subpanel 10–3, 10–10
unnecessary force 10–9

CD-ROM drive
jumper positions 5–5

chain termination, SCSI 5–2
changing operating systems, important information 

3–8
changing password 3–13
chassis fan, removal and replacement 13–2, 13–3
chassis indicator lights D–1
chassis types, illustrated 7–1
chipset

815e 11–1
cleaning

computer 7–5
keyboard 7–5
monitor 7–6
mouse 7–6

clearing password 3–14
cloning tools, software 3–1
Compaq Diagnostics for Windows 2–13
Compaq Insight Manager LC 3–3
Compaq Remote Management Setup 3–3
Compaq Restore CD 2–14, 2–15, 3–1
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Index
Compaq software. See software
computer

cleaning 7–5
diagnostics 2–10

Computer Checkup (TEST) 2–10
Computer Setup

menu 2–4
utilities 2–3, 3–7

configuring power button 3–7
connector pin assignments A–1 to A–12
controlling access to computer 3–9
convertible minitower

desktop to minitower conversion 10–9
country-specific power cord set requirements B–2
cover lock

SMART, removal & replacement 8–2, 8–3
cover lock security, caution 3–17
cover lock, SMART 3–17
customizing software 3–1

D
data integrity 3–21
deleting password 3–13
delimiter characters, table 3–13
deployment tools, software 3–1
Desktop Management Interface (DMI) 3–8
desktop, converting to minitower 10–9
device drivers

installing/upgrading 1–1, 1–2
obtaining 1–3
SCSI 1–2

diagnostic
diskette 2–10
error codes E–1
indicator lights D–1
tests 2–14

diagnostic tool for hard drives 3–21
diagnostics, computer 2–10
DIMMs, removal and replacement 11–5
disassembly preparation 8–1
disk, cloning 3–1
DMI (Desktop Management Interface) 3–8

drive
cable select 4–1
capacities 4–7
device designation 4–1
Drive Protection System (DPS) 3–21
partition size 4–7
protecting 3–21
removal and replacement 9–1 to ??, 9–2 to ??, 

9–3 to ??, 9–4 to ??
replacement type 4–6
SMART 4–6

dual-state power button 3–7
DVD-ROM drive

jumper positions 5–5

E
ECC Fault Prediction and Prefailure Warranty 3–21
electrostatic discharge. See ESD
energy savings, settings for 3–8
entering

power-on password 3–12
setup password 3–12

error codes, test
audio E–9
CD-ROM/DVD-ROM E–9
diagnostic E–1
diskette drive E–4
hard drive E–6
keyboard E–3
memory E–3
microprocessor E–2
modem communications E–5
network interface E–9
parallel port E–4
pointing device E–10
serial port E–5
special E–10
summary E–1
tape drive E–6
video E–7

error messages, POST C–1 to C–11
ESD (electrostatic discharge)

information 7–2
materials and equipment 7–4
preventing damage 7–3
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Index
Ethernet
AUI pin assignments A–2
BNC pin assignments A–1
RJ-45 pin assignments A–2

expansion card
removal and replacement 11–6

F
FailSafe

Boot Block ROM 3–5
Key, caution 3–18
Key, ordering 3–18

fan
chassis, removal and replacement 13–2, 13–3
power supply 7–6

FAT 32 to NTFS conversion 1–4
fault notification 3–20
feet, removal and replacement 10–8
Fingerprint Identification Technology 3–20
formatting disk, important information 3–20
4-pin power pin assignments A–12
14-pin power pin assignments A–10, A–11
front bezel

removal and replacement 10–2

G
graphics card, removal and replacement 11–7 to 

11–9
grounding methods 7–3

H
hard drive

diagnostic tool 3–21
proper handling 7–8

Hardware Abstraction Layer (HAL) 12–7
headphone pin assignments A–4
heatsink, removal and replacement 12–2
Hyper-Threading Technology 1–5

I
ID numbers, SCSI 5–1
IDE CD-ROM pin assignments, Slimline A–10
indicator lights D–1
infrared (IR) transceiver, external, pin assignments 

A–6
initial configuration 3–1
INSPECT 2–12
installing

Microsoft Windows 2000 1–1
Microsoft Windows XP 1–2
Red Hat Linux 1–3

Intelligent Manageability 3–8

internal computer temperature 3–21
invalid system ROM 3–4
IR transceiver. See infrared (IR) transceiver

J
jumper positions

CD-ROM drive 5–5
DVD-ROM drive 5–5
SCSI hard drive 5–4
Zip drive 5–5

K
Kensington cable lock 3–20
keyboard

cleaning 7–5
delimiter characters, national 3–13
indicator lights D–1
lights, ROM, table 3–5
pin assignments A–1

L
lights, indicator D–1, D–2
line-in audio pin assignments A–4
line-out audio pin assignments A–4
Linux

device drivers 1–3
locking Smart Cover Lock 3–17
low voltage differential (LVD) 5–2

M
Master Boot Record Security, setting 3–18
memory

DIMM installation 11–5
expansion 11–1

memory errors 3–21
microphone pin assignments A–3
model number naming convention

Compaq Evo Workstations H–1
monitor

cleaning 7–6
pin assignments A–6

mouse
cleaning 7–6
pin assignments A–1

MultiBay CD-ROM adapter pin assignments A–8
multiprocessor 12–7

N
national keyboard delimiter characters 3–13
NIC Alert 3–6
non-correctable memory errors 3–21
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O
operating systems, important information about 

3–8
ordering FailSafe Key 3–18

P
parallel interface pin assignments A–3
partitioning disk, important information 3–20
password

changing 3–13
clearing 3–14
deleting 3–13
power-on 3–12
security 3–11
setup 3–11, 3–12

PC Transplant 3–3
POST (Power-On Self-Test) 2–1
POST error messages C–1 to C–11
power button

blinking 3–7
configuring 3–7
dual-state 3–7

power cord set requirements
country specific B–2
general B–1

power indicator lights D–1
Power Management 3–8
power supply

fan 7–6
removal and replacement 13–1
surge-tolerant 3–21

power-on password
entering 3–12
setting 3–12

Power-On Self-Test (POST) 2–1
prefailure memory warranty 3–21
preinstalled software image 3–1
processor

recognizing second 12–7
removal and rerplacement 12–2

protecting hard drive 3–21
protecting ROM, caution 3–4
protecting software 2–14

R
recovering system 3–4
recovery, software 3–1
Remote Security Management 3–6
remote setup 3–2

Remote System Installation, accessing 3–2
Remote Wakeup and Remote Shutdown 3–6
removal and replacement

access panel 10–1
battery 12–10
board guide 10–7
card guide 10–7
DIMMs 11–5
drives 9–1 to ??, 9–2 to ??, 9–3 to ??, 9–4 to ??
expansion card 11–6
fan

standard 13–2, 13–3
feet 10–8
front bezel 10–2
graphics card 11–7 to 11–9
heatsink 12–2
power supply 13–1
processor 12–2, 12–6
security bracket 8–4
subpanel and bezel blanks 10–3

required tools and software 7–7
retention mechanism, AGP 11–7 to 11–9
riser board

designators G–1
ROM

invalid 3–4
keyboard lights, table 3–5
upgrading 3–4

S
safety precautions 7–5
safety precautions, cleaning 7–5
SATA drives

guidelines 6–1
saving energy 3–8
screws, correct size 7–7
SCSI

cable adapter 5–1
chain termination 5–2
device drivers 1–2
guidelines 5–1
ID numbers 5–1
jumper positions 5–4
multi-mode cable 5–2
pin assignments A–4

SCSISelect utility 5–3
second processor recognition 12–7
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Index
security
bracket 8–4
devices 8–2
features, table 3–10
master boot record 3–18
settings, setup of 3–9

serial interface pin assignments A–3
service considerations 7–6
setting

power-on password 3–12
setup password 3–11, 3–12
Smart Cover Sensor 3–16
timeouts 3–8

setup
initial 3–1
Microsoft Windows 2000 1–1
Microsoft Windows XP 1–2
Red Hat Linux 1–3
replicating 3–7
software 1–3

setup password
entering 3–12
setting 3–11

Smart Cover
FailSafe Key

spare part number 8–2
FailSafe Key, ordering 3–18
Lock, unlocking 3–17
lock, unlocking 8–2, 8–3
Lock,locking 3–17
Sensor 3–16

Smart Cover Sensor 3–16
SMART drive 4–6, 5–3
software

AssetControl 3–9
Compaq Diagnostics for Windows 2–13
Compaq Insight Manager LC 3–3
Compaq Remote Management Setup 3–3
Compaq Restore CD 2–14, 2–15
Computer Setup Utilities 2–1, 3–7
customizing 3–1
Drive Protection System 3–21
FailSafe Boot Block ROM 3–5
Fault Notification and Recovery 3–20
Fingerprint Identification Technology 3–20
managing 3–2
Master Boot Record Security 3–18

Microsoft Windows 2000 1–1
Microsoft Windows XP 1–2
NIC Alert 3–6
ordering 2–15
Power Management 3–8
protecting 2–14
recovery 2–15, 3–1
Red Hat Linux 1–3
Remote Management Setup 3–2
Remote Security Management 3–6
Remote System Installation 3–2
Remote Wakeup and Remote Shutdown 3–6
required 7–7
SCSISelect utility 5–3
setup 1–3
System Software Manager (SSM) 3–3
updating 3–2
updating multiple machines 3–3

spare part number
external cable adapter 5–1
internal cable adapter 5–1
Smart Cover FailSafe key 8–2
wrench, tamper resistant 7–7

static electricity 7–2
subpanel and bezel blanks, removal and 

replacement 10–3
surge-tolerant power supply 3–21
system board

designators G–1
diagnostic lights D–2
general guidelines 12–8

system recovery 3–4
System Software Manager 3–3

T
temperature, internal computer 3–21
TEST (Computer Checkup) 2–10
test error codes

audio E–9
CD-ROM/DVD-ROM E–9
diskette drive E–4
hard drive E–6
keyboard E–3
memory E–3
microprocessor E–2
modem communications E–5
network interface E–9
parallel port E–4
pointing device E–10
serial port E–5
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special E–10
summary E–1
tape drive E–6
video E–7

thermal sensor 3–21
timeouts, setting 3–8
To 2–14
tools, required 7–7
troubleshooting using Compaq Intelligent 

Manageability F–15
troubleshooting without diagnostics

audio F–9
audio hardware conflicts F–15
diskette drive F–3
display F–5
DVD-ROM/CD-ROM F–11
hard drive F–8
hardware installation F–10
memory F–12
minor problems F–2
network F–13
preliminary checklist F–1
printer F–7
processor F–11
SCSI F–6

20-pin power pin assignments A–11, A–12
24-pin power pin assignments A–12

U
Ultra ATA Integrity Monitoring 3–21
Ultra SCSI pin assignments A–5
unlocking SMART Cover Lock 8–2, 8–3
unlocking Smart Cover Lock 3–17
upgrading ROM 3–4
USB

card removal and replacement 10–4
USB pin assignments A–3

V
View System Information (INSPECT) 2–12

W
warnings

battery 7–8
hot surfaces 11–5

Web sites
www.compaq.com 3–4, 3–6, 3–7, 3–8, 3–18
www.compaq.com/easydeploy 3–3
www.compaq.com/im 3–3
www.compaq.com/im/lc 3–3, 3–10
www.compaq.com/solutions/pcsolutions 3–1
www.compaq.com/support/files/index.html 

3–3, 3–10
Wired for Management technologies 3–9
wrench, tamper-resistant 7–7

Z
Zip drive

jumper positions 5–5
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